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While reasonable efforts were made to ensure that the information in this
document was complete and accurate at the time of printing, AT&T can assume
no responsibility for any errors or liability for any direct or consequential damages
resulting from use of the information. Changes and/or corrections to the
information contained in this document may be incorporated into future issues.
Check the Readme file enclosed with the software to ensure you are aware of any
last minute modifications to this documentation.

Copying of this document is permitted provided that copyright, trademark and
any other proprietary rights markings or notices are faithfully reproduced and
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Your Responsibility for Your System’s Security

Toll fraud is the unauthorized use of your telecommunications system by an
unauthorized party, for example, persons other than your company’s employees,
agents, subcontractors, or persons working on your company’s behalf. Note that
there may be a risk of toll fraud associated with your telecommunications system,
and if toll fraud occurs, it can result in substantial additional charges for your
telecommunications services.

You and your System Administrator are responsible for the security of your
system, such as programming and configuring your equipment to prevent
unauthorized use. The System Administrator is also responsible for reading all
installation, instruction, and system administration documents provided with this
product in order to fully understand the features that can introduce risk of toll
fraud and the steps that can be taken to reduce that risk. AT&T does not warrant
that this product is immune from or will prevent unauthorized use of common
carrier telecommunication services or facilities accessed through or connected to
it. AT&T will not be responsible for any charges that result from such
unauthorized use.
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AT&T Corporate Security

Whether or not immediate support is required, all toll fraud incidents involving
AT&T products or services should be reported to AT&T Corporate Security at
1 800 821-8235. In addition to recording the incident, AT&T Corporate Security is
available for consultation on security issues, investigation support, referral to law
enforcement agencies, and educational programs.
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To Get Help

If you have any questions about or problems with FastCall for PassageWay
Solution Telephony Services that this user’s guide does not resolve, call the AT&T
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Contents

■

■

■

■

■

■

■

■

1

1-1

Introduction 1-1

What is FastCall for PassageWay Solution
Telephony Services?

How FastCall Works

FastCall Product Offerings

System Requirements

Organization of This User’s Guide

User Responsibilities

Conventions Used in this Guide

Getting Help

1-4

1-6

1-8

1-10

1-12

1-12

1-12

2 Initial Configuration 2-1

■ Overview 2-1

■ Configuring Telephone Parameters 2-4

■ Configuring Outgoing Call Rules 2-8

■ Configuring Directory Application 2-13

■ Other Configuration Settings 2-15

i



Contents

3 Using FastCall 3-1
■

■

■

■

Overview 3-1
Starting FastCall 3-2
What is the FastCall - Call Control Keys Window? 3-3
Exiting FastCall 3-46

4 Administering FastCall
■ Overview
■ FastCall Administration Notes

■ FastCall Administration

■ Configuring the FastCall - Call Control Keys
Window Hotkey

■ Setting the FastCall Password

■ Configuring Calling Number List
■ Configuring Called Number List

■ Configuring Caller Input List

■ Configuring Call Forward Destinations

■ Configuring Special Dialing Codes
■

■

■

■

■

Configuring Telephone Parameters

Configuring the Directory Application

Configuring Preferences

Importing and Exporting Triggers

Saving and Loading Configurations

4-1
4-1

4-2

4-3

4-6

4-8

4-10

4-15

4-19

4-24

4-28

4-33

4-39

4-40

4-44

4-48

ii



Contents

5 Setting Up Applications
■ Overview

■ Call Triggers
■ Determining Your Application Requirements

■ Arranging Your Windows Desktop

■ Configuring Application Paths

■ Configuring Application Triggers

■ Recording a Dynamic Data Exchange (DDE) for
an Incoming Call Trigger

■ Saving Trigger Configurations

5-1
5-1

5-2

5-3

5-4

5-6

5-8

5-44

5-48

6 Configuring Call Rules 6-1

■ Overview 6-1

■ Rules-Based Call Processing 6-1

■ Incoming Call Rules 6-3

■ Configuring Outgoing Call Rules 6-16

■ Saving Call Rule Configurations 6-24

iii



Contents

7 Using Log Viewer 7-1
■ Overview 7-1
■ What is Log Viewer? 7-2
■ Helpful Hints 7-4
■ Tasks 7-5
■ Log Viewer Menu Bar Options 7-11

8 Using AT&TCall 8-1
■

■

■

■

■

■

■

■

■

Overview 8-1

What is AT&TCall? 8-3

Getting Started 8-10

Helpful Hints 8-25

Running AT&TCall 8-26

File Tasks 8-29

Card Tasks 8-52

Quick Dial Tasks 8-58

AT&TCall Menu Bar Options 8-62

A Troubleshooting A-1
■ Overview A-1
■ FastCall Problems A-1
■ AT&TCall Problems A-7

iv



Contents

B Keyboard Shortcuts B-1

■ Overview B-1

GL Glossary GL-1

IN Index IN-1

v



vi



Figures

2 Initial Configuration 2-1
2-1.
2-2.
2-3.
2-4.
2-5.

2-6.

2-7.
2-8.

Configure FastCall Dialog Box
Telephone Parameters Dialog Box
Caller Input Dialog Box
Auto Login Dialog Box
Outgoing Call Rules - North American Dialing

Dialog Box
Advanced External Dialing Options

Dialog Box
Advanced Internal Dialing Options Dialog Box
Directory Application Dialog Box

2-2
2-4
2-6
2-7

2-8

2-10
2-11
2-13

3 Using FastCall 3-1
3-1.
3-2.
3-3.

3-4.

3-5.
3-6.
3-7.
3-8.
3-9.

FastCall - Call Control Keys Window 3-3

FastCall - Call Control Keys Window Elements 3-4

FastCall - Call Control Keys Window with
Multiple Call Appearances 3-5

FastCall - Call Control Keys Window for
FastCall Promotional

FastCall Call Status
Button Bar
Answer - Select Call Dialog Box
Redirect Dialog Box
Redirect - Select Call Dialog Box

3-10. Redirecting Call
3-11. Call Dialog Box

3-6
3-7
3-8
3-9
3-11
3-13
3-15
3-19

vii



Figures

3-12.
3-13.
3-14.
3-15.
3-16.
3-17.
3-18.
3-19.
3-20.
3-21.
3-22.
3-23.
3-24.
3-25.
3-26.
3-27.
3-28.

3-29.

Call Directory List
Placing Call Dialog Box
Conference - Add Dialog Box
Conference - Add Dialog Box
Conference - Add Dialog Box
Conference New Call Dialog Box
Cancel Conference - Add Dialog Box
Transfer Dialog Box
Transfer Dialog Box
Transfer [Call in Progress]
Transferring Dialog Box
New Call Message Box
Cancel Transfer Dialog Box
Display Panel & Tool Bar
Sample Conference Room Window
Conference - Add Dialog Box
Conference Room Window when a

Conference is on Hold
Conference - Drop Dialog Box

3-20
3-21
3-23
3-26
3-27
3-29
3-29
3-31
3-32
3-33
3-34
3-35
3-36
3-37
3-40
3-41

3-43
3-44

4 Administering FastCall 4-1
4-1.
4-2.
4-3.
4-4.
4-5.
4-6.
4-7.

FastCall Security Dialog Box 4-3
FastCall - Administration Program Window 4-5
FastCall Hotkey Dialog Box 4-7
Set New System Password Dialog Box 4-8
Confirm System Password Dialog Box 4-9
Calling Number List Dialog Box 4-11
Add Numbers Dialog Box 4-12

viii



Figures

4-8. Calling Number List Dialog Box
4-9. Called Number List Dialog Box
4-10.
4-11.
4-12.
4-13.
4-14.
4-15.
4-16.
4-17.
4-18.
4-19.
4-20.
4-21.
4-22.
4-23.
4-24.
4-25.
4-26.
4-27.
4-28.
4-29.
4-30.
4-31.

Add Numbers Dialog Box
Called Number List Example
Caller Input List Dialog Box
Add Numbers Dialog Box
Caller Input List Example
Call Forward Destinations List Dialog Box
Add Numbers Dialog Box
Call Forward Destinations List Example
Special Dialing Codes List Dialog Box
Add Numbers Dialog Box
Special Dialing Codes List Dialog Box
Telephone Parameters Dialog Box
Caller Input Dialog Box
Telephony Server Auto Login Dialog Box
Directory Application Dialog Box
Preferences Dialog Box
Select the Library Directory Dialog Box
Export Trigger Library Dialog Box
Select the Library Directory Dialog Box
Import Trigger Library Dialog Box
Save Configuration Dialog Box
Load Configuration Dialog Box

4-13
4-15
4-16
4-17
4-20
4-21
4-22
4-24
4-25
4-26
4-29
4-30
4-31
4-34
4-36
4-37
4-39
4-40
4-44
4-45
4-46
4-47
4-49
4-51

ix



Figures

5 Setting Up Applications 5-1
5-1.
5-2.
5-3.
5-4.
5-5.
5-6.
5-7.
5-8.
5-9.
5-10.
5-11.
5-12.
5-13.
5-14.
5-15.

5-16.
5-17.

5-18.
5-19.

5-20.
5-21.
5-22.
5-23.
5-24.

Sample Desktop
Application Path Assignment Dialog Box
Application Triggers Dialog Box
Telephone Number Format Dialog Box
Incoming Call Trigger Example
Configure Keystroke Macro Dialog Box
Keystroke Macro Warning Box
Macro Suspended Dialog Box
View Keystroke Window
Incoming Call Triggers Dialog Box
Configure Keystroke Macro Dialog Box
Keystroke Recorder Dialog Box
Incoming Call Triggers
AT&TCall Find Dialog Box
Keystroke Macro Recorder Suspended

Dialog Box
Keystroke Macro Recorder Dialog Box
Keystroke Macro Recorder Suspended

Dialog Box
AT&TCall Find Dialog Box
Keystroke Macro Recorder Suspended

Dialog Box
Outgoing Call Triggers Dialog Box
Outgoing Macro Diagram
Outgoing Call Triggers Dialog Box
Warning Screen
AT&TCall Application

5-5
5-6
5-9
5-12
5-15
5-16
5-16
5-17
5-18
5-20
5-21
5-22
5-23
5-24

5-25
5-26

5-27
5-28

5-29
5-31
5-35
5-37
5-38
5-39

x



Figures

5-25. Edit Card
5-26. Keystroke Macro Recorder Suspended

Dialog Box
5-27. Keystroke Macro Recorder Suspended

Dialog Box
5-28. Message Box
5-29. Incoming Call Triggers Dialog Box
5-30. Configure DDE Client Dialog Box

6 Configuring Call Rules
6-1. Rules Based Call Processing
6-2. Incoming Call Rules Dialog Box
6-3. Forwarding Destinations Dialog Box
6-4. Call Alert Options Dialog Box
6-5. Incoming Call Rules
6-6. Call Alert Options Dialog Box
6-7. Incoming Call Rules Dialog Box
6-8. Incoming Call Rules Dialog Box
6-9. Incoming Call Rules Dialog Box
6-10. Outgoing Call Rules - North American

Dialing Dialog Box
6-11. Advanced External Dialing Options

Dialog Box
6-12. Advanced Internal Dialing Options

Dialog Box
6-13. Outgoing Call Rules - Global Dialing

Dialog Box

5-40

5-41

5-42
5-43
5-45
5-47

6-1
6-2
6-3
6-8
6-9
6-11
6-12
6-13
6-14
6-15

6-17

6-19

6-21

6-22

xi



Figures

7 Using Log Viewer 7-1
7-1.
7-2.
7-3.
7-4.

Log Viewer Window 7-2
Preferences Dialog Box 7-7
Filter/Sorting Options Dialog Box 7-8
Filter/Sorting Options Dialog Box 7-10

8 Using AT&TCall
8-1. Components of an AT&TCall Window
8-2. Desktop with 10/20 Quick Dials and

Card Shown
8-3. Desktop with 10/20 Quick Dials and

Card Hidden
8-4. Desktop with 25/50 Quick Dials and

Card Displayed
8-5. Desktop with 25/50 Quick Dials and

Card Hidden
8-6. Telephony Server Identification Dialog Box
8-7. Initial Telephony Server Login Dialog Box
8-8. Telephony Server Identification Dialog Box
8-9. Initial Telephony Server Identification

Dialog Box
8-10. Sort Dialog Box
8-11. Export Dialog Box
8-12. Print List Dialog Box
8-13. Printing Cards With and Without the Notes
8-14. Print Cards Dialog Box
8-15. Password Dialog Box

8-1
8-4

8-6

8-7

8-8

8-9
8-11
8-12
8-26

8-27
8-29
8-33
8-38
8-40
8-41
8-42

xii



Figures

8-16.
8-17.
8-18.
8-19.

8-20.

Account Code Options Dialog Box
Dial Options Dialog Box
Sample File to be Loaded Automatically
Sample Telephony Server Identification

Dialog Box
Delete Card Dialog Box

8-45
8-47
8-49

8-50
8-54

A Troubleshooting A-1

A-1. FastCall - Master Control Program Dialog Box A-2

A-2. FastCall Error Message Box A-3

xiii



Introduction

1
What is FastCall for PassageWay
Solution Telephony Services?

FastCallTM for PassageWay® Solution Telephony Services is a software
package that runs with Microsoft® WindowsTM operating system 3.1 or later or
Windows for Workgroups 3.11 or later, enabling you to control telephone calls
(both incoming and outgoing) directly from your lBM®-compatible personal
computer on a local area network (LAN) using NetWare® Telephony Services
software.

In the PassageWay Telephony Services Solution environment, there is no
physical connection between telephone and computer, as the telephone
system and network server interface to provide third party call control.
FastCall interfaces with the Telephony Services software to provide computer-
telephone integration.

PassageWay Solution provides the interface between your telephone and your
PC on the LAN running NetWare Telephony Services software. PassageWay
Solution provides the pathway for information to be exchanged between your
PC and your telephone.
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Introduction

FastCall is a Windows-based Computer Telephone Integration (CTI)
middleware program that brings together telephone and computer
technology. CTI is the linking of telephone voice communication systems to
computers, which can increase productivity and customer satisfaction
through the exchange of information between the computer and telephone.
FastCall enables you to access the telephone directly from your computer
keyboard. It automates the handling of both inbound and outbound calls.

FastCall for Windows provides three principle Computer-Telephone
Integration capabilities:

■ Screen-based telephony

Telephone functions normally achieved by pressing buttons on the
telephone are accessed through keystrokes or mouse clicks on the
computer, with feedback provided on the computer screen. The
following screen based telephony functions are supported in FastCall:

—  Answering an incoming call

—  Disconnecting (hanging up) a call

—  Placing a call

—  Transferring a call

—  Conferencing up to six parties on a call

—  Redirecting an incoming call to another extension or number

—  Dialing an outbound call

Special dialing codes, such as agent log, call park, and international
dialing can be customized to your phone system.
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■ Incoming call and screen synchronization (or screen pops)

FastCall enables you to receive calls and information about the caller,
through the computer and telephone. Information can be obtained
from a database application, spreadsheet, or other application resident
on or accessed from your computer. FastCall uses a learning
algorithm to link Windows programs to incoming calls. For example, a
bank loan officer could see the database record of a mortgage
applicant “pop up” automatically when that applicant calls. Information
would be available as soon as voice communication is established.

■ Application-based preview dialing

FastCall links with applications for automated outbound dialing. By
recording the keystrokes used to find and retrieve a telephone number
from a database record, FastCall can find the telephone number,
extract it, and automatically begin dialing, whenever you press a single
function key.

■ Rules-based intelligent call handling

FastCall can also support multiple line appearances. FastCall can support up
to 10 simultaneous calls. The number of line appearances used is
determined by the configuration of the Telephone System for the extension
administered to the PC.
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How FastCall Works

FastCall allows you to “telephony enable” your Windows applications. Through
the use of keystroke macros, you can train FastCall to execute “triggers” when
incoming telephone calls match the criteria of an incoming call rule. A trigger
is information and instructions that execute actions. You define triggers by
configuring application paths and recording keystroke macros. Triggers make
your applications and data pop upon the screen. Triggers are enabled by
call rules, which are a set of conditions that filter your calls and enable
FastCall to handle your calls in the ways that you want them to be handled.
You can configure FastCall so that when a call meets the criteria of a rule, a
trigger is executed.

Call rules can use the following criteria to determine what action to take when
calls arrive:

■ Calling Number (usually ANI or CLID)

Calling Number identifies who will be calling you. Calling numbers can
be configured to be specific people you know will be calling, such
friends or associates, or they can be numbers of business clients. This
feature utilizes the Automatic Number Identification (ANI) or Caller ID
(CLID) capabilities of the telephone system.

■ Called Numbers (DNIS or VDNs)

The called number identifies the number called by someone. You may
have many numbers through which incoming calls may be received,
such as 1-800-555-INFO, 1-800-555-ACCT, 1-800-555-SALE, etc., each
one connecting to a different department. A Called Number can also
be an extension. You can configure FastCall to identify the number for
which a call is coming in, and have FastCall automatically execute a
series of actions based on the number called.
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For example, if someone calls 1-800-555-SALE, you know that he is
calling in regard to a purchase. You would configure FastCall to pop
up a database record containing pricing and product availability
information. You could also configure FastCall so that when your
personal extension is called, it will pop up your personal directory
application, such as Lotus OrganizerTM.

If someone calls 1-800-555-ACCT, you know that she is calling to
inquire about her account status. You may configure FastCall to
automatically redirect the call to your accounting department and pop
up an account record on the screen. Before the accounting agent
answers the phone, information regarding the account would be
available to the agent. This feature utilizes the Vector Directory
Number (VDN) or Dialed Number Identification Service (DNIS)
capabilities of the telephone system.

■ Caller Input

Caller input is information that the calling party enters via a touch-tone
(DTMF) phone. Information may be an account number, as when you
call a credit card company and are prompted to enter your account
number. For caller input to be used by FastCall, your AT&T telephone
system must be equipped with the Call Prompting feature. FastCall

■

Promotional and Runtime do not support the Call prompting feature.

Time of Day

Time of Day determines the time that a call arrives.

Calls may be answered and a trigger may be launched, or calls could be
rerouted to another extension based on any one call rule criterion, or a
combination of the call rule criteria.

For outgoing calls, FastCall allows you to preview dial from any Windows
application through the use of outbound macros. Depending on your version
of FastCallj you can develop keystroke macros to highlight, extract, and dial
numbers from any Windows application. You also have the option to speed
dial using the F6 - Call key and access numbers from the FastCall Calling
Number list.
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FastCall Product Offerings

The following versions of FastCall are available:

■ FastCall Professional

■ FastCall Runtime

■ FastCall Promotional

FastCall Professional

FastCall Professional is the full-featured version of FastCall and is described
throughout this manual. FastCall Professional has the following features:

■ Call Control Keys with administrative and directory icons

■ Up to 100 Rules and Triggers included for intelligent, rules-based call
processing and handling

■ DDE support

■ Warn Before Dial over Dial warning configuration

■ Lookup Conversion - speed improvements and centralized look-up lists

■ Ability to Telephony Enable any Windows applications (that is,
recording macros for any Windows applications)

■ Conference Room

■ Caller Input feature
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FastCall Runtime

FastCall Runtime offers the knowledge worker “Off the Shelf” middleware
integration and screen-based telephony provided by FastCall’s Call Control
Keys. FastCall Runtime has the following features:

■ Call Control Keys with administrative and directory icons

■ Up to 100 Rules and Triggers included for intelligent, rules-based call
processing and handling

■ Middleware integration only with applications in the Library.

■ The Library keystroke macros may be re-recorded. (You cannot record
keystroke macros for applications that are not in the Library.)

FastCall Promotional

FastCall Promotional is the basic version of FastCall and provides all screen-
based telephony features of the core product, as well as middleware
integration with AT&TCall as a default. FastCall Promotional has most of the
FastCall Runtime features for 30 days after installation. After 30 days, most
advanced call control functions (for example, Transfer and Redirect) and
access to the Library are denied.

NOTE:
Most call control functions and access to the macro Library are
disabled 30 days after installation. To regain these capabilities, you
must upgrade to FastCall Professional or FastCall Runtime.
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System Requirements

To run FastCall 2.0, you must have the following hardware and software
already installed:

■ An IBM-compatible PC with:

—  an 80486 or higher microprocessor.

—  at least 8 MB of RAM memory.

—  at least 28 MB of space on your hard disk if you choose to load
the FastCall on-line documentation. If you do not load the on-line
documentation, you need at least 8 MB of space on your hard
disk:

— a

— a

— a

3.5-inch, 1.44 MB diskette drive.

VGA or better video controller and monitor.

mouse or other Windows-compatible pointing device.

NOTE:
System performance may be adversely affected by lower system
speeds and lower memory capacities.

■ Microsoft Windows 3.1 or Windows for Workgroups 3.11 running in
enhanced (386) mode. Emulation environments such as Windows
under OS/2® or Windows NT are not supported.

■ LAN hardware and networking software.

■ A NetWare Telephony Services server (release 2).

■ FastCall Workstation Setup software. This software is typically installed
when the Telephony Services Release 2.0 platform software is installed
on your PC.
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In order for FastCall and PassageWay applications to operate, your Network
Administrator must perform the following NetWare Telephony Services
administration:

■ Create a computer telephony integration (CTI) link which is capable of
controlling your telephone. (You will enter the name of this link in the
Server ID field of the Telephony Server Auto Login dialog box when you
configure FastCall.)

■ Create a NetWare Iogin on the Telephony Server that services the CTI
link to which your telephone is assigned. (More than likely, you already
will be a user of your organization’s LAN, and will have a NetWare Iogin
on the server that has been designated to be the Telephony Server. )
Note that your Telephony Server Iogin and password are the same as
your NetWare Iogin and password.

■

■

■

Add your Iogin to the list of Telephony Services users.

Add your phone to the list of devices on the Telephony Server.

Assign you “call control” and “device/device monitoring” permissions
for your “device” (that is, telephone). These are the default permissions
provided by the system.

Your Network Administrator will inform your telephone System Administrator of
the Server ID for Telephony Services. If you do not already have a NetWare
Iogin and password for the server assigned to Telephony Services, this
information will also be provided.
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Organization of This User’s Guide

This user’s guide contains eight chapters and two appendices. Also included
is a glossary of terms and an index. Each section of this manual is described
below.

Chapter 1 - Introduction

Chapter 1 describes the structure and content of this user’s guide.
This chapter also provides an introduction to the features and operation
of FastCall, and includes an overview of CTI.

Chapter 2 - Initial Configuration

Chapter 2 provides information about configuring FastCall the first time
you run it. You must configure FastCall before you can use it.

■

■

■

■

■

■

FastCall.

Chapter 3 - Using FastCall

Chapter 3 provides information about the FastCall Controller main
window, and how to use it for inbound and outbound call control.

Chapter 4 - Administering FastCall

Chapter 4 provides information and instructions for configuring

Chapter 5 - Setting Up Applications

Chapter 5 describes the methods and procedures for setting up the
Windows applications that are to work with FastCall.

Chapter 6 - Configuring Call Rules

Chapter 6 discusses call rules and describes the procedures for
configuring the rules that you want to apply in your FastCall
environment. Several examples of call rules are included to
demonstrate how rules are configured and applied.
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■ Chapter 7 - Using Log Viewer

This chapter describes how to use Log Viewer to view and store entries
of your calls.

■ Chapter 8 - Using AT&TCall

This chapter describes how to use AT&TCall.

■ Appendix A - Troubleshooting

This appendix provides information about possible error conditions and
how to respond to them.

■ Appendix B - Keyboard Shortcuts

This appendix provides some common keyboard shortcuts that you
can use with FastCall.

■ Glossary

The glossary provides definitions of words, terms, and phrases that are
used in this user’s guide and/or in the CTI and telecommunications
industries.

■ Index

The index provides a quick way of locating information within this
manual.
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User Responsibilities

Before using any of the FastCall applications, you should be familiar with
basic Windows functions and procedures. If not, consult your Microsoft
Windows User’s Guide.

You may also want the documentation for the applications that you will be
configuring for use with FastCall.

Conventions Used in this Guide

The following conventions are used in this guide:

■ Commands and text you should enter appear in this style of
type.

■ Values, instructions, and prompts that appear on the screen are in
this style of type.

■ Key names that are always located on the keyboard in the same place
appear in all capital letters, as in ENTER.

■ Key combinations (holding down one key while pressing another key)
are connected with a “+” (for example, SHIFT + TAB).

■ Only active windows are displayed.

■ The terms option buttons and radio buttons refer to the same object.

Getting Help

If you have questions about or problems with FastCall for PassageWay
Solution Telephony Services that this user’s guide does not resolve, call the
AT&T Technical Service Center at 1 800 334-1096 or your local Authorized
Dealer.
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Initial Configuration

2
Overview

After you have installed FastCall, you must set some initial parameters before
you can use FastCall. This chapter describes the procedures for initial setup.

The Configure FastCall dialog box (Figure 2-1) will automatically appear every
time you run FastCall until you configure at least the Telephone Parameters,
Outgoing Call Rules, and Directory Application. After these parameters have
been configured, the Configure FastCall dialog box will no longer appear. You
can reconfigure these parameters later. (Refer to Chapters 4, 5 and 6.)
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Figure 2-1.  Configure FastCall Dialog Box

You can access the Configure FastCall dialog box to configure FastCall
initially in any of the following ways:

■ Double-click on the FastCall Controller icon in the AT&T PassageWay
program group.

■ Double-click on the FastCall Administration icon in the AT&T
PassageWay program group.

To configure FastCall, you must perform the following steps:

1.  Configure

2.  Configure

3.  Select the

the Telephone Parameters.

the Outgoing Call Rules.

Directory Application.
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Before configuring FastCall, you must know the following information:

■ your extension number

■ the numbers of any other extensions that you can answer from your
telephone

■ the extension number to which incoming calls should be redirected or
forwarded in the event that the original destination is busy or invalid.
(This is the Master Redirect Number.) FastCall only uses the Master
Redirect Number for calls that are redirected or forwarded via call rules
you create.

■ whether your company’s telephone system uses caller input. If your
company’s telephone system uses caller input, you must know the
device identification of the VDN which is being used for monitoring
purposes.

NOTE:
Caller Input is only available in FastCall Professional.

■ the name of the server where the Telephony Server software

■ your Iogin ID for the Telephony Server

■ your password for the Telephony Server

is installed

You can get this information from your System Administrator.
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Configuring Telephone Parameters

To configure the telephone parameters, follow these steps:

1.

2.

In the Configure FastCall
option button.

dialog box, select the Telephone Parameters

Click the Configure button.

The Telephone Parameters dialog box appears.

Figure 2-2.  Telephone Parameters Dialog Box

2-4



Initial Configuration

3.

4.

5.

Enter

NOTE:
With FastCall Professional, the Telephone Parameters dialog
box also contains the Caller Input button.

the extension number of each extension that appears on the
first ten buttons of your telephone in the corresponding space. (Your
telephone may have less than ten extensions administered.)

Enter the Master Redirect Number in the space provided.

If your company’s telephone system does not use caller input,
proceed to step 6.

If your company’s telephone system uses caller input, perform the
following steps:

NOTE:
Caller Input is only available in FastCall Professional.

a. Click the Caller Input button.

The Caller Input dialog box appears.
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Figure 2-3.  Caller Input Dialog Box

b. In the Device IDs field, enter the device identification of the VDN
which is being used for monitoring purposes. (Consult your
System Administrator.)

c. Click the Add button.

d. Click the OK button.

The Caller Input dialog
Parameters dialog box

6. Click the Auto Login button.

box closes, and the Telephone
reappears.

The Telephony Server Auto Login dialog box appears.
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Figure 2-4.  Telephony Server Auto Login Dialog Box

7. Click the drop-down button at the right of the Server ID field.

A list of server IDs appears.

8. Click the server identification for the server where the Telephony
Server software is installed.

9. In the Login ID field, enter your login ID for the Telephony Server.

10.  In the Password field, enter your password.

11. Click the OK button.

The Telephony Server Auto Login dialog box closes, and the
Telephone Parameters dialog box reappears.

12. Click the OK button.

The Telephone Parameters dialog box closes, and the Configure
FastCall dialog box reappears.

Next, proceed to “Configuring Outgoing Call Rules.”
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Configuring Outgoing Call Rules

To configure the outgoing call rules, follow these steps:

1. In the Configure FastCall dialog box, select the Outgoing Call Rules
option button.

2. Click the Configure button.

The Outgoing Call Rules - North American Dialing dialog box
appears.

Figure 2-5.  Outgoing Call Rules - North American Dialing Dialog Box

3.  In the Local Area Code box, enter your local area code.
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4.

5.

6.

7.

8.

9.

In the Local Prefix box, enter the prefix you must dial to obtain an
outside line before dialing local calls.

In the Long Distance Prefix box, enter the prefix you must dial to
obtain an outside line before dialing long distance calls.

If it is necessary to dial “1” for long distance calls, check the Ensure a
1 on Long Distance check box.

If it is necessary to dial your local area code for long distance calls
within the area code, check the Use Area Code for Toll Calls within
the Area Code check box.

In the Local Exchanges box, enter all exchanges where it is
unnecessary to dial “1” before making a local call. Your System
Administrator will provide you with a list of these exchanges or will
indicate that you should use the constant ALL instead of individual
exchanges. Each exchange is entered by following these steps:

a.  Enter an exchange.

b.  Select the Add button.

The exchange is added to the list.

Click the External Dialing button.

The Advanced External Dialing Options dialog box appears.
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Figure 2-6.  Advanced External Dialing Options Dialog Box

10.

11.

If there are any area codes where it is unnecessary to dial a "1" before
the 10-digit telephone number, enter each area code in the
Neighboring Area Codes box and click the Add button. You may
enter a maximum of three area codes.

If there are any exchanges in neighboring area codes where you do
not have to dial a "1" or the area code before the 7-digit telephone
number, enter each exchange in the Exchanges that can be dialed as
local 7-digit numbers box and click the Add button.
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12.

13.

14.

If there are any exchanges in neighboring area codes where it is
unnecessary to dial a "1" before the area code and telephone number,
enter each exchange in the Exchanges that can be dialed as local 10
digit numbers box and select the Add button.

When you are finished, select the OK button.

The Advanced External Dialing Options dialog box closes.

Select the Internal Dialing button in the Outgoing Call Rules - North
American Dialing dialog box.

The Advanced Internal Dialing Options dialog box appears.

Figure 2-7.  Advanced Internal Dialing Options Dialog Box

15. In the Maximum Number of Digits box, enter the maximum number of
digits an internal extension in your company may have. FastCall
supports extension lengths from 1 to 7 digits.
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16.

17.

18.

If your company uses 7-digit internal extensions, perform the following
steps:

a. In the Exchanges box, enter each exchange that is used as part of
7-digit extension numbers and select the Add button.

b. In the Range of Subscriber Digits boxes, enter the range for the
last four digits of any 7-digit extensions that have been added to
the Exchange list.

If your company does not use 7-digit internal extensions, proceed to
step 17.

When you are finished,

The Advanced Internal

Select the OK button.

select the OK button.

Dialing Options dialog box closes.

The Outgoing Call Rules - North American Dialing dialog box closes,
and the Configure FastCall dialog box reappears.

Next, proceed to “Configuring Directory Application.”
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Configuring Directory Application

To configure the directory application, follow these steps:

1.

2.

In the Configure FastCall dialog box, select the Directory Application
option button.

Click the Configure button.

The Directory Application dialog box appears. The default directory
application, AT&TCall, will be entered in the Description field and the
path to AT&TCall will be entered in the Path Name field.

Figure 2-8.  Directory Application Dialog Box

You cannot change the directory application until the application
paths have been configured elsewhere in FastCall Administration. See
Chapter 4 for instructions.
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3.

4.

5.

To accept the default AT&TCall directory application, click the OK
button.

The Directory Application dialog box closes, and the Configure
FastCall dialog box reappears.

Click the OK button in the Configure FastCall dialog box.

The Configure FastCall dialog box closes.

Select Exit from the File menu to close the FastCall Administration
program.

You can now use FastCall.
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Other Configuration Settings

After you set the initial FastCall configuration parameters, you may wish to
configure other options to customize FastCall to your way of working. Some of
the options you can configure are:

■ Incoming Call Rules: Tells FastCall how to route or process calls based
on calling number, called number, caller input (available in FastCall
Professional only), time of day, and other factors.

■ Applications Paths: Tells FastCall where to find Windows applications
for use as the directory application for outgoing calls or for “screen-
pop” use for incoming calls.

■ Applications Triggers: Tells FastCall how to use other Windows
applications for directory or “screen-pop.”

■ Password: Prevents inadvertent alteration of your FastCall setup.

For call-handling groups such as inbound or outbound telemarketing, a
FastCall configuration can be saved and then loaded so that it can be used
by all members of the group with minimum effort.

NOTE:
Saving and loading configurations is not supported in FastCall
Promotional.
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3
Overview

This chapter provides the following information:

■   how to start FastCall

■   a description of the FastCall - Call Control Keys window

■   a description of the call control functions within the
    Control Keys window

■   a description of the icons within the Tool bar of the
    Control Keys window

■   how to use the FastCall - Call Control Keys window

■   how to use the Conference Room feature

■   how to exit FastCall

FastCall - Call

FastCall - Call

for call control
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Starting FastCall

Before you can run FastCall, you must first access Windows and open the
program group that contains FastCall. To start FastCall, double-click on the
FastCall Controller icon. The FastCall - Telephony Services Login dialog box
appears.

If you are running FastCall for the first time, perform the following steps:

1.

2.

3.

4.

Enter the name of the Telephony Server or select the name of the
Telephony Server in the Server ID box.

Enter your login ID on the Telephony Server in the Login ID box.

Enter your password in the Password box, and then select the OK
button.

The FastCall - Call Control
Program icon appear.

Double-click the FastCall -

The FastCall - Call Control

Keys icon and the FastCall - Master Control

Call Control Keys icon.

Keys window appears.

If you have run FastCall before, enter your password for the Telephony Server,
and select the OK button. The FastCall - Call Control Keys icon and the
FastCall - Master Control Program icon appear. Double-click the FastCall -
Call Control Keys icon to open the FastCall - Call Control Keys window.
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What is the FastCall - Call Control
Keys Window?

The FastCall - Call Control Keys window provides user control of telephony
functions through the use of function keys or icons on the FastCall - Call
Control Keys window button bar. Call information on incoming and outgoing
calls, and access to special functions through the FastCall - Call Control Keys
tool bar are also provided. Figure 3-1 shows the FastCall - Call Control Keys
window.

Figure 3-1.  FastCall - Call Control Keys Window
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The FastCall - Call Control Keys window consists of the following components:

■

■

■

■

■

■

Call Information Panel

Button Bar

Display Information Panel

Tool Bar

System Menu Button

Minimize Button

Figure 3-2 shows the elements of the FastCall - Call Control Keys window.

System menu Button Minimize Button

Display Info Panel Call Info Panel Button Bar Tool Bar

Figure 3-2.  FastCall - Call Control Keys Window Elements
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Call Information Panel

The Call Information Panel displays the status of all current calls. Each call
appearance causes this window to grow upwards to a maximum of 10
appearances (Figure 3-3).

Figure 3-3.  FastCall - Call Control Keys Window with Multiple Call
Appearances

The following information
Information Panel:

■ Calling number

On incoming calls,

is shown for every call appearance in the Call

this is the Caller ID label (as defined in the Calling
Number List, see Chapter 4) or the calling number of the particular call.
If incoming call information is not available, “No Calling Number” will be
displayed in this field. Internal calls will show either the name from the
Calling Number List or the actual extension number of the calling party.
On outgoing calls, this shows your extension or name.
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■

■

Called Number

On incoming calls, this is the Caller ID label (as defined in the FastCall
Called Number List, see Chapter 4) or the phone number dialed by the
incoming caller. If the Caller ID label is not found or the Called Number
is unknown, “No Called Number” will be displayed. Internal calls will
show the Caller ID label or the extension number dialed. On outgoing
calls, this shows either the name or the telephone number of the person
you are calling.

Caller Input

On incoming calls, this is the information entered via touch tone
(DTMF). For Caller Input to be utilized by FastCall, your AT&T
telephone system must be equipped with the Call Prompting feature.
The Caller Input field is only displayed with the Professional version of
FastCall. The Promotional and Runtime versions of this product do not
have the Caller Input feature. The FastCall - Call Control Keys window
shown in Figure 3-4 shows the FastCall Promotional version without the
Caller Input field.

Figure 3-4.  FastCall - Call Control Keys Window for FastCall Promotional

■    Timer

Timer shows the connect time of the call from the ringing state until the
call is disconnected.
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■

■

Answer/F2

Answer/F2 allows you to answer ringing appearances, or calls in the
Hold state. Calls may be answered by using the mouse to click on the
desired appearance, by pressing F2 and the call appearance number
(if there is more than one), or by pressing ALT and the call appearance
number. Once the call is answered, the Answer button for the
answered appearance is disabled. See Figure 3-5 for details.

Status

Status shows the state of each call appearance. The three states are
Active, On Hold, or Ringing. Only one call may be in the Active state.
The color of the Active appearance will be white, while a non-active
appearance (for example, On Hold or Ringing) will be gray. As calls
come in, the most recent call appears at the top of the Call Information
Panel, while the oldest appears at the bottom. See Figure 3-5 for
details.

Figure 3-5.  FastCall Call Status
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Button Bar

The Button bar consists of eight buttons as shown in Figure 3-6. The
functions shown on the buttons may be invoked by pressing the function key
indicated beneath each button, by clicking on the desired button with the
mouse, or by entering the accelerator for the button (for example, ALT + i for
Redirect).

Figure 3-6.  Button Bar

How to Answer Calls

There are several ways to answer incoming calls using the FastCall - Call
Control Keys window:

■

■

■

Using the mouse, click on the Answer button for the desired call
appearance.

Press the ALT key and the line number that corresponds to the desired
call appearance. The line appearance is displayed in the Call
Information Panel on the Answer button.

Press the Answer function key. If there is only one call appearance
ringing or on hold, that call is answered. If there is more than one
incoming call, the Answer - Select Call dialog box is displayed
(Figure 3-7).
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Figure 3-7.  Answer - Select Call Dialog Box

Elements of the Answer - Select Call
Dialog Box

■ Information
operation.

Panel - Displays information pertinent to the Answer

■ Selection List - List of calls to answer.

■ Cancel Button - Cancels the Answer -

■ Help Button - Invokes the Help option

Select Call option.

for the Answer operation.

■ System Menu Button - Opens the Windows standard menu, and
the Move and Close options. Move permits moving the Answer -

allows
Select

Call dialog box to another position on the screen, while Close cancels
the Answer operation.
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The order of calls in the Answer - Select Call dialog box matches the order in
the FastCall - Call Control Keys window. The call on the top of the list is the
most recent call, while the call on the bottom is the oldest. You select the call
to be answered by highlighting it and pressing the OK button. Selecting the
Cancel button closes the Answer - Select Call dialog box and returns to the
FastCall - Call Control Keys window.

If you attempt to answer a call while another call is active, the active call is put
on hold automatically.

F3 - Redirect

Press F3 - Redirect to forward a ringing call to another party. Redirect is
enabled only when there is a ringing call appearance, and only one call may
be redirected at a time. When there is more than one ringing call
appearance, FastCall prompts you to select which call should be redirected.
Pressing the F3 - Redirect button causes the Redirect dialog box to appear
as shown in Figure 3-8.
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Figure 3-8.  Redirect Dialog Box
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Redirect Dialog Box Elements

■ Information Panel - Contains directions for the Redirect operation in
process.

■ Dialpad - Enables you to enter numbers for the Redirect operation. You
may enter numbers by using the Dialpad buttons, by using the PC
keyboard, or by selecting entries from the Caller ID list. Entries in this
list are from the Call Forward Destination lists as configured in FastCall
Administration.

■ Dialpad Text Field - Displays the number entered from the Dialpad or
Caller ID list. The default entry in this list is the first number in the
Caller ID list.

■ Selection Button - Allows you to select different entries in the Caller ID
List.

■ Send Call Button - Dials the number selected in the Dialpad text field.

■ Cancel Button - Cancels the Redirect operation and reconnects to the
original call.

■ Help Button - Displays help information for the Redirect process.

■ System Menu Button - Opens the Windows standard menu, and allows
the Move and Close options. Move permits moving the Redirect dialog
box to another position on the screen, while Close cancels the Redirect
operation, and reconnects to the original call.

■ Caller Input Field - Displays the caller input associated with the
incoming call. When the call is redirected to another extension
monitored by FastCall, the caller input will go with the call and will be
displayed in the Caller Input field of the FastCall - Call Control Keys
window.
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In cases where caller input is not used, and this field is blank, you may
enter up to 16 characters of digits or text that will appear in the Caller
Input field of the destination extension if it is monitored by FastCall.

NOTE:
Caller Input is available with FastCall Professional only.

How to Redirect a Call
Press the F3 - Redirect button when there is a ringing call appearance that
you want to redirect. If there is only one ringing appearance, the Redirect
dialog box appears. If there is more than one ringing appearance, the
Redirect - Select Call dialog box appears (Figure 3-9).

Figure 3-9.  Redirect - Select Call Dialog Box
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Options for this dialog box operate in the same manner as the Redirect dialog
box, which appears when there is only one ringing appearance. The only
difference is the Selection List when all appearances that can be redirected
are shown. Select the appearance to be redirected and press the OK button.
The OK button is not enabled until a selection is made. Canceling the
process at this point will return to the FastCall - Call Control Keys window.

After you select the call to be redirected, the Redirect List dialog box
appears. Select the number you want to redirect the call to and press the
Send Call button. After you press the Send Call button, FastCall dials the
selected redirect number. Refer to Figure 3-10.
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Figure 3-10.  Redirecting Call
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If this consultation call is successful, the Redirect dialog box closes and the
original call is connected to the dialed number. Exceptions are handled as
follows:

■ If there are no lines available for a consultation call, the redirect
operation fails, and the call being redirected is placed on hold. FastCall
closes the Redirect dialog box.

■ If you call an internal line that is busy, the Redirect fails, and the
Redirect dialog box stays open. You may then try the Redirect
operation again, or close the box by pressing the Cancel button.

■ If at any point during the Redirect operation the original call is
terminated, the Redirect dialog box closes, and the FastCall - Call
Control Keys window appears.
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F4 - Dial Main

Press the F4 - Dial Main button to dial the main number as defined by the
outgoing call trigger for the application you selected. With FastCall
Promotional, the number dialed will be from the application you associated
with FastCall during installation. You activate this application by pressing the
Directory Application icon on the Tool bar in the FastCall - Call Control Keys
window. If your version of FastCall has the ability to record and create
outgoing triggers from other windows applications, refer to Chapter 5 for
details on how to set up FastCall’s Outgoing Call Triggers.

If the application is not open or has not been configured for use with FastCall,
the following message will be displayed in the Display Information Panel:
“Could not find application from which to dial." If the number is not copied to
the Windows clipboard, the following message will be displayed in the
Display Information Panel: “No dialable number found in the clipboard."

NOTE:
You can enter touch-tone digits from your telephone dialpad during a
call using FastCall. If your company has a DEFINITY® Communications
System Generic 3 Version 4 (G3V4), you can also enter touch-tone
digits from your PC keyboard during a call using FastCall. You cannot
enter touch-tone digits from any of the FastCall dialog boxes during a
call .

F5 - Dial Other

Press the F5 - Dial Other button to dial the alternate number as defined by the
outgoing call trigger for the application you selected. With FastCall
Promotional, the number dialed will be from the application associated with
FastCall during installation. You activate this application by pressing the
Directory Application icon on the Tool bar in the FastCall - Call Control Keys
window. If your version of FastCall has the ability to program and create
outgoing triggers from other windows applications, refer to
details on how to set up FastCall’s Outgoing Call Triggers.

Chapter 5 for
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If the application is not open or has not been configured for use with FastCall,
the following message will be displayed in the Display Information Panel,
"Could not find application from which to dial." If the number is not copied to
the Windows clipboard, the following message will be displayed in the
Display Information Panel, "No dialable number found in the clipboard."

NOTE:
You can enter touch-tone digits from your telephone dialpad during a
call using FastCall. If your company has a DEFINITY Communications
System Generic 3 Version 4 (G3V4), you can also enter touch-tone
digits from your PC keyboard during a call using FastCall. You cannot
enter touch-tone digits from any of the FastCall dialog boxes during a
call.

F6 - Call

The F6 - Call button initiates several different types of calls from the FastCall -
Call Control Keys window. You can make the following types of calls with the
F6 - Call button:

■

■

■

Directory: Allows you to make calls from the dialpad or by selecting an
entry from the FastCall internal name/number list. This list is built from
an alphabetized combination of the FastCall Calling Number and Call
Forward Destinations lists as configured in FastCall Administration. See
Chapter 4 for further information.

Redial: Allows you to dial from a list of the last unique 100 dialed
numbers and received incoming numbers.

Special Codes: Allows you to make special calls, such as international
or feature access codes as configured in the FastCall Administration
Special Dialing codes list.

Pressing the F6 - Call button displays the Call dialog box (Figure 3-11).
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Figure 3-11.  Call Dialog Box

NOTE:
You can enter touch-tone digits from your telephone dialpad during a
call using FastCall. If your company has a DEFINITY Communications
System Generic 3 Version 4 (G3V4), you can also enter touch-tone
digits from your PC keyboard during a call using FastCall. You cannot
enter touch-tone digits from any of the FastCall dialog boxes during a
call.
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How to Use F6 - Call
Press the F6 - Call button to pop the Call dialog box (Figure 3-12). The first
time the Call box is opened, the Directory button and the first entry in the
Directory list are selected as defaults. You may press the Selection button to
select another entry in the Directory list, type a number using your PC
keyboard, or use the dialpad to enter another number.

Figure 3-12.  Call Directory List

If you want to use the Redial or Special Codes list, select that option from the
Call dialog box by pressing the button associated with that option. The
Directory list associated with the selected option will appear.
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After making the list and number selections, pressing the Send Call button will
cause FastCall to attempt to dial the selected number. Once the call is
successful, the Call dialog box is closed, and the FastCall - Call Control Keys
window returns. Exceptions are handled as follows:

■    If you have no available lines or calls to a number that is busy, the Call
operation fails to complete, and the Call dialog box is closed.

■    If there is an active call and the Send Call button is pressed, the
Placing Call dialog box appears (Figure 3-13). Pressing the OK button
will drop the active call and dial the selected number. Pressing the
Cancel button will close the Call dialog box and return to the active
appearance in the FastCall - Call Control Keys window.

Figure 3-13.  Placing Call Dialog Box

NOTE:
This dialog box can be disabled from the FastCall Administration
program via the Preferences option. This can be especially useful
high-volume outgoing call environments such as collections or
telemarketing.

in
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F7 - Hang Up

Press the F7 - Hang Up button to disconnect the currently active call
appearance. This button is enabled only when there are active calls. When
no calls are active, the FastCall - Call Control Keys window is automatically
minimized.

F8 - Conference

The F8 - Conference button is enabled when an active call exists and a
conference is not already in session. One conference session with a
maximum of six members is supported. The F8 - Conference button is
pressed to invoke a three-way conference. Once the conference is
established, the F8 - Conference button is disabled, and changes to the
conference are made through use of the Conference Room feature. The
Conference Room feature is described later in this chapter.

Pressing the F8 - Conference button with an active call appearance displays
the Conference - Add dialog box (Figure 3-14).
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Figure 3-14.  Conference - Add Dialog Box
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Conference - Add Dialog Box Elements

■ Information Panel - Displays information pertinent to the Conference
operation.

■ Dialpad - Allows for number entry for the Conference - Add function.
Numbers may be entered by using the Dialpad buttons, by using the
PC keyboard, or by selecting entries from the Caller ID list. Entries in
this list are a combination of the FastCall Calling Number and Call
Forward Destination lists as configured in FastCall Administration.

■ Dialpad Text Field - Displays the number entered from the Dialpad or
Selection button.
Caller ID list.

■ Selection Button -
List.

The default entry in this list is the first entry in the

Allows you to select different entries in the Caller ID

■ Send Call Button - Dials the number selected in the Dialpad text field.

■ OK Button - Completes the Conference - Add operation.

■ Cancel Button - Cancels the Conference - Add operation and
reconnects to the original call.

■ New Call button - Drops the consultation call and reconnects to the
original call.

■ Help Button - Displays help information for the Call operation.

■ System Menu Button - Opens the Windows standard menu, and allows
the Move and Close options. Move permits moving the Conference -
Add dialog box to another position on the screen, while Close cancels
the Conference operation.
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■ Caller Input Field - Displays the caller input associated with the
incoming call. When the call is conference to another extension
monitored by FastCall, the caller input will go with the call and will be
displayed in the Caller Input field of the FastCall - Call Control Keys
window.

In cases where caller input is not used, and this field is blank, you may
enter
Input

up to 16 characters of digits or text that will appear in the Caller
field of the destination extension if it is monitored by FastCall.

NOTE:
Caller Input is available with FastCall Professional only.
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How to Conference a Call
After pressing F8 - Conference with a call active, the
box appears (Figure 3-15).

Conference - Add dialog

Figure 3-15.  Conference - Add Dialog Box
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You may select a number from the dialing list shown when the selection
button is pressed, or you may enter a number from the dialpad. Once the
number is selected, you may press the Send Call button. After the Send Call
button is pressed, the Conference Information Panel will display, “Call in
progress XXX-XXXx" where “XXX-XXXx is the number selected to be dialed.
After this message is displayed, the panel is updated to say, “Press OK to
complete the Conference-Acid.” See Figure 3-16.

Figure 3-16.  Conference - Add Dialog Box
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Press the OK button to complete the conference, and the Conference - Add
box closes. The FastCall - Call Control Keys window reappears with the
active appearance and the "Conference Complete!" message showing in the
Called Number field. At this time, the Conference Room icon appears, and the
Conference Room feature is activated. The Conference Room feature is
described later in this chapter.

The following exceptions apply to the F8 - Conference button:

■    If you have no available lines, the operation fails to complete, the
original call is put on hold, and the Conference - Add dialog box
closes.

■    If you attempt to connect to an internal busy or invalid number, the
operation fails and the Conference - Add dialog box remains open. You
may cancel the operation or attempt to re-establish the conference.

The following special cases apply to the Conference operation:

■    When the New Call button is pressed, the Conference New Call dialog
box appears (Figure 3-17). The New Call function, once confirmed,
drops the consultation call. Pressing the Yes button confirms this
sequence, causing the consultation call to disconnect, the dialog box
to close, and the Conference - Add dialog box to reappear. Pressing
the No button cancels the New Call operation, the consultation call is
unaffected, and you are returned to the Conference - Add dialog box.
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Figure 3-17.  Conference New Call Dialog Box

Pressing the Cancel button when a consultation call does not exist closes the
Conference - Add dialog box. If the call does exist, pressing Cancel displays
the Cancel Conference - Add dialog box (Figure 3-18).

Figure 3-18.  Cancel Conference - Add Dialog BOX
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F9 - Transfer

The F9 - Transfer button is enabled only when there is an active call. Pressing
the Transfer button displays the Transfer dialog box (Figure 3-19). With
FastCall Professional, caller input associated with a call will appear in the
Caller Input field at the bottom of the Transfer dialog box. Caller input will
follow the call to the destination extension if the destination is monitored by
FastCall. You also have the option entering up to 16 characters of digits or
text, and transferring that information to another monitored FastCall extension.
Information transferred in the Caller Input field will show up in the Caller Input
field of the FastCall - Call Control Keys window.

NOTE:
Caller Input is available with FastCall Professional only.
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Figure 3-19.  Transfer Dialog Box
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How to Transfer a Call
With a call appearance active, press the F9 -
Transfer dialog box. When entering this box,
the New Call button. See Figure 3-20.

Transfer button to display the
all options are enabled except

Figure 3-20.  Transfer Dialog Box
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Use the Selection button to display the transfer dialing list, which is a
combination of the FastCall Calling Number list and Call Forward Destinations
list. You may select an entry from this list or use the dialpad to enter another
number. When the number desired shows in the Dialpad text field, press the
Send Call button. The Send Call button is disabled, and the New Call button
is enabled. The Transfer, Call in progress box will appear (Figure 3-21).

Figure 3-21.  Transfer [Call in Progress]
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Once the Send Call button is pressed, you must press the OK button to
complete the transfer. The Transfer Information Panel will show the message,
“Press OK to complete the Transfer.” As a shortcut, you may press the OK
button instead of pressing both the Send Call button and the OK button. In
either case, after the OK button is pressed, the Transferring dialog box
appears (Figure 3-22).

Figure 3-22.  Transferring Dialog Box
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When the Transfer is complete, the Transferring dialog box closes. The
following exceptions apply:

■ If you have no available lines, the Transfer fails to complete, and the
call being transferred is put on hold. The Transfer dialog box is closed,
and the FastCall - Call Control Keys window appears.

■ If you transfer to a busy or invalid internal number, the Transfer fails to
complete. The Transfer dialog box remains open, and you can cancel
the operation by pressing Cancel or try to complete another Transfer
operation.

The following special cases apply to the Transfer operation:

■  When the New Call button is pressed, the Transfer New Call dialog box
appears (Figure 3-23). The New Call function, once confirmed, drops
the consultation call. Pressing the Yes button confirms this sequence,
causing the consultation call to disconnect, the dialog box to close,
and the Transfer dialog box to reappear. Pressing the No button
cancels the New Call operation, the consultation call is unaffected, and
you are returned to the Transfer dialog box.

Figure 3-23.  New Call Message Box

3-35



Using FastCall

Pressing the Cancel
Transfer dialog box.

button when a consultation call does not exist closes the
If the call does exist, pressing the Cancel button displays

the Cancel Transfer dialog box (Figure 3-24).

Figure 3-24.  Cancel Transfer Dialog Box

F10 - Hold

The F10 - Hold button is enabled only when there are active calls. Pressing
the button when a call appearance is active causes the status area of the Call
Information Panel to show On Hold. The color of the formerly active
appearance changes from white to gray, which represents a call on hold or
ringing.

If a call placed on hold is a conference call, the Conference Room icon on the
Tool bar will show the text “On Hold” on top of the icon.
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Display Information Panel

The Display Information Panel is located at the bottom of the FastCall - Call
Control Keys window, to the left of the Tool bar. Figure 3-25 shows the
location of the Display Panel. Information displayed in this window includes:

■    Last Incoming Number

■    Attempt to Redirect a Call

Tool Bar

The Tool bar is located at the bottom of the FastCall - Call Control Keys
window to the right of the Display Information Panel (Figure 3-25).

Intuity Message Manager Directory Administration
Phone Book Application

Intuity Message Manager Log Viewer Help

Figure 3-25.  Display Panel & Tool Bar
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The Tool bar contains the following buttons:

■ Conference Room, which is visible when a conference is active with the
Conference Room feature. For further information, see “Conference
Room” later in this chapter.

■ Directory Application, which starts or restores the selected Windows
application that is utilized for incoming and outgoing triggers by the
FastCall application. Note that for inbound and outbound application
call processing, the Directory Application must be active.

■ Log Viewer, which starts or restores the AT&T Log Viewer application.
See Chapter 7 for further information.

■ Administration, which starts or restores the FastCall Administration
Program. See Chapter 4 for further information.

■ lntuityTM Message Manager, which starts or restores the Intuity
Message Manager program (if loaded on your desktop).

■ Intuity Message Manager Phone Book, which starts or restores the
Intuity Message Manager Phone Book (if loaded on your desktop).

■ Help, which starts or restores the FastCall Help Utility.

Digit Dialing

You may dial one digit at a time after a call is active using the number keys if
the FastCall - Call Control Keys window has the focus. The keys 0-9, *, and #
are supported. Digits 0-9 may be dialed from the keyboard area as well as
the number pad. “*” is dialed only from the “*” key on the number pad. “#” is
dialed only from the “/” key on the number pad.
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System Menu Button

The system menu button opens the Windows standard system menu. The
system menu contains the following options:

■

■

■

■

Restore, which is present when the FastCall - Call Control Keys window
is in the minimized state. Pressing Restore returns the FastCall - Call
Control Keys window to normal.

Move, which allows moving the FastCall - Call Control Keys window
from its current screen position to another position using standard
Windows cursor positioning.

Close, which closes (exits) the FastCall - Call Control Keys window.

Minimize button, which minimizes the FastCall - Call Control Keys
window.

Conference Room

This section describes how to perform the following tasks:

■

■

■

■

■

■

When

start a conference

add a person to a conference

drop a person from a conference

put a conference on hold

return to a conference on hold

end a conference

you start a conference call using FastCall, the Conference Room
window appears, displaying the first three people (yourself and two other
people) on the conference call. Each person is represented by a panel, which
displays the Caller ID information associated with the person. Figure 3-26
shows a sample Conference Room window.
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Figure 3-26.  Sample Conference Room Window

If you are a participant in a conference (that is, you did not start the
conference) and you choose the Conference (F8) button on the Button bar of
the FastCall - Call Control Keys window, the Conference Room window
appears, identifying the people on the call.

Starting a Conference
To start a conference:

1.

2.

Make sure the call you want to conference is active in the FastCall -
Call Control Keys window.

Choose the Conference (F8) button on the Button bar.

The active call is put on hold, and the Conference - Add dialog box
appears.
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Figure 3-27.  Conference - Add Dialog Box

3.

4.

5.

Select an entry or enter a number for the person you want to add to
the conference.

Choose the Send Call button.

FastCall places the call.

After the call is answered, choose the OK button to add the person to
the conference.

The Conference Room window appears, displaying three panels.
Each panel represents a member of the conference. The Conference
icon appears on the Tool bar, indicating that the conference is active.
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Adding a Person
This procedure

NOTE:

to a Conference
enables you to add people to an existing conference.

Keep in mind the following information:

—  You cannot add incoming calls to a conference.

—  You cannot conference a ringing internal station and some ringing
external calls.

—  FastCall allows a maximum of six participants (including you) on a
conference call. However, the maximum number of participants
allowed by your private branch exchange (PBX) system may be
different. Consult your System Administrator for more information.

To add

1.

2.

3.

a person to a conference:

Choose the Add button in the Conference Room window.

The conference is put on hold, and the Conference - Add dialog box
appears.

Select an entry or enter a number for the person you want to add to
the conference.

Choose the Send Call button.

The conference is put on hold, and FastCall places the call. The Hold
button in the Conference Room window becomes outlined in red
(Figure 3-28).
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Figure 3-28.  Conference Room Window when a Conference is on Hold

4.  After the call is answered, choose the OK button to add the person to
the conference.

The conference becomes active, and a panel for the new person
appears in the Conference Room window.

Dropping a Person from a Conference
This procedure enables you to selectively drop people from the conference.

NOTE:
Using this procedure, you can drop yourself from the conference.
Depending on how your company’s telephone system is administered,
if you drop yourself from the conference the other people in the
conference may or may not continue the conference call. Consult your
System Administrator for more information.
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To drop a person from a conference:

1. Choose the Drop button in the Conference Room window.

The Conference
for each person

NOTE:

- Drop dialog box appears, disp
in the conference.

laying the call labels

If you select the panel of the person whom you want to drop
from the Conference Room window and then select the Drop
button, the label for that person will already be selected in the
Conference Drop dialog box.

Figure 3-29.  Conference - Drop Dialog Box
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2.

Putting a

Select the person you want to drop from the call, and then choose the
OK button.

The Conference - Drop dialog box closes, and the panel for the
selected person is removed from the Conference Room window.

NOTE:
The Conference Room window closes automatically if the
conference contains only you and one other person. The call
appearance for this person appears in the FastCall - Call
Control Keys window.

Conference on Hold
To put a conference on hold, choose the Hold button in the Conference Room
window.

Returning to a Conference on Hold
To return to a conference that is on hold, choose the Hold button in the
Conference Room window.

Ending a Conference
To end a conference, select the Hang Up button in the Conference Room
window. The Conference Room window closes. Depending on how your
company’s telephone system is administered, the other people in the
conference may or may not continue the conference call. Consult your System
Administrator for more information.
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Exiting FastCall

To exit FastCall:

1. Double-click on the FastCall - Master Control Program icon.

The FastCall - Master Control Program

2.  Select Exit from the File menu.

window appears.
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4
Overview

This chapter includes information about FastCall administration, including
identifying the calling parties, called parties, and caller input.

NOTE:
Caller Input is only supported by FastCall Professional.

Before you begin configuring FastCall, you need to prepare the information
that you will use. This information includes:

■ List of telephone numbers that are to be answered, including your
personal extension (Called Numbers).

■ ACD agent group numbers that are to be answered (Called Numbers).

Telephone numbers and extensions of people you call and/or people■

who call you (Calling Numbers).

■ Numbers and extensions to which you commonly transfer, forward, or
redirect calls (Call Forward Destinations).
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FastCall Administration Notes

FastCall uses the North American Dialing Plan. Depending on the Outgoing
Call Rule Configuration, it automatically recognizes 7 and 10 digit numbers as
external phone numbers and inserts dashes. For internal calls, 1 through 7
digit numbers (and the number 0) are recognized as extensions and are
prefixed with an x. Recognition of 7 digit numbers as internal or external
numbers is accomplished by the configuration of Advanced Dialing Options
in the Outgoing Call Rules. (See Chapter 6, “Configuring Call Rules.”) All
numbers are prefixed with an x when Global Dialing is enabled. Global
Dialing allows up to 22 digits as well as use of special dialing characters.
Global Mode will also distinguish between extensions and external numbers
and dial external access codes as configured in the Outgoing Call rules.

Any configuration changes that you make are automatically saved. After
configuring FastCall for your environment, you should back up the
configuration using the File, Save Configuration as option. See
“Saving a FastCall Configuration” in this chapter for more information.

NOTE:
FastCall Promotional does not support the File, Save
Configuration as option.

Note that Calling Numbers, Called Numbers, and Caller Input each include a
default that specifies an unknown number, for example
<NO CALLING NUMBER>. This allows you to specify trigger macros to
process cases where call information is not available. This is also useful for
re-routing calls that have no ANI to other users or to a call prompting device.
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FastCall Administration

Use the FastCall Administration program to configure FastCall for your
environment. If you did not configure FastCall during installation, you must
configure FastCall before running the FastCall Controller program. The
FastCall Controller program controls the FastCall - Call Control Keys window.

To run the FastCall Administration program, double-click on the FastCall
Administration program icon in the FastCall program group. Once FastCall
has been configured, you may also access Administration by using the
Administration icon on the FastCall - Call Control Keys window Tool bar.

FastCall Password

When you double-click on the FastCall Administration icon, the FastCall
Security dialog box is displayed (Figure 4-1). By default, there is no
password. To administer a password, refer to “Setting the FastCall Password”
later in this chapter. If you have a password, you must enter the correct
password in order to access the FastCall - Administration Program window.
After four incorrect attempts to enter the password, the program will exit.

Figure 4-1.  FastCall Security Dialog Box
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FastCall - Administration Program Window

After entering the password, the FastCall - Administration Program window
appears (Figure 4-2). FastCall configuration functions and options are
accessed from the main window. The FastCall Administration functions are
discussed in Chapters 4, 5, and 6 of this manual.

Any configuration changes that you make are automatically saved. However,
after configuring FastCall for your environment, you should back up the
configuration using the File, Save Configuration as option. See
“Saving a Configuration” in this chapter for more information.

NOTE:
FastCall Promotional does not support the File, Save
Configuration

To exit from the FastCall

as option.

Administration program, select File, Exit.

4-4



Administering FastCall

File Logs Help— — —

Incoming Call Rules...
—

Outgoing Call Rules...
—

Calling Numbers...—

Called Numbers...—

Caller Input List...—

Call Forward Destinations...—

Special Dialing Codes...—

Application Paths...—

Application Triggers—

Directory Application...—

FastCall HotKey...—

Call Log Parameters...—

Telephone Parameters...—

Preferences...—

Figure 4-2.  FastCall - Administration Program Window

4-5



Administering FastCall

Configuring the FastCall - Call
Control Keys Window Hotkey

The hotkey is a single keyboard key that toggles the display of the FastCall -
Call Control Keys window. Pressing the hotkey while the FastCall - Call
Control Keys window is visible on the screen causes the window to be
minimized. Pressing the hotkey when the FastCall - Call Control Keys window
is minimized or unfocused causes it to become visible and focused on the
screen. The PAUSE key is the default FastCall hotkey.

NOTE:
During keystroke macro recordings and playbacks, the hotkey is
disabled. It is not re-enabled until you exit the Incoming or Outgoing
Call Triggers dialog box and return to the FastCall - Administration
Program window.

If the PAUSE key is used as part of your application, you must enter
SHIFT-PAUSE when FastCall is running. This is true regardless of what
you have programmed for a hotkey.

Select Configure, Hotkey in the FastCall - Administration Program-window
to change the FastCall - Call Control Keys window hotkey. The FastCall
Hotkey window is displayed (Figure 4-3). Select from the list the key that you
want to assign as the hotkey and click the OK button.
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Figure 4-3.  FastCall Hotkey Dialog Box
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Setting the FastCall Password

The FastCall Administration program is password protected to guard against
unauthorized access to the system configuration. By default, there is no
password. The FastCall password is case sensitive.

To change the password:

1.

2.

3.

Run FastCall Administration by double-clicking on the FastCall
Administration icon in the FastCall program group.

Enter the current password to access the program.

Select File, Set System password in the FastCall -
Administration Program window.

The Set New System Password dialog box is displayed (Figure 4-4).

Figure 4-4.  Set New Password Dialog Box

4.  Enter the new password that you want to use. The password must be
at least four characters and not more than 10 characters in length.
The password is case sensitive.
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5. Click the OK button after typing the password.

The Confirm System Password dialog box is then displayed
(Figure 4-5).

Figure 4-5.  Confirm System Password Dialog Box

6. Re-enter the password in the Confirm System Password dialog box.

7. To apply the new password, you must exit from FastCall
Administration and then restart the program. When prompted for the
system password, use the new password to gain access to the
program.
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Configuring Calling Number List

The alphabetized Calling Number List identifies telephone numbers or
extensions (ANI or CLID) of people who call you. It should also include
numbers of people you call that you want in your Call list (F6), Transfer list
(F9), and Conference list (F8). These keys each invoke an alphabetized list in
which all configured Calling Numbers and Call Forward Destinations are
merged. If there is a duplicate number, FastCall displays the number from
the Calling Numbers list.

Note that these numbers represent numbers that can trigger events based on
information on incoming or outgoing calls. This list does not have to include
your entire personal directory. It should include the numbers for which you
want to specify unique handling in terms of applications that should pop-up,
calls that should be forwarded, calls that should be redirected, etc.

To configure the Calling Number List, select Configure, Calling
Numbers from the FastCall - Administration Program window. The Calling
Number List dialog box is then displayed (Figure 4-6). The Calling Number
List holds a maximum of 999 entries.

Note that the Calling Number List includes a default that specifies an unknown
number, given as <NO CALLING NUMBER>. This allows you to specify
trigger macros to process cases where calling number information is not
available. This is also useful for re-routing calls that have no ANI to other
users or to a call prompting device.
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Figure 4-6.  Calling Number List Dialog Box

Adding Items to the Calling Number List

To add an item to the Calling Number List:

1. Click the Add button in the Calling Number List dialog box.

The Add Numbers dialog box appears (Figure 4-7).
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Figure 4-7.  Add Numbers Dialog Box

2.

3.

4.

Enter the telephone number in the Enter Number field without dashes
or spaces in the number. FastCall automatically inserts dashes. If
the number is an extension, FastCall automatically detects this and
prefixes the extension with an x. Note that if you have configured
FastCall for Global Dialing, then all of the supported characters for
international dialing can be used in the Calling Number List.

In the Enter Description field, type a description for the number. The
description can be up to 22 characters in length. This is the
description that will appear in the FastCall - Call Control Keys window
for the particular number entered.

Click the Add # button to add the number and its description to the
Calling Number List.
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5.

6.

Repeat steps 2 through 4 to add
you are done adding items, click
Numbers box.

additional items to the list. When
the OK button to close the Add

Click the OK button in the Calling Number List dialog box to close the
window and return to the FastCall - Administration Program window.

Example Calling Number List

Figure 4-8 shows what the Calling Number List window might look like after
adding numbers and descriptions.

Figure 4-8.  Calling Number List Dialog Box
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Deleting Items from the Calling Number List

To delete an item from the Calling Number List:

1.

2.

3.

4.

Select Configure, Calling Numbers from the FastCall -
Administration Program window to display the Calling Numbers List.

Highlight the item you want to delete, or click on an item (the number
or description) to select it:

When the description/number that you want to delete is highlighted,
click the Delete button.

Click the OK button to close the Calling Numbers List dialog box
when you are done deleting items.

To modify an entry in the list, it must be deleted from the list and then re-
entered with the changes you want.
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Configuring Called Number List

The alphabetized Called Number List (VDN or DNIS) identifies specific
numbers called by someone that would reach you at your desk. At a
minimum, this list would include your extension. It would also include any
ACD or hunt group numbers that you would answer.

To configure the Called Number List, select Configure, Called Numbers
from the FastCall - Administration Program window. The Called Number List
dialog box is then displayed (Figure 4-9). The Called Number List holds a
maximum of 999 entries.

Note that the Called Number List includes a default value of
<NO CALLED NUMBER> that specifies an unknown number. This allows you
to specify trigger macros to process cases where the called number
information is not available.

Figure 4-9.  Called Number List Dialog Box
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Adding Items to the Called Number List

To add an item to the Called Number List:

1. Click the

The Add

Add button in the Called Number

Numbers dialog box is displayed

List dialog box.

(Figure 4-10).

Figure 4-10.  Add Numbers Dialog Box

2.  Enter the telephone number in the Enter Number field without dashes
or spaces in the telephone number. FastCall automatically inserts
dashes. If the number is an extension, FastCall automatically detects
this and prefixes the extension with an x.

3.  In the Enter Description field, type a description for the number. The
description can be up to 22 characters in length. This is the
description that will appear in the FastCall - Call Control Keys window
for the particular number entered.

4-16



Administering FastCall

4.

5.

6.

Click the Add # button to add the number and its description to the
Called Number List.

Repeat steps 2 through 4 to add additional items to the list. When
you are done adding items, click the OK button to close the Add
Numbers box.

Click the OK button in the Called Number List dialog box to close the
window and return to the FastCall - Administration Program window.

Example Called Number List

Figure 4-11 shows what the Called Number List window might look like after
adding numbers and descriptions.

Figure 4-11.  Called Number List Example
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Deleting Items from the Called Number List

To delete an item from the Called Number List:

1.

2.

3.

4.

Select Configure, Called Numbers from the FastCall -
Administration Program window to display the Called Number List
dialog box.

Highlight the item you want to delete, or click on an item (the number
or description) to select it.

When the description/number that you want to delete is highlighted,
click the Delete button.

Click the OK button to close the Called Number List dialog box when
you are done deleting items.

To modify an entry in the list, it must be deleted from the list and then re-
entered with the changes you want.
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Configuring Caller Input List

NOTE:
This feature is supported only by FastCall Professional.

The alphabetized Caller Input List utilizes the Call Prompting feature to
identify information entered via a touch-tone (DTMF) phone. Information may
be an account number such as when you call a credit card company and are
prompted to enter your account number. For caller input to be used by
FastCall, your AT&T telephone system must be equipped with the Call
Prompting feature.

NOTE:
If you are using the Call Prompting option, and you are currently active
on a call when a second call arrives at your desktop, FastCall will not be
able to retrieve the call prompting information for the newly arriving call
until that call is answered. When no other calls are active, the call
prompting information will appear automatically in the FastCall - Call
Control Keys window.

To configure the Caller Input List, select Configure, Caller Input List
from the FastCall - Administration Program menu. The Caller Input List dialog
box is then displayed (Figure 4-12). The Caller Input List can hold a
maximum of 999 entries.

Note that the Caller Input List includes a default that specifies an unknown
number, given as <NO CALLER INPUT>. This allows you to specify incoming
trigger macros to process cases when call prompting information is not
available.
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Figure 4-12.  Caller Input List Dialog Box

Adding Items to the Caller Input List

To add an item to the Caller Input List:

1. Click the Add button in the Caller Input List dialog box.

The Add Numbers dialog box is displayed (Figure 4-13).
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Figure 4-13.  Add Numbers Dialog Box

2.

3.

4.

5.

6.

Enter the caller input information (for example, account number) in the
Enter Number field without dashes or spaces.

In the Enter Description field, type a description for the number. The
description can be up to 22 characters in length.

Click the Add # button to add the number and its description to the
Caller Input List.

Repeat steps 2 through 4 to add additional items to the list. When
you are done adding items, click the OK button to close the Add
Numbers box.

Click the OK button in the Caller Input List dialog box to close the
window and return to the FastCall - Administration Program window.
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Example Caller Input List

Figure 4-14 shows what the Caller Input List might look like after you have
configured it.

Figure 4-14.  Caller Input List Example
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Deleting Items from the Caller Input List

To delete an item from the Caller Input List:

1.

2.

3.

4.

Select Configure, Caller Input List from the FastCall -
Administration Program window to display the Caller Input List dialog
box.

Highlight the item you want to delete, or click on an item (the number
or description) to select it.

When the description/number that you want to delete is highlighted,
click the Delete button.

Click the OK button to close the Caller Input List dialog box when you
are done deleting items.

To modify an entry in the list, it must be deleted from the list and then re-
entered with the changes you want.
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Configuring Call Forward
Destinations

The alphabetized Call Forward Destinations List identifies numbers or
extensions to which you commonly transfer or redirect incoming calls. The
Call Forward Destinations list that you create is invoked when you press the
F3 - Redirect button in the FastCall - Call Control Keys window. It is merged
with the FastCall Calling Number list when you press the F6 - Call button,
F9 - Transfer button or F8 - Conference button in the FastCall - Call Control
Keys window.

To configure the Call Forward Destinations List, select Configure, Call
Forward Destinations from the FastCall - Administration Program menu.
The Call Forward Destinations List dialog box is then displayed (Figure 4-15).

Figure 4-15.  Call Forward Destinations List Dialog Box
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Adding Items to the Call Forward
Destinations List

To add an item to the Call Forward Destinations List:

1. Click the Add button in the Call Forward Destinations List dialog box.

The Add Numbers dialog box is displayed (Figure 4-16). Note that
the list includes the default destinations of Attendant and Voice Mail.
At a minimum, you should add one of these destinations
Forward Destinations list. This assures that a forwarded
reaches a destination where a message can be left.

to the Call
call always

Figure 4-16.  Add Numbers Dialog Box

2. Enter the telephone number in the Enter Number field without dashes
or spaces in the telephone number. FastCall automatically inserts the
dashes. If the number is an extension, FastCall automatically
this and prefixes the extension with an x.

.

detects
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3.

4.

5.

6.

In the Enter Description field, type a description for the number in this
field. The description can be up to 22 characters in length. This
description is displayed in the Speed Dial, Transfer, Redirect and
Conference lists.

Click the Add button to add the number and its description to the Call
Forward Destinations List.

Repeat steps 2 through 4 to add additional items to the list. When
you are done adding items, click the OK button to close the Add
Numbers box.

Click the OK button in the Call Forward Destinations List to close the
window and return to the FastCall - Administration Program window.

Example Call Forward Destinations List

Figure 4-17 shows what the Call Forward Destinations List dialog box might
look like after it has been configured.

Figure 4-17.  Call Forward Destinations List Example
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Deleting Items from the Call Forward
Destinations List

To delete an item from the Call Forward Destinations List:

1.

2.

3.

4.

Select Configure, Call Forward Destinations from the
FastCall - Administration Program window to display the Call Forward
Destinations List dialog box.

Highlight the item you want to delete, or click on an item (the number
or description) to select it.

When the description/number that you want to delete is highlighted,
click the Delete button.

Click the OK button to close the Call Forward Destinations List dialog
box when you are done deleting items.
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Configuring Special Dialing Codes

The Special Dialing Codes list enables you to configure FastCall to
automatically use any internal codes required for your phone system. It can
also be used to enter special dialing sequences for international calls. Dialing
codes can specify things such as:

Action: Example Code:
Call Forwarding Activation Code: *21
Call Pickup Access Code: *67
Send All Calls Activation Code: *20
Send All Calls Deactivation Code: #20
Transfer to AUDIX® Code: *15
Login Access Code: *45,2000
Logout Access Code: *46

The Dialing Codes list appears when you press F6 - Call, and select the
Special Codes option in the Call dialog box.

Supported Characters for Special Dialing
Codes

The following characters can be used as part of the special dialing codes that
you configure. Note that these characters and their functions are supported
only for the Special Dialing Codes when the FastCall default configuration is
used (the North American Dialing Plan). When FastCall is configured for
Global Dialing Mode (see “Preferences” in this chapter), these characters can
be used anywhere within the FastCall system.

Character Meaning
, (comma) wait approximately 1.5 seconds
: (colon) wait approximately 4 seconds
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To configure dialing codes, select Configure,
in the FastCall - Administration Program window.

Special Dialing Codes
The Special Dialing Codes

List dialog box is then displayed (Figure 4-18). The list can hold up to 999
entries.

Figure 4-18.  Special Dialing Codes List Dialog Box

Adding Items to the Special Dialing Codes
List

To add an item to the Special Dialing Codes List:

1. Click the Add button in the Special Dialing Codes List dialog box.

The Add Numbers dialog box is displayed (Figure 4-19).
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Figure 4-19.  Add Numbers Dialog Box

2.

3.

4.

5.

6.

4-30

Enter the code number in the Enter Number field without dashes or
spaces. FastCall automatically adds the prefix x. You can enter
numbers, *, #, ,, or :.

In the Enter Description field, type a description of up to 22
characters for the code.

Click the Add # button to add the number and its description to the
Special Dialing Codes List.

Repeat steps 2 through 4 to add additional items to the list. When
you are done adding items, click the OK button to close the Add
Numbers dialog box and return to the Special Dialing Codes List
window.

Click the OK button in the Special Dialing Codes List dialog box to
close the window and return to the FastCall - Administration Program
window.
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Example of Special Dialing Codes List

Figure 4-20 shows what the Special Dialing Codes List might look like after it
has been configured.

Figure 4-20.  Special Dialing Codes List Dialog Box
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Deleting Items from the Special Dialing
Codes List

To delete an item from the Special Dialing Codes List:

1.

2.

3.

4.

Select Configure, Special Dialing Codes from the FastCall -
Administration Program window to display the Special Dialing Codes
List.

Highlight the item you want to delete, or click on an item (the number
or description) to select it.

When the description/number that you want to delete is highlighted,
click the Delete button.

Click the OK button to close the Special Dialing Codes List window
when you are done deleting items.
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Configuring Telephone Parameters

NOTE:
Telephone parameters usually are configured when installing the
FastCall software. If you skipped this step during installation, you must
configure telephone parameters before running the

You must configure the FastCall Telephone Parameters to

FastCall software.

match the phone
system that you are usi
familiar with the phone

ng. You may require the assistance of a technician
set.

Select Configure, Telephone Parameters in the FastCall -
Administration Program window to configure the telephone display. The
Telephone Parameters dialog box is displayed (Figure 4-21).
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Figure 4-21.  Telephone Parameters Dialog Box

Extension of Connected Phone

Enter in this field the extension number for each available call appearance of
the phone attached to the system.
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Master Redirect Number

The Master Redirect Number applies to incoming calls that are affected by a
rule. If the rule redirects the call to a busy or invalid number or extension, the
call will be re-routed to the Master Redirect Number. The Master Redirect
Number field specifies the number or extension to which calls should be
redirected or forwarded in the event that the original destination is busy or
invalid. Enter in this field the number to which all calls should be redirected in
such cases.

Number of Line Appearances

Enter in this field the number of line appearances that are connected to your
phone system. Valid entries for this field are in the range 1 to 10. FastCall
supports up to 10 line appearances.

Caller Input (supported by FastCall
Professional)

Double-click this button and the Caller Input dialog box is displayed
(Figure 4-22).
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Figure 4-22.  Caller Input Dialog Box

When using PassageWay Solution Telephony Services, Caller Input is enabled
by the use of a “monitoring” VDN. This VDN is vectored to by the original VDN
where Call Prompting digits are collected. Telephony Services monitors this
second VDN for Call Prompting information. Enter the device identification of
the VDN which is being used for monitoring purposes. This monitoring VDN
will be routed to an agent or queued to an ACD split. The monitoring VDN
must have access rights to monitor devices set in Telephony Services
Administration. Refer to the Passage Way Telephony Services Administration
Guide for further information.

Auto Login

Double-click the Auto Login button and the Telephony Server Auto Login
dialog box appears (Figure 4-23). This box will appear each time the FastCall
Controller is started unless Auto Login is configured here.
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Figure 4-23.  Telephony Server Auto Login Dialog Box

Server ID
Select from the drop down list the name of the Telephony Server to which you
wish to be attached.

Login ID
Enter your Telephony Services (NetWare) user Iogin name.
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Password
Enter your Telephony Services user password.

NOTE:
You must restart the FastCall - Call Control Keys window after changing
any Telephone Parameters, Preferences, or Outgoing Call Rules in
order for the changes to take effect. To restart the FastCall - Call
Control Keys window, double-click on the FastCall Controller icon in the
FastCall program group, then click the Yes button or press ENTER
when the dialog box asks if you want to restart the FastCall Controller.
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Configuring the Directory
Application

This Administration function allows you to select the application that will be
started or restored when the Directory Application Icon on the FastCall - Call
Control Keys window is pressed. The option is selected by highlighting the
Directory Application option in the Configure list. The Directory Application
window will appear as shown in Figure 4-24. Application Paths (see Chapter
5 for further information) must be configured for the application to show in the
Description drop down list.

Note that only one application may be selected to be started or restored by
the Directory Application icon.

If the Application Path has been configured, the status for the selected
application in the description field will be “Found.”

Figure 4-24.  Directory Application Dialog Box
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Configuring Preferences

Select Configure, Preferences in the FastCall - Administration Program
window to configure the FastCall Preference options (Figure 4-25). Features
are enabled by selecting the check box next to each description. Shown
below are the default settings for Preferences options. You must restart the
FastCall - Call Control Keys window after making changes to FastCall
Preferences in order for the changes to take effect. See Chapter 3 for
information on restarting the FastCall - Call Control Keys window.

Figure 4-25.  Preferences Dialog Box
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Enabling/Disabling Preferences Options

Preferences options are toggled between enabled and disabled. When you
check an option that is disabled (not checked), you are enabling it. When you
check an option that is enabled (checked), you are disabling it. To select a
Preferences option, click on Configure, Preferences, and then click on
the option you want by selecting the appropriate check box.

Continuous Call Window (Enabled by
default)

Enable Continuous Call Window to allow the FastCall - Call Control Keys
window to show all non-idle call appearances. With this option enabled, all
incoming and outgoing calls are shown in the FastCall - Call Control Keys
window. When Continuous Call Window is disabled, the FastCall - Call
Control Keys window does not display call information - it displays only the
call control keys. The window temporarily displays call information when
multiple calls are present and you choose any function that requires the
selection of one of the multiple calls.

Global Dialing Mode

Select this option to disable North American Dialing Plan (NADP) dialing. In
Global Mode, you may dial up to 22 digits including any characters
supported as Special Dialing Codes. When this mode is selected, Outgoing
Call Rules must be set to define the external access number and the
maximum of digits for an extension. Refer to Chapter 6 for more information.

Do Not Disturb

When Do Not Disturb is selected, the FastCall - Call Control Keys window will
not pop up automatically on incoming calls. The FastCall - Call Control Keys
window will not be displayed until the hotkey is pressed. Triggers configured
to run before answer will run when Do Not Disturb is enabled.
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Warn Before Dial Over Active Call

When the Warn Before Dial Over Active Call option is checked, you will be
alerted by a message box when attempting to place a call without putting the
active call on hold. When this option is disabled, you will not see a message
box, and placing a call with a call appearance active will cause the active
appearance to be dropped before the outgoing call is dialed. See Chapter 3
for more information.

Trigger

This option displays a submenu of trigger options.

Trigger Before Answer (Enabled by Default)
Enable this option to cause the triggers associated with calls to run before
answering a call provided there are no other calls active. This is probably the
setting you will most commonly want. This enables you to have pertinent
information on-screen before beginning to speak to the caller.

If this option is enabled, the trigger runs as soon as FastCall detects ringing.
If this option is disabled, the trigger will not occur until you press F2- Answer
(if Auto Trigger On Answer is enabled) or until you run the trigger manually
(On-Demand).

Trigger On Answer
Enable this option to cause triggers to run when the call is answered.

If this option is enabled, the trigger will execute when you press F2 - Answer
or the Answer button in the FastCall - Call Control Keys window. However, If
you pick up the telephone handset instead of using the FastCall - Call Control
Keys window options, the trigger will not run. This gives you the option of
running or not running the trigger.
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Trigger on Demand
Enable this option to cause triggers to run only on demand. Pressing SHIFT +
n where n is the call appearance number will cause the trigger to be run.

In order to avoid macro conflicts and possible data corruption, if a second
call arrives during the execution of a trigger (before trigger), the trigger for the
second call will not run automatically. The trigger for the second call can be
run manually, or on demand, by pressing SHIFT+n, where n is the line
appearance. If you press a key while the macro is executing, the macro is
suspended.

NOTE:
The FastCall hotkey and all other keyboard inputs are disabled while a
trigger is running.
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Importing and Exporting Triggers

Exporting Triggers

If you wish to export triggers to a Library file either on your hard disk or to a
diskette, select File, Export Triggers in the FastCall Administration
main window. The Select the Library Directory dialog box is then displayed
(Figure 4-26).

Figure 4-26.  Select the Library Directory Dialog Box

Trigger information is exported to the directory that you specify in this dialog
box. This directory must be created before it can be selected as part of the
path statement. Other drives or directories may be used, including floppy
disk drives.
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Once you have selected a valid path, you will have the opportunity to select
which triggers you wish to export (Figure 4-27). The selected path will be
displayed along with a list of available triggers. Select any or all of the triggers
by highlighting them. Click the check boxes for either incoming triggers,
outgoing triggers or both. FastCall will then export the selected triggers to the
directory specified.

Figure 4-27.  Export Trigger Library Dialog Box
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Importing Triggers

If you wish to import triggers from a file or from the FastCall Macro Library
diskette, select File, Import Triggers from the FastCall Administration
main window. The Select the Library Directory dialog box is then displayed
(Figure 4-28).

Figure 4-28.  Select the Library Directory Dialog Box

Trigger information is imported from the directory that you specify in this
dialog box. This directory must contain a valid trigger library, such as one
exported from FastCall, or it may be a floppy drive with the FastCall Library
Macro diskette installed.

Once you have selected a valid path, you will have the opportunity to select
which triggers you wish to import (Figure 4-29). The selected path will be
displayed along with a list of available triggers. Select any or all of the triggers
by highlighting them. Click the check boxes for either incoming triggers,
outgoing triggers or both. FastCall will then import the selected triggers and
make them part of the FastCall installation. Triggers already installed will not
be affected.

4-46



Administering FastCall

Figure 4-29.  Import Trigger Library Dialog Box
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Saving and Loading Configurations

Saving a FastCall Configuration

NOTE:
Features that are not available for FastCall Runtime and Promotional will
be grayed out.

When you have completed configuring FastCall, save the configuration
information by selecting File, Save Configuration as in the FastCall -
Administration Program window. The Save Configuration dialog box is then
displayed (Figure 4-30).

4-48



Administering FastCall

Figure 4-30.  Save Configuration Dialog Box

FastCall configuration information is saved in the directory that you specify in
this dialog box. The default configuration directory is the FastCall directory,
C:\FASTCALL\DEFAULT, as shown in Figure 4-30. Other drives or directories
may be used, including floppy disk drives.
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You can save any number of FastCall configurations. However, each
configuration must be saved in its own directory. The directory must already
exist and it must not be the root (for example, C:\) directory. If you save a
configuration to a directory that already has a set of configuration files, they
are overwritten by the new information.

You also may select the configuration information that you wish to save.
Selecting the check box next to each item listed will save that particular item.
If you wish to save the entire configuration, select the check boxes for all of
the items.

The configuration information consists of a set of files that are saved in the
specified directory. These files contain all of the information that you have
selected, such as calling party numbers, called numbers, caller input lists,
dialing codes, rules, and triggers.

Loading a FastCall Configuration

NOTE:
Features that are not available for FastCall Runtime and Promotional will
be grayed out.

You can load a FastCall configuration by selecting File, Load
Configuration in the FastCall - Administration Program window. The Load
Configuration dialog box is then displayed (Figure 4-31). Specify the
pathname of the directory containing the configuration that you want to load.
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Figure 4-31.  Load Configuration Dialog Box
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Loading FastCall Configurations on Agent
Systems

The Load Configuration and Save Configuration features allow you to create a
single configuration that can be copied to multiple systems. You must load a
FastCall configuration on each agent system. To do this, the FastCall
Administration program must be installed on each agent system. Note that
the password is not loaded as part of the FastCall Load Configuration
process. This enables a unique password to be configured at each system.

FastCall configuration information is loaded in the directory that you specify in
this dialog box. The default configuration directory is the FastCall directory,
C:\FASTCALL\DEFAULT, as shown in the dialog box. Other drives or
directories may be used, including floppy disk drives.

You also may select the configuration information that you wish to load.
Selecting the check box next to each item listed will load that particular item.
If you wish to load the entire configuration, select the check boxes for all of
the items.

The configuration information consists of a set of files that are loaded in the
specified directory. These files contain all of the information that you have
selected, such as calling party numbers, called numbers, caller input lists,
dialing codes, rules, and triggers.

Typically, the System Administrator would configure FastCall at his or her
terminal. The System Administrator would then load the configuration on each
agent system via a network or by saving the configuration to a diskette and
then using the diskette or network to load the configuration on each system.
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5
Overview

NOTE:
The FastCall Promotional and Runtime products do not allow creation of
call triggers. Triggers for your application of choice, or installation of
triggers from the Macro Library are accomplished automatically.
Access to the Macro Library is allowed with the Professional and
Runtime products. FastCall Professional has access to all of the
functionality described in this chapter.

This chapter provides instructions for setting up your applications to work with
FastCall. To set up applications for use with FastCall, you must:

■   Determine the Windows applications that you intend to use

■   Arrange your desktop by starting and minimizing all necessary
applications

■   From the FastCall Administration main window:

—  Set up the Application Paths

—  Configure Incoming Call Triggers

—  Configure Outgoing Call Triggers
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Call Triggers

Call triggers are actions that occur when a call is received or originated. A
call trigger executes the actions in an application needed for a specific call.
Triggers can be configured for incoming and outgoing calls.

Triggers work in conjunction with call rules. In summary, a rule is a set of
predefine conditions that a call must meet. When a call meets the
conditions of a rule, it causes the trigger(s) defined in the rule to run.

NOTE:
Triggers may only be created with the FastCall Professional version.

There are incoming and outgoing call rules. Call Rules are discussed in
Chapter 6 of this user’s guide.
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Determining Your Application
Requirements

Before configuring FastCall, determine how you want the telephone calls you
receive to be handled by FastCall. Determine the applications that you want
to “pop up” in Windows when calls are received. You must be familiar with the
applications to know the keystrokes required to find the correct information.
This is necessary because FastCall utilizes a macro language to pop up
applications and locate specific information within applications. FastCall
triggers make use of the macros to automatically perform defined actions.

NOTE:
Database records need to have the calling or called number as an
index inside a cardfile card.

The PBX needs to be equipped with the Call Prompting option so that
touch tone (DTMF) input collected from the caller provides information
that can be used to pop up the correct record. For example, Call
Prompting could be used to collect an account number from people
calling their bank to get information. FastCall could use this account
number to retrieve and pop up the caller’s account record when the call
is routed to a bank representative. FastCall calls this Caller Input. (See
Chapter 4.)

You need to use the Look-Up Conversion option (discussed later in this
chapter).
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Arranging Your Windows Desktop

Figure 5-1 shows how your screen, or Windows desktop, may be arranged
after launching and minimizing the applications that are typically part of your
working environment. Arrange your desktop with the applications that you
intend to use before configuring Application Paths and Call Triggers.

You may want to configure agent systems, the computers that the phone
agents will be using, to automatically run Windows and launch all of the
standard applications and FastCall Controller. This can be done using the
Windows StartUp group and Windows macros capabilities. This enables you
to create a standard environment that is fully functional any time the computer
is turned on.

Example Desktop

In the example desktop shown in Figure 5-1, we are running AT&TCall, a
Windows spreadsheet, and the Windows Clock. FastCall - Call Control Keys,
FastCall - Master Control Program, and FastCall Administration are also
running and minimized.
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File
—

Options
—

Window
— Help—

Figure 5-1.  Sample Desktop
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Configuring Application Paths

To configure application path assignments, first start all of the applications
that you plan to use with FastCall. After starting an application, it can be
minimized (iconized). If the application is not active or minimized you may
access the path by utilizing the “Browse” option.

Select Configure, Application Paths from the FastCall Administration main
window to set up the application paths. The Application Path Assignment
dialog box is then displayed (Figure 5-2). You can configure a maximum of
100 application path assignments.

Figure 5-2.  Application Path Assignment Dialog Box
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To configure application path assignments:

1. In the Description field, enter a unique description that you intend to
use to identify the application. This description will be tracked by
FastCall and used in the call triggers screen to determine the
application to be accessed.

2.  Click on the drop-down list arrow in the Pathname field to see the list
of currently active applications.

3.  In the list, click on the application you want to match to the
description you entered in the Description field. If scrolling through
the list, stop scrolling when the desired application path is displayed
in the field.

4.  Click the OK button to complete the application path assignment.

NOTE:
If the application that you want to use is not included in the Pathname
drop-down list, it means that the application is not active. In that case,
use the Browse option to find the correct path. Remember that the
application must be running in order to record Keystroke macros, and
to enable screen pops when FastCall is active.
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Configuring Application Triggers

FastCall triggers utilize macros. A macro is a sequence of instructions to
execute any number of functions and actions. By recording commonly
performed keystroke sequences as a macro, you can automate the
performance of multiple tasks. FastCall has adapted the concept to create
dynamic keystroke macros that incorporate the telephone numbers of callers
and telephone numbers to be dialed. The keystroke macros are associated
with your applications to create “triggers” that FastCall uses to integrate the
handling of incoming and outgoing calls with your applications.

The execution of application triggers is determined by selecting or
deselecting the Auto Trigger Before Answer in the FastCall Preferences.
Refer to the “Configuring Preferences” in Chapter 4 for more information.

Configuring Triggers for Incoming Calls

NOTE:
This feature allows access to the Library Macros in FastCall Runtime
and allows creation of new macros and editing of Library Macros in
FastCall Professional.

Triggers for incoming calls include a unique description (name of the trigger),
the application that the trigger will pop up in Windows, a specific window
within the application, and- the type of trigger. Both keystroke macros and
Dynamic Data Exchange (DDE) are supported trigger types. The
applications that you intend to define triggers for must be running. They can
be minimized.
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The Incoming Call Triggers Dialog Box
Select Configure, Application Triggers, Incoming Calls in the
FastCall Administration main window. The Incoming Call Triggers dialog box
is then displayed (Figure 5-3). Use this dialog box to configure all the triggers
you will use for incoming calls. You can configure a maximum of 100
incoming call triggers.

Figure 5-3.  Application Triggers Dialog Box
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About the Incoming Call Triggers Dialog Box

Index
The Index number indicates the order in which Call Triggers have been
defined and will run if multiple triggers are selected for an incoming call rule.

Look-Up Conversion Enabled
When the Look-Up Conversion Enabled option is selected, FastCall overrides
the input specified in the trigger keystroke macro and scans the look-up data
in one of the following files in the FastCall \DATA directory, relative to the input
specified in the macro:

File Scanned Macro Input
LOOKING.DAT Calling Number
LOOKED.DAT Called Number
LOOKER.DAT Caller Input

If FastCall doesn’t find a matching entry in the file, it uses a null string. If the
required look-up file does not exist, it uses a null string. Each file is in ASCII
and can be created using the Windows Notepad or a text editor. This feature
is provided in cases where you want to map the call data to other data. For
example, if you have a client who has several numbers on which they can call
you but you maintain a single account number for that client, then you would
set up the Calling Number List to include each number and set up your
trigger macro to use the Calling Number data in the trigger. You would then
create an ASCII file named LOOKING.DAT and enable the Look-Up
Conversion option. In LOOKING.DAT, you would have a list of all the phone
numbers of the client each followed by the client’s account number. When
the client calls from any of these numbers, FastCall would scan
LOOKING.DAT and use the account number in the trigger. The table below
shows how the LOOKING.DAT file would be set up:

555-1234,1234567
555-4321,1234567
555-7890,1234567
555-0987,1234567
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Description
Enter a unique description, up to 30 characters, to identify the trigger. Since
the descriptions are used by FastCall to identify the trigger in other places
such as in the Call Rules configuration dialog boxes, it is important that you
can recognize your trigger descriptions. This is discussed further in
Chapter 6.

Application
Select from the application list the application that this trigger will pop up on
screen. The applications are listed by the descriptions that you give them in
the Application Path Assignment dialog box.

Window
A Windows application can have multiple files open, each in a separate
window and each identified by a title bar. For each containing a different
database table. Within the application select the specific window you want to
pop up on screen by selecting the title bar of the window you want to pop up.

If you wish to pop the application, and use whichever to pop Access and
have the ability to access all three database tables (as described above)
select the application window option.

Trigger types
The currently supported trigger types include keystroke macros and Dynamic
Data Exchange (DDE).

Format
Selecting the Format option allows calling or called numbers utilized in
macros to be formatted to match the constraints of the telephone number field
in some windows programs (Figure 5-4). For example, some programs will
not recognize dashes or non-numeric characters in telephone number fields.

5-11



Setting Up Applications

Figure 5-4.  Telephone Number Format Dialog Box

For external numbers, use the check boxes to indicate which items to include
in the telephone number string, Separators for the area code, exchange, and
subscriber code can be set for dashes, spaces, or none. Internal numbers
may also be formatted to remove the “x” from extension numbers or to remove
numbers from the extension string.
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Recording a Macro for an Incoming Call
Trigger

To record a keystroke macro, you must know how to use the keyboard to
perform the desired functions within the applications for which you are
defining triggers. It is recommended that you practice the process before
you record the macro, making certain you know what keystrokes to use to
accomplish the actions you want the macro to perform. These actions can
include searching for specific fields within a database or other application.

When recording keystroke macros for Incoming Call Triggers, you must take
care not to create macros that might cause application malfunctions or
corrupt your application or files. The following guidelines are recommended
when recording macros:

■

■

■

■

Remember that macros may run when you are not at your desk or not
using your computer. You must take care that if the applications and
windows associated with the trigger are running, the macro will run
correctly from any cursor position or screen position in which you may
have left the application.

Make sure the macro contains keystrokes to bring the application to a
known starting point, from which the intended operations will occur,
from any of these likely cursor or screen positions. Often this can be
accomplished by a sequence of keys that always brings you to a main
menu or a general database query screen. You may need to consult
the documentation or help screens for your applications to determine
the best keystroke sequence.

Make sure that both incoming and outgoing call macros contain
keystrokes that bring the application back to a known position when
the macro completes. This helps ensure that the triggers associated
with the next call will execute correctly.

To receive the benefits of FastCall’s automated incoming call triggers,
make sure that the applications for which triggers are assigned are
returned to an appropriate screen or cursor position when you are
finished using the application. Often this can be done by assigning or
recording a hotkey sequence.
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■ Since you may interrupt macros and it is possible to prematurely abort
a macro, it is important to record macros with care and return all
associated applications to a known “FastCall-friendly” state after using
the applications.

The next section provides an example of how to record a macro for use with
the AT&TCall application.

NOTE:
You can not record macros while the FastCall - Call Control Keys
window is running. Close the FastCall - Call Control Keys window if it is
running before you record your macros. After recording the macros,
exit from the Incoming Call Triggers dialog box and restart the FastCall
- Call Control Keys window.

Do not use the mouse when recording macros. The mouse is unreliable
for macros because application windows may be located in different
areas of the screen between user sessions. The operation of the
mouse is based on its screen location.

If it is necessary to use the PAUSE key in your application, and you
want to use it within your keystroke macro, enter SHIFT + PAUSE during
recording and PAUSE will be entered as a keystroke.

To record the macro, enter or select the required information in the Incoming
Call Triggers dialog box (Figure 5-5), including the description or name of the
trigger, the application that the trigger will pop up in Windows, a specific
window within the application or the “(application window)” option (that is,
whichever window was active last in the application), and the type of trigger.
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Figure 5-5.  Incoming Call Trigger Example

Press Configure to select the specific window within the application or the
“application window” option (that is, whichever window was active last in the
application).
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Figure 5-6.  Configure Keystroke Macro Dialog Box

Click the Record button to begin recording the macro. The following
message is displayed (Figure 5-7).

The keystroke macro recorder is about to be
turned on. If you select OK or press return, the
recording will commence, and you must press
the PAUSE key to suspend the recorder.
REMEMBER: Use only keystrokes to record
your macro. Mouse movements are unreliable
for macro playbacks.

Figure 5-7.  Keystroke Macro Warning Box
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Click the OK button to begin recording the keystroke macro. When you reach
a point at which you want to insert the called number, the calling number or
the caller input, press the PAUSE button to suspend the macro recording.
The following dialog box is displayed. Use the DOWN ARROW key to select
the input you want to use with this macro, then click the OK button to continue
recording the keystroke macro.

Figure 5-8.  Macro Suspended Dialog Box

To end the macro recording, press the PAUSE key to display the Keystroke
Macro Recorder Suspended dialog box, then press the DOWN ARROW key
once to select the End Recording option button and select the OK button.

Playback
Click the Playback button to playback the macro that you just recorded. This
lets you test the macro to see that it works correctly.
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View
Click the View button to see the keystrokes that have been recorded for the
selected trigger (Figure 5-9).

Incoming trigger #1: AT&T Call Incoming

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _

[ALT]+L
[CONTROL]+F
[DELETE]
[Insert the
[ALT]+F
[ESC]

calling number]

Figure 5-9.  View Keystroke Window
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Incoming Call Trigger - Example
This example defines a trigger and keystroke macro to work with AT&TCall.
Note that the keystrokes used in this example are the keystrokes for the
AT&TCall application. The example is intended to show you the methods and
procedures for creating an incoming call trigger. The keystrokes that you
record depend on the application that you are setting up to work with
FastCall.

1.

2.

3.

Select Configure, Application Paths to configure the path for
AT&TCall.

Select Configure, Application Triggers, Incoming Calls
from the FastCall Administration main window.

Make the appropriate selections and entries in the incoming Call
Triggers dialog boxes as shown in the Figures 5-10 and 5-11.
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Figure 5-10.  Incoming Call Triggers Dialog Box
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Figure 5-11.  Configure Keystroke Macro Dialog Box

4.  Click the OK button to add the trigger, and then click the Record
button to begin recording the macro.

The following message is displayed (Figure 5-12).
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The keystroke macro recorder is about to be
turned on. If you select OK or press return, the
recording will commence, and you must press
the PAUSE key to suspend the recorder.
REMEMBER: Use only keystrokes to record
your macro. Mouse movenents are unreliable
for macro playbacks.

Figure 5-12.  Keystroke Recorder Dialog Box

5.  Click the OK button to continue and begin recording the keystroke
macro.

The application window specified for this trigger, AT&TCall, is
displayed (Figure 5-1 3).
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Figure 5-13.  Incoming Call Triggers

6.

7.

8.

Press

Press

Press

ALT + L to cancel out of Edit mode or New Card

ALT + I to Hide Notes.

HOME to place you on the first card in the bank.

mode.
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9.  Press CTRL + F to select the AT&TCall Search and Find command.

The AT&TCall Find dialog box is displayed (Figure 5-14).

Find:

Field: [all fields]

❑ Match Whole

❑ Match Case

Word Only Direction

Up  Down

Figure 5-14.  AT&TCall Find Dialog Box

10.  Press the DEL button to remove any text or characters currently
displayed in the Find field.

5-24



Setting Up Applications

11. Press the PAUSE button to suspend the macro recording.

The following Keystroke Macro Recorder Suspended dialog box
appears (Figure 5-15).

Figure 5-15.  Keystroke Macro Recorder Suspended Dialog Box

12. Select the Insert the calling number option button and then press the
ENTER key.

The Keystroke Macro Recorder dialog box is then displayed
(Figure 5-16). This dialog box provides a way of supplying data (the
number) during the recording that will normally be supplied by the
system. We have entered the extension x5000 in the example dialog
box below because this is a valid number in AT&TCall.
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Figure 5-16.  Keystroke Macro Recorder Dialog Box

13. Enter a valid number that you want to use to test the macro, and then
press the ENTER key. The number must be entered exactly as it is
formatted in AT&TCall for a successful find. Note that in real-time
operation, (that is, when the FastCall Controller is running) in order for
the Incoming Call Trigger to work properly for calling and called
numbers, the application must be formatted in the FastCall format. If
not, use the FastCall Telephone Number Format option to insure the
macro telephone number format matches your application’s format.
Also, caller input numbers must be present without embedded
dashes or non-numeric characters.

The Keystroke Macro Recorder Suspended dialog box is displayed
again, with the Resume recording option selected (Figure 5-17).
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Figure 5-17.  Keystroke Macro Recorder Suspended Dialog Box

14. Click the OK button to continue recording the macro.

The AT&TCalI Find dialog box is then displayed (Figure 5-18). The
test number, x5000, has been inserted into the Find field.
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Figure 5-18.  AT&TCall Find Dialog Box

15. Press ALT + F to execute the Find Next button in the AT&TCall Find
dialog box.

AT&TCall will search for the next occurrence of the extension x5000.

16. Press ESC once to close the Find dialog box and to ensure that if the
number is not found the application will return to its original state
when the macro has completed.
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17.  Press the PAUSE button to suspend the macro recording.

The Keystroke Macro Recorder Suspended dialog box is displayed
(Figure 5-19).

Figure 5-19.  Keystroke Macro Recorder Suspended Dialog Box

18. Select the End recording option button and then press the ENTER
key.

The macro recording for the incoming call trigger is now complete.
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19.

20.

Click the Playback button to play the macro to confirm its
performance.

During the playback, you will need to enter a valid number to test the
macro.

When the playback is completed, go to the AT&TCall application to
verify that the correct card is displayed. If the correct card does not
pop-up on screen, re-record the macro.

Configuring Triggers for Outgoing Calls

NOTE:
Outgoing Triggers can only be created with FastCall Professional. With
the FastCall Promotional product, triggers for your application of choice
and Library Macros are installed automatically. You can edit macros in
the trigger library in the Runtime and Professional versions of FastCall.

Outgoing call triggers are macros that run a set of actions when an agent
selects F4 - Dial Main or F5 - Dial Other in the FastCall - Call Control Keys
window. Triggers for outgoing calls include a unique description, or name of
the trigger, the application with which the trigger is associated, a specific
window within the application, and the type of triggers (keystroke macros or
DDE). It is not necessary to define an application path if you have already
done so for an incoming trigger.

Additionally, outgoing triggers may be configured to automatically add the
name and phone number dialed from your windows application to the FastCall
Calling Number list.

The Outgoing Call Triggers Dialog Box
Select Configure, Application Triggers, Outgoing Calls in the
FastCall Administration main window. The Outgoing Call Triggers dialog box
is then displayed (Figure 5-20). Use this dialog box to configure all of the
triggers that you want for outgoing calls.
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Figure 5-20.  Outgoing Call Triggers Dialog Box

About the Outgoing Call Triggers dialog box

Index
The Index number indicates the order in which Call Triggers have been
defined, and is used internally by FastCall. If multiple triggers are assigned,
FastCall uses the trigger with the lowest index number available to execute
when the F4 or F5 keys are pressed.
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Description

Application

Enter a unique description, up to 30 characters, to identify the trigger.

Select from the application list the application associated with this trigger.
This would be the application in which you store information such as
telephone numbers and extensions.

Window
A Windows application can have multiple files open, each in a separate
window and each identified by a title bar. For example, you could be running
Microsoft Access and have three windows open, each containing a different
database table. Within the application select the specific window you want to
pop up on screen by selecting the title bar of the window you want to pop up.

If you wish to pop the application, and use whichever window was active last
rather than a specific window, select the “(application window)” option from
the drop down list. For example, if you wanted to pop Access and have the
ability to access all three database tables (as described above) select the
application window option.

Trigger Types
Supported trigger types include keystroke macros and Dynamic Data
Exchange (DDE).
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Recording a Macro for an Outgoing Call
Trigger

Click the Record button to begin recording the macro. The Keystroke Macro
Control selection dialog box is then displayed. Select the button for the
macro that you want to record. A message box is displayed that advises you
that you are about to begin recording the macro. Click the OK button to
continue.

NOTE:
You can not record macros while the FastCall - Call Control Keys
window is running. Close the FastCall - Call Control Keys window if it is
running before you record your macros. After completing the macro
recordings, exit from the Outgoing Call Triggers dialog box and restart
the FastCall - Call Control Keys window.

Do not use the mouse when recording macros. The mouse is unreliable
for macros because application windows may be located in different
areas of the screen between user sessions. The operation of the
mouse is based on its screen location.

About Main and Other Macros
For each outgoing call trigger you may record two macros, one for the
F4 - Dial Main key and one for the F5 - Dial Other key. For each application
and window combination there should be only one trigger. If multiple triggers
are assigned, FastCall uses the trigger with the lowest index number available
to execute when the F4 or F5 keys are pressed.

Select Main to record the actions that are to occur when an agent presses the
FastCall - Call Control Key F4 - Dial Main. This macro will locate the last
active Windows application, which will typically be a database file or other
application in which you store information about people. It will then search for
the location of the Main number (for example, the person’s office number),
select it and copy it to the clipboard. FastCall will take the number from the
Windows clipboard and pass it through the computer and telephone system,
automatically dialing the Main number.
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Select Other to record the actions that are to occur when an agent presses
the FastCall - Call Control Key F5 - Dial Other. This macro will be similar to
the Main macro, but it will search for the Other telephone number (for
example, the person’s home number), select it and copy it to the clipboard,
where FastCall would take over.

Database records should be indexed and files should be organized in
consistent manners so the macro functions efficiently.

Figure 5-21 shows the relationship between the outgoing call dialing keys and
the Main and Other macros.
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Select Main to record

the actions that are to
occur when an agent
selects Call Control Key

Select Other to record
the actions that are to
occur when an agent
selects Call Control Key

F4 - Dial Main. F5 - Dial Other.

Figure 5-21.  Outgoing Macro Diagram
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Outgoing Call Trigger - Example
The following example shows how you can configure an Outgoing Call Trigger
using the AT&TCall application. If AT&TCall were the application that you use
to store the names of personal, professional and business contacts, you
would set up a trigger as in this example. This trigger would run when an
agent presses the F4 - Dial Main button in the FastCall - Call Control Keys
window.

1.  Select Configure, Application Paths to configure the path for
the AT&TCall application if this has not been done yet.

2.  Select Configure, Application Triggers, Outgoing Calls
from the FastCall Administration main window to configure the triggers
for the AT&TCaIl application.

The Outgoing Call Triggers dialog box is displayed.

3.  Make the appropriate selections and entries in the Outgoing Call
Triggers dialog box (Figure 5-22).
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Figure 5-22.  Outgoing Call Triggers Dialog Box

4. Click the OK button to add this trigger to the index of outgoing call
triggers.

5. Click on the Record button to begin recording the keystrokes that will
be executed for this trigger.

The Keystroke Macro Control selection dialog box is then displayed.
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6. Select the Main button to record the macro for dialing a contract's
primary phone number.

The warning dialog box is then displayed (Figure 5-23).

The keystroke macro recorder is about to be
turned on. If you select OK or press return, the
recording will commence, and you must press
the PAUSE key to suspend the recorder.
REMEMBER: Use only keystrokes to record
your macro. Mouse movements are unreliable
for macro playbacks.

Figure 5-23.  Warning Screen

7. Click the OK button to continue with the macro recording.

The AT&TCall application pops up on screen (Figure 5-24). Note the
AT&TCall Office # field location.
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Figure 5-24.  AT&TCall Application

8. Go to Edit Card, ALT + C, then press the TAB key eight times to
move to the Office # field.
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Figure 5-25.  Edit Card
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9.  Press CTRL + C to copy Office # field to the Windows Clipboard.

NOTE:
FastCall removes non-dialable, unsupported characters from the
string before dialing. Supported, dialable characters include
numeric characters (0-9), * (star), # (pound), , (comma), : (colon),
and + (plus). It is therefore okay to have extra characters in the
string as long as they are non-dialable. See “Supported
Characters for Special Dialing Codes” in Chapter 4.

10.  Press PAUSE to suspend the macro recording.

The options box shown in Figure 5-26 is displayed. (Selecting Copy
first, middle or last characters of name from Clipboard copies the
name and phone number of the number dialed by the outgoing
macro into the FastCall Calling Number List.)

Figure 5-26.  Keystroke Macro Recorder Suspended Dialog Box
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11.

12.

13.

14.

again.

Select the Dial from Clipboard option button, and then press ENTER.

The Keystrokes Macro Recorder Suspended dialog box appears

Press ENTER or click the OK button to resume recording.

Press ALT + L to close the Edit Card dialog box and leave AT&TCall
in a “clean” state.

Press PAUSE to suspend the macro recording.

The Keystroke Macro Recorder Suspended dialog box appears
again (Figure 5-27).

Figure 5-27.  Keystroke Macro Recorder Suspended Dialog Box
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15. Press the DOWN ARROW key to select the End recording option
button, and then click the OK button.

This completes the recording of the outgoing call trigger.

16. Click the Playback button to play the macro to confirm its
performance.

If the macro works correctly, the message box shown in Figure 5-28
will appear, showing the selected text which was copied to the
Windows clipboard.

655-1213

Figure 5-28.  Message Box
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Recording a Dynamic Data
Exchange (DDE) for an Incoming
Call Trigger

NOTE:
This feature is enabled for FastCall Professional only.

In a DDE conversation, the client’s application initiates and controls the
conversation and the application that responds is the server. The client is
application requests information from the server and sends information and
commands to it. The server application serves the needs of the client
application by returning information, accepting information and carrying out
commands.

Incoming Call Triggers

To record the macro, enter or select the required information in the Incoming
Call Triggers dialog box (Figure 5-29), including the name of the trigger, the
application that the trigger will pop up in the Windows, and the type of trigger.
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Figure 5-29.  Incoming Call Triggers Dialog Box
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Configure DDE Client

Press Configure to select the specific DDE parameters to configure and make
the appropriate selections and entries as shown in the diagram. When you
begin a DDE conversation you must specify:

■ The name of the application it wants to talk to (the server)

■ The subject of the conversation (the topic)

■ The reference to a data that is meaningful to the server application
(item)

■ The format that supports the data

NOTE:
There is no user interface to go along with the outgoing DDE. It is
always running when the FastCall - Call Control Keys are running.
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Figure 5-30.  Configure DDE Client Dialog Box
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Saving Trigger Configurations

When you have completed configuring your applications and triggers, you
should save the configuration information. See “Saving a FastCall
Configuration” in Chapter 4 for more information.
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6
Overview

This chapter provides instructions for configuring the rules that will apply to
calls received or placed by FastCall.

Call rules are filters that enable you to configure FastCall to handle calls in
particular ways. Incoming calls and outgoing calls are handled separately, so
you must configure both Incoming Call Rules and Outgoing Call Rules. In
general, a call is handled according to:

■    How the rule’s criteria filter the call.

■    What action is selected for the rule.

Rules-Based Call Processing

The flow chart shown in Figure 6-1 shows how an incoming call is processed
according to rules. Rules are applied on a priority basis. If a call does not
meet the criteria of a rule, it is compared to the criteria of the next priority rule,
and so on, until it meets the criteria of a rule. The call is processed according
to the instructions of the first rule with which it complies.
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Figure 6-1.  Rules Based Call Processing
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Incoming Call Rules

Select Configure, Incoming Call Rules in the FastCall - Administration
Program window. The Incoming Call Rules dialog box is displayed (Figure 6-
2). Use the Incoming Call Rules Dialog box to define the rules that are to
apply to incoming calls. With FastCall Professional you can define a
maximum of 100 incoming call rules. The dialog box is described in the
following section.

Figure 6-2.  Incoming Call Rules Dialog Box
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About the Incoming Call Rules Dialog Box

Priority (FastCall Professional only)
The priority of a rule determines the order in which a call is compared to the
rule’s criteria. The priority of a rule is based on the order in which it is
defined. That is, the first rule that you define is priority 1, the next is priority 2,
the next priority 3, etc. You can alter the priority assignments by adding rules
between rules. For example, if you are viewing the Priority 2 rule and click the
Add button, a new rule is inserted after rule 2 and becomes the new priority 3
rule. The old priority 3 rule becomes rule 4.

Calls are processed according to the instructions of the first rule with which
they comply. Calls are not checked against disabled rules. For example, if
you have four rules defined, priority 1 through priority 4, and you disable rule
3, calls will be checked in order against 1, 2 and 4.

The following Rules parameters are selectable for all Rules configured with
FastCall Professional. All parameters with the exception of Caller Input are
also in effect for the call rules enabled with FastCall.

Enabling/Disabling the Rule
Use the Enabled check box to enable or disable the rule. A rule is in effect
when it is enabled. A rule is not in effect when it is disabled. An X is in the
check box when the rule is enabled. The default setting is enabled. Press
ALT + E or click on the Enabled field to toggle the setting between on and off.

The Rule Description
Enter in the description field the name of the rule, up
recommend that you use descriptive names that you
recognizable.

to 30 characters. We
will find easily
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Configuring Call Rules

Use the Criteria area of the dialog box to select the items that a call must
match in order for the rule to apply to the call. The criteria let you filter calls
by time of day, calling numbers, called numbers and caller input.

Select All criteria to specify that the call must meet all of the checked criteria
items in order for the action defined in the rule to occur. This is a logical AND
of the selected criteria.

Select Any criteria to specify that if the call meets any one of the selected
criteria filters, do the action defined by the rule. This is a logical OR of the
selected criteria.

Time of Day
Select Time of Day criteria to filter calls based on the time of day that the call
is received according to the clock in your computer. Specify the range of
time to apply to the call using the time selection fields. For example, if you
wanted to answer incoming calls between 8:00 AM and 5:00 PM, you would
select the Time of Day check box, and then in the time selection fields select
From 8:00 AM to 5:00 PM.

Calling Numbers
Click on Calling Numbers to filter incoming calls based on the Calling
Number. Select all items in the Calling Number Selections list that you want to
have included by the rule. The numbers available in the Calling Number
Selections list are those that you configure in the Configuring Calling Number
List section. (Refer to Chapter 4). You can select any number of Calling
Numbers from the selections list. Only the items selected apply to the rule.

Note that the Calling Number Selections list includes a default value of
<NO CALLING NUMBER> that specifies an unknown number. This allows
you to specify trigger macros to process calls where the calling information is
not available. This is also useful for re-routing calls that have no ANI or CLID
to other users or to a call prompting device.
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Called Numbers
Click on Called Numbers and select all items in the Called Number Selections
list that you want to have included, or affected by the rule. The descriptions
listed in the Called Number Selections list are those that you configure in the
Configuring Called Number List section. (Refer to Chapter 4). You can select
any number of Called Numbers from the list. Only the numbers selected in
the list apply to the rule.

Note that the Called Number Selections list includes a default value of
<NO CALLED NUMBER> that specifies an unknown number. This allows you
to specify trigger macros to process calls where the called number
information is not available.

Caller Input (FastCall Professional only)
Select Caller Input to filter incoming calls based on caller input information
(Call Prompting data). Select the items from the Caller Input Selections list
that you want to include in the rule. You can select any number of items from
the list. Only items selected from the list apply to the rule.

Note that the Caller Input Selections list includes a default value of
<NO CALLER INPUT> that specifies an unknown number. This allows you to
specify trigger macros to process calls where call prompting information is
not available.

Action of The Rule
Select the action that you want to occur when a call meets the criteria of the
rule from the drop-down list in the Action Desired field.

Accept Call
Select Accept Call when you want the call to be answered. If desired, you
may then click the Alerts button to configure what is to occur to alert you to
the incoming call.
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Forward to Voice Mail
Select Forward to Voice Mail when you want a call that meets the conditions of
the rule to be redirected to the Voice Mail extension assigned in the Call
Forward Destinations list. The description of this number must be Voice Mail
(initial capital letters). If desired, you may then click the Alerts button to
configure the Alerts for this rule.

Forward to Attendant
Select Forward to Attendant when you want a call that meets the criteria of a
rule to be redirected to the phone attendant extension assigned in the Call
Forward Destinations list. The description for the attendant’s number must be
Attendant (initial capital letter). If desired, you may then click the Alerts
button to configure the Alert for this rule.

Forward to...
Select Forward to when you want a call that meets the conditions of the rule to
be forwarded to a number or extension. The Forwarding Destinations list
(see “Configuring Call Forward Destinations” in Chapter 4) is displayed
(Figure 6-3). Select a destination from this list or enter the number in the
Select or Enter Number field. If desired, you may then click the Alerts button
to configure the Alert for this rule.
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Figure 6-3.  Forwarding Destinations Dialog Box
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Alerts
Click the Alerts button to configure what actions to take when the rule applies
to a call. The Call Alert Options dialog box appears (Figure 6-4).

Figure 6-4.  Call Alert Options Dialog Box

Audible Alert Option
Select the audible alert option that you want for this call rule. Normal Tone is
one beep on the computer; Urgent Tone is multiple beeps.

Visual Alert Option
Select the visual alert option when you want to trigger Windows applications.
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Trigger(s)
Select the incoming call trigger(s) that you want to run when a call that has
met the criteria of the rule is supposed to be answered. You must select and
highlight a trigger from the list (even when only one trigger is listed). You can
select multiple triggers from the list. Highlight each trigger that you want to
select by clicking on it.

Configuring an Incoming Call Rule

To configure an incoming call rule:

1.

2.

3.

4.

5.

Select Configure, Incoming Call Rules from the FastCall -
Administration Program window.

The FastCall Incoming Call Rules dialog box is then displayed.

Enter a descriptive name for the rule in the Description field.

Select the Criteria that you want to apply to calls under this rule.

Select the Action Desired that you want to occur when a call meets
the criteria of this rule.

If you select Accept Call as the Action desired, click the Alerts button
to configure what is to occur when you answer the call.
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Incoming Call Rules — Examples

Example #1
We have configured the Incoming Call Rule shown in Figure 6-5 to say:

Accept all incoming calls between 7:00 AM and 6:00 PM that are dialed in on
the Called Numbers of Customer Service or Support. (See Chapter 4 for
information about configuring Called Numbers, Calling Numbers and Caller
Input.)

In other words, this rule says to accept all calls made to Customer Service or
Support between 7:00 AM and 6:00 PM.

This call rule
determines that the

incoming call
must meet All

Criteria, including:
Time of Day criterion

(From 7:00 AM To 6:00 PM)
and

Called Numbers criterion
(Customer Service and Support)

for the action of
Accept Call

to occur.

Figure 6-5.  Incoming Call Rules
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Example #1a - Alerts
When a call meets the criteria of the rule in Example #1, the action Accept
Call occurs. To alert the agent to an incoming call that should be answered,
we have configured the Alert shown in the figure below. This alert causes the
FastCall - Call Control Keys window to pop up, the computer to generate a
single beep, and causes the keystroke macro specified in the Account
Balances trigger to be played.

Figure 6-6.  Call Alert Options Dialog Box
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Example #2
We have configured the rule in this example to say:

Forward to Voice Mail all calls made by the highlighted Calling Number
selections, and received between 7:00 AM and 6:00 PM.

Figure 6-7.  Incoming Call Rules Dialog Box
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Example #3
We have configured the

Forward to Attendant all

rule in this example to say:

calls received between 12:00 PM (noon) and
from parties identified by the highlighted Calling Number selections.

This rule might be set up for important calls that you don’t want to miss
you are at lunch or otherwise pre-occupied.

1:30 PM

while

Figure 6-8.  Incoming Call Rules Dialog Box
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Example #4
The rule in this example says:

Accept all incoming calls from 7:00 AM to 6:00 PM that are made to
Accounting or Accounts Receivable.

The highlighted Caller Input selections, together with the specified time range,
are filtering the calls in this rule. If a call comes in and Caller Input indicates
the caller wants Accounting or Accounts Receivable, but the time is 7:30 PM,
this rule will not apply because the call is outside the specified time range.

Figure 6-9.  Incoming Call Rules Dialog Box
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Configuring Outgoing Call Rules

Select Configure, Outgoing Call Rules in the FastCall - Administration
Program window to configure the rules for outgoing calls. The Outgoing Call
Rules dialog box is displayed.

Rules for outgoing calls specify information about area codes and exchanges
based on the North American Dialing Plan. If Global Dialing mode is used,
refer to the section “Outgoing Call Rules, Global Dialing Mode” later in this
chapter. Enter the information appropriate to your phone system in this dialog
box to configure the rules for outgoing calls.

NOTE:
You must restart the FastCall Controller program after making any
changes to Outgoing Call Rules in order for the changes to take effect.
See the section “Starting FastCall” in Chapter 3 for information on
restarting the FastCall Controller program.
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Figure 6-10.  Outgoing Call Rules - North American Dialing Dialog Box
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About the Outgoing Call Rules Dialog Box

Local Area Code
Enter the local, three-digit area code in this field. The local area code is the
area code from which you are dialing.

Local Line Prefix
If your telephone system requires that you dial a prefix to access a local
outside line, enter the prefix in this field. FastCall automatically dials this
prefix when you press a FastCall - Call Control Key to make an outside call.

Long Distance Line Prefix
If your telephone system requires that you dial a prefix to access a long
distance line, enter the prefix in this field. FastCall automatically dials this
prefix when you press a FastCall - Call Control Key to make a long distance
outside call.

Ensure a 1 on Long Distance
Check this box if it is necessary for FastCall to dial "1" for long distance
dialing. If your PBX automatically dials "1," leave this box unchecked.

Use Area Code with Toll Calls within the Area Code
Check this box if it is necessary to dial the area code when dialing toll calls
within your local area code.

Local Exchanges
Enter in this list the three-digit exchange numbers that you call for which it is
not necessary to dial a one before dialing the exchange. When placing calls
that are beyond the local dialing range within some area codes, it is
necessary to dial a one before the exchange number. If this is not required
within your area code, you can enter ALL in the Exchanges list to indicate that
all exchanges within the area code do not require a one to be dialed.
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To add an exchange, type the number in the text field and click the Add
button. To delete an exchange number from the list, click on the number to
highlight it, and then click the Delete button.

Advanced Dialing Options (External)
The Advanced External Dialing Options dialog box configures FastCall for use
with the enhanced North American Dialing Plan (Figure 6-11).

Figure 6-11.  Advanced External Dialing Options Dialog Box
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Neighboring Area Code Index
Add any additional area codes, to a maximum of 3, where it is not necessary
to dial a "1." If an area code added here also appears as a Local area code in
the Outgoing Call rules, the Outgoing Call rules apply.

Local Exchanges (7) Digit
Add any exchanges for each neighboring area code where it is not necessary
to dial a "1" or include the area code.

Local Exchanges (10) Digit
Add any exchanges for each neighboring area code where it is not necessary
to dial a "1" but the area code must be included as part of the dialed string.

NOTE:
If there are duplicate entries in the 7 and 10-digit exchange list,
FastCall defaults to the 7-digit list.
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Advanced Dialing Options (Internal)
The Advanced Internal Dialing Options dialog box configures FastCall for use
with internal extensions (Figure 6-12).

Figure 6-12.  Advanced Internal Dialing Options Dialog Box

Maximum Number of Digits
FastCall supports extension lengths from 1 to 7 digits. Enter maximum
extension length here.

Seven Digit Extensions/Exchanges
To distinguish between 7 digit extensions and 7 digit external numbers, enter
all exchanges that are used as part of 7 digit extension numbers.
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Range of Subscriber’s Digits
Enter the range for the last four digits of any seven digit extensions that have
been added to the Exchange list.

Outgoing Call Rules, Global Dialing Mode

If you have selected Global Dialing Mode, the Outgoing Cal
are disabled
the outgoing

and the rules dialog box shown in Figure 6-13
call rules.

l rules for NADP
is used to select

Figure 6-13.  Outgoing Call Rules - Global Dialing Dialog Box

External Prefix
If your DEFINITY system requires a prefix number to dial outside calls, enter it
here.
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Max Digits for Internal Extension
Select the maximum number of digits allowed as internal extension numbers.
The allowed range is 1 to 7 digits. FastCall will consider all numbers greater
than the maximum to be external numbers.

Special Dialing Information

When using NADP, a number preceded by "011" will be dialed as entered.
FastCall will allow up to 19 digits after the 011.
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Saving Call Rule Configurations

When you have completed configuring your call rules, you should save the
configuration information. See “Saving a FastCall Configuration” in Chapter 4
for more information.
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Using Log Viewer

7
Overview

This chapter provides the following information:

■    a description of Log Viewer

■    helpful hints when using Log Viewer

■    the procedures for running Log Viewer .

■    the tasks you will perform regularly while using Log Viewer

■    a description of all the Log Viewer menu options
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What is Log Viewer?

Log Viewer is an application that enables you to view entries that are stored in
the PassageWay call log. The call log stores a record entry of the following
calls:

■    Every call you make while FastCall is running.

■    All incoming calls you received. The call log only stores entries of calls
that arrive while FastCall is running.

Figure 7-1 shows the Log Viewer window.

File Edit View
— — —

Setup Help
— —

View: All Calls Unfiltered Sorted By:     Date & Time     Newest First

Text Label Number Type Date & Time
Klien,Bruce.......................................................................................................................................................................9 - 5 5 5 - 6 1 0 0 0
Dialpad 54485 0
Dialpad
Vogel, Dennis
Phone
Unknown
Unknown
Schultz, Harvey
Phone
Unknown
Schultz, Harvey
Unknown
Dialpad

54484
54484
54484
9085554020
9085554020
54020
54484
9085554020
54028
9085554020
54484

0
0
0
I
I
0
0
I
0
I
0

03/08/94 04:54p
03/08/94 04:45p
03/08/94 04:44p
03/08/94 04:28p
03/08/94 04:28p
03/08/94 04:27p
03/18/94 04:19p
03/08/94 04:18p
03/08/94 04:18p
03/08/94 04:17p
03/08/94 04:16p
03/08/94 04:16p
03/08/94 04:15p

Unknown 9085554020 I 03/08/94 04:13p

Figure 7-1.  Log Viewer Window
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The call log can store a maximum of 8,000 entries. When this maximum is
reached, the oldest call entry (that is, entry 1) is overwritten by the newest
entry (that is, entry 8001). Each call log entry consists of the following
components:

■ the primary and secondary labels of the card associated with the call.
(For incoming calls, you only get this information if a match exists
between the caller ID and an AT&TCall file card.)

■ the account code associated with the call

■ the telephone number associated with the call (that is, the dialed
number for outgoing calls and the caller ID, if available, for incoming
calls)

■  the type of call (“O” for outgoing calls, and “l” for incoming calls)

■  the date and time the call started (that is, when the outgoing call was
dialed or the incoming call started ringing)

Log Viewer enables you to perform the following tasks with the entries in the
call log:

■  view selected entries

■  sort selected entries

■  delete entries

■  move entries from the log to a permanent archive file

■  print entries
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Helpful Hints

When using Log Viewer, keep in mind the following information:

■

■

■

When the Log Viewer window is open, select the Refresh option from
the View menu to make sure you are viewing all of the entries you have
specified. If you make a call while the Log Viewer window is open, that
entry will not be displayed in the Log Viewer. The Refresh option
insures that all relevant entries are displayed.

The call log stores a maximum of 8,000 calls. Entry 8001 overwrites the
oldest entry in the call log.

By default, the system automatically adds deleted entries to the call log
archive file. The call log archive is an ASCII file in which each field of
data is separated by a tab. The archive file is called PWLOG.ARC and
is located in your Windows directory. This file can be viewed, edited, or
modified by any program
wish to keep your call log
deleted entries to archive
Setup menu.

that can access ASCII files. If you do not
entries permanently, turn off the “Add auto.
file” option from the Preferences option in the
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Tasks

This section describes the tasks that you will use with the Log Viewer.

Deleting Entries from the Call Log

To delete entries from the call log:

1.

2.

Select the entries that you want to delete from the Log Viewer window.
If you want to select all of the entries in the Log Viewer, select Select
All from the Edit menu.

The entries that you selected are highlighted.

Perform one the following steps:

—  If you want to add these entries to the call log archive file, select
Move to Archive from the Edit menu.

The PassageWay Log Viewer dialog box appears, displaying the
number of entries that will be deleted from the call

Select the OK button.

The entries are deleted from the log and added to the archive file.

—  If you do not want to add these entries to the call log archive file,
select Delete from the Edit menu.

The PassageWay Log Viewer dialog box appears, displaying the
number” of entries that will be deleted from the call log.

Select the OK button.

The entries are deleted from the log.
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Printing Log Entries

Log Viewer enables you to print the entries that are displayed in its window.
To print log entries:

1. Using the Filter/Sort Options option from the View menu, view the calls
that you want to print.

The specified calls are displayed in the Log Viewer window.

2.  Select Print View from the File menu.

The entries displayed in the Log Viewer window are printed.

Setting the Log Viewer Preferences

You can set Log Viewer to perform the following procedures automatically:

■    delete entries after a specified number of days

■    add automatically deleted entries to the call log archive file

NOTE:
By default, the call log archive keeps a copy of all entries that are
deleted automatically by the program (for example, exceeding
the maximum number of entries or deleting entries after a certain
number of days). These entries will not be added to the call log if
the “Add auto. deleted entries to archive file” option is turned off.

■    display a warning when a specified percentage of the call log is filled

To set the preferences:

1. Select Preferences. . . from the Setup menu.

The Preferences dialog box appears.

7-6



Using Log Viewer

Automatically delete entries more than               days old
—

Add auto. deleted entries to archive file
—

Display warning when log is             % full
—

Figure 7-2.  Preferences Dialog Box

2.  Select

3.  Select

the

the

preferences you want.

OK button.

Sorting Call Log Entries

Log Viewer enables you to specify the criteria for sorting call log entries
the-order in which these sorted entries are displayed. You can sort the
displayed entries according to the following criteria:

■

■

■

■

text label

telephone number

account number

date and time the telephone number was dialed or received

and

Sorted entries can be displayed in order of oldest first or newest first.
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To sort entries in the Log Viewer:

1.   Select Filter/Sort Options. . . from the View menu.

The Filter/Sorting Options dialog box appears.

Filtering Options

Text Label
—

Number
—

Account
—

Date
—

Call Types
—

All Calls     Outgoing     All Incoming
Incoming - Unanswered   Incoming - Answered

Sort By
—

Text Label

Number
Account
Date & Time

Order
—

Oldest First
Newest First

Sorting Options

Figure 7-3.  Filter/Sorting Options Dialog Box

2.

3.

4.

Select the

Select the

Select the

option

option

button

button

OK button.

of the

of the

Sort By option you want.

Order option you want.

The Log Viewer displays the call log entries in the order in which you
requested. The top of the window displays the current sorting options.
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Specifying the Call Log Entries to be
Displayed

Log Viewer enables you to specify which call log entries you want displayed
in the Log Viewer window. You can specify entries according to the following
criteria:

■ text label

■ telephone number

■ account number

■ date

■ call type

To specify the calls to be displayed:

1.  Select Filter/Sort Options. . . from the View menu.

The Filter/Sorting Options dialog box appears.
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Filtering Options

Text Label
—

Number
—

Account
—

Date
—

Call Types
—

All Calls     Outgoing      All Incoming
Incoming - Unanswered    Incoming - Answered

Sorting Options
Sort By
—

Text Label
Number

Account
Date & Time

Order
—

Oldest First
Newest First

Figure 7-4.  Filter/Sorting Options Dialog Box

2. Select the filtering options you want.

3. Select the OK button.

Log Viewer displays the call log entries that meet the filtering options
you specified. The top of the window displays the viewing selection.
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Log Viewer Menu Bar Options

This section describes the options contained in each Log Viewer menu.

File

This section describes the File menu options.

Print View
Prints the entries that meet the criteria you specified.

Print Setup...
Displays the Windows printer setup window, allowing you to modify the printer
settings (for example, paper size and orientation).

Exit
Exits the Log Viewer application.

Edit

This section describes the Edit menu options.

Copy
Copies the currently selected information from the Log Viewer window and
places it in the Windows Clipboard.

Delete
Deletes the currently selected information from the Log Viewer window. Once
deleted, this information is no longer present in the call log.
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Move to Archive
Deletes the currently selected information from the Log Viewer window and
adds it to the call log archive file.

Select All
Selects all of the entries currently displayed in the Log Viewer window.

View

This section describes the View menu options.

Filter/Sort Options...
Enables you to specify which calls you want displayed in the
is, filter), and the order in which you want the calls displayed

Refresh
Updates the information displayed in the Log Viewer.

Hide Account Field
Enables you to either show or hide the account codes
calls displayed in the Log Viewer. A check next to this
the account codes will not be displayed for each call.

Log Viewer (that
(that is, sort).

associated with the
option indicates that
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Setup

This section describes the Setup menu option.

Preferences...
Enables you to set Log Viewer to perform the following procedures
automatically:

■

■

■

Help

delete entries after a specified number of days

add automatically deleted entries to an archive file

display a warning when a specified percentage of the call log is filled

This section describes the Help menu options.

Contents
Enables you to access the on-line help for Log Viewer.

Search for Help on...
Enables you to access help information on a certain topic.

How to Use Help
Describes how to use the on-line help for Log Viewer.

About PassageWay Log Viewer
Displays the number of entries currently in the view (that is, the number of
entries that meet the criteria you specified), the capacity of the call log, and
the number of entries in the call log.
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8
Overview

AT&TCall is a card file application that enables you to maintain information
such as names, addresses, and telephone numbers. You specify the
information that you want to store. With AT&TCall, you can place calls directly
from your PC.

This chapter provides the following information:

■     a description of AT&TCall

■     a tutorial describing how to use AT&TCall

■     helpful hints when using AT&TCall

■     the procedures for running AT&TCall

■     the tasks you will perform regularly while using AT&TCall

■     a description of all the AT&TCall menu options
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NOTE:
You can use AT&TCall with FastCall, or you can use AT&TCall as a
standalone application. If you run AT&TCall with FastCall, you can make
calls from FastCall just using AT&TCall as the directory application, or
you can make calls directly from AT&TCall. If you run AT&TCall as a
standalone application (that is, without running FastCall), you make
calls from AT&TCall. If you use AT&TCall to make calls, you must log
into the Telephony Server from AT&TCall before you can make any
calls.

chapter:

■

■

Before using AT&TCall, you Should consult the following sections of this

"What is AT&TCall?," which describes AT&TCall and provides tasks that
you can perform with AT&TCall

"Getting Started," which is a tutorial that shows you how to use
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"Helpful Hints," which provides some "inside" tips and shortcuts that■

maximize your time and effort when using AT&TCall
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What is AT&TCall?

As mentioned previously, AT&TCall is a card file application. To understand
how AT&TCall operates, it is helpful to recall how a card file works. A card file
is a unit that stores separate index cards, which are sorted according to
whatever method you want (usually alphabetical order) and contain specific
information you enter. When you obtain a new card file, it is usually empty.
You must then enter data on a card and add the card to the card file.
Eventually, the card file contains a “bank” of cards. If you want to modify a
card in the card file, you must find the card in the card file, remove it, make
your changes, and then place it back to its position in the bank. If you want to
remove a card, you must locate the card in the card file and remove it
(usually, you throw it away).

Each AT&TCall file can be thought of as being a separate card file unit. Each
AT&TCall file contains separate data entries, which are referred to as “cards.”
The collection of these cards is referred to as a “bank.” Each AT&TCall file can
contain a maximum of 2000 cards in its bank. These cards are sorted in
whatever manner you specify (via the Sort option in the View menu) and
contain specific information that you enter. Figure 8-1 shows the components
of an AT&TCall window.
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List Field Card File name Quick Dial

Dial Button

Label Button

Slider Dial Button

Figure 8-1.  Components of an AT&TCall Window

When you create a new AT&TCall file, it does not contain any cards. The List
field, which lists the cards present in the file, is empty, and the screen
displays a blank card. As with a card file, you must then access a new, blank
card (via the New Card button), enter data on the blank card, and add the
new card to the bank of the AT&TCall file (via the Add Card button).
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If you want to modify a card in the AT&TCall file, you must find the card that
you wish to modify, remove it from the card bank, make your changes to the
card (via the Edit Card button), and then place it back in the bank (via the
Return Card button). If you want to delete a card, you must locate the card in
the AT&TCall file and delete it (via the Delete Card option in the Edit menu)
from the bank of the AT&TCaIl file. If you make changes that you want to save,
you must save the entire card bank to a file (via the Save or Save As options
in the File menu).

Unlike a card file, AT&TCall enables you to perform the following tasks quickly
and easily:

■    place calls directly from a card

■    sort cards in a AT&TCall file any way you want

■    modify the card labels for all the cards in the AT&TCall file

■    keep track of all the calls you make

■    include notes for each card

■    implement passwords to prevent unauthorized use of your AT&TCall
files

Each AT&TCall file also provides a “desktop” with Quick Dials, which are
similar to autodial buttons on your telephone. AT&TCall provides a maximum
of 50 Quick Dials (two sets of 25) per file. However, if you need no more than
20 Quick Dials, you can set AT&TCall to display a maximum of 20 Quick Dials
(two sets of 10). AT&TCall also enables you to hide all of the cards in your
AT&TCall file. In this situation, only the Quick Dials, Hang Up button, Dialpad
button, Timer button, and Quick Shift button (if 50 Quick Dials are used) are
displayed.

Depending on the number of Quick Dials you specified and whether the card
is hidden, your AT&TCall file desktop can have four different “looks.” Figures
8-2, 8-3, 8-4, and 8-5 show these different desktop looks.
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Figure 8-2.  Desktop with 10/20 Quick Dials and Card Shown
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Figure 8-3.  Desktop with 10/20 Quick Dials and Card Hidden
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Figure 8-4.  Desktop with 25/50 Quick Dials and Card Displayed
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Figure 8-5.  Desktop with 25/50 Quick Dials and Card Hidden
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Getting Started

If you are using AT&TCall for the first time, it is a good idea for you to perform
the tutorial, which provides the basic procedures for using AT&TCall. This
tutorial takes approximately 15 minutes to complete and shows you how to
perform the following tasks:

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

Run AT&TCall.

Open an existing AT&TCall file.

Modify an existing card.

Create a new card.

Enter notes for a card.

Make a telephone call from AT&TCall.

Save an existing file.

Create a new file.

Customize the labels in a file.

Assign a telephone number to a Quick Dial.

Save a new file.

Exit AT&TCall.

After completing this tutorial, you will have performed most of the basic
procedures necessary to use AT&TCall.
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Step 1: Running AT&TCall

Before you can perform any AT&TCall tasks, you must run AT&TCall. In order
to run AT&TCall, you must first access Windows and open the program group
that contains the PassageWay Solution applications. To run AT&TCall, double-
click on the AT&TCall icon. The Telephony Server Identification dialog box
appears.

Server Name:

Phone Ext.:

Session Inactive

ATT#G3_SWITCH#CSTA#INHOUSE

72704

Figure 8-6.  Telephony Server Identification Dialog Box

The Telephony Server Identification dialog box contains the following
information:

■     the name of the server

■     your telephone extension

The first time you run AT&TCall, the Telephony Server Identification dialog box
contains “sample” information for the Server Name and Phone Ext. fields
(Figure 8-7).
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Session Inactive

Server Name:

Phone Ext.:

Figure 8-7.  Initial Telephony Server Login Dialog Box

Every time you access AT&TCall, you will be prompted to enter your
password for the Telephony Server in order to log into the Telephony Server.
You can use AT&TCall without logging into the Telephony Server, but you will
be unable to make calls using AT&TCall.

If you are running AT&TCall for the first time, perform the following steps:

1.

2.

3.

4.

5.

8-12

Enter the name of the server or select the name of the server in the
Server Name box.

Enter your telephone extension in the Phone Ext. box.

Select the OK button.

The Telephony Server Login dialog box appears.

Enter your Iogin ID on the Telephony Server in the Login ID box.

Enter your password in the Password box, and then select the OK
button.
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If the information you entered in this dialog box is correct, an untitled
AT&TCall window appears, displaying a blank card.

If you have run AT&TCalI before, perform the following steps:

1.

2.

Select the OK button in the Telephony Server Identification dialog
box.

The Telephony Server Login dialog box appears. Your Iogin ID and
password are displayed.

Select the OK button.

If the Iogin ID and password entered in the Telephony Server Login dialog
box are correct, an untitled AT&TCall window appears, displaying a blank
card.

At this point, you can either enter information into this new file (by adding new
cards) or open an existing file. For this tutorial, you will open an existing file.

Step 2: Opening an Existing AT&TCall File

In this step you will learn how to open an existing file by opening the file
“sample. dex.” This file was copied to your PC when you installed the
PassageWay Solution applications.

To open an existing AT&TCall file, perform the following steps:

1.

2.

Select Open. . . from the File menu.

The Open dialog box appears.

Select sample.dex from the File Name box, and select the OK
button.

The AT&TCall file titled “SAMPLE.DEX” appears. This file was copied
to your hard disk during the installation procedure. AT&TCall displays
the last state of the card bank. Whenever you open an existing
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AT&TCall file, AT&TCall displays the last card that was displayed
before you saved and exited that file.

NOTE:
You can only run one instance of AT&TCall at a time.

Step 3: Editing an Existing Card

In this step, you will learn how to modify the information that is present in an
existing card (that is, a card that was already created and added to the card
bank).

The displayed card information cannot be modified directly. To make any
changes to this information, you must “edit” the card. However, before you
can edit an existing card, you must first locate the card in the bank. AT&TCall
provides several methods for selecting a card:

■   clicking on the card in the List field

■   clicking on the Next and Previous arrow buttons located on each side
of the Show Notes button

■   clicking on the appropriate letter in the Slider, located at the bottom of
the AT&TCall window. For example, if the name you wanted started
with the letter “w,” you could click on the “w” on the Slider. The first card
that began with the letter “w” would be selected and displayed.

To edit

1.

a card, perform the following steps:

Select the card “Kemp, Dave” from the card bank using one of the
methods described above.

The card for Dave Kemp appears.
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2.

3.

4.

5.

Select the Edit Card button, which is located beneath the List field.

The Edit Card window appears and displays all the information for the
selected card. The cursor is located in the top label field (“Last”), and
the name “Kemp” is highlighted. The Edit Card button removes the
card from the card bank, enabling you to modify the card.

NOTE:
In the AT&TCall window, the Edit Card and the New Card
buttons are “grayed” while you are editing or adding a card.
Only one card can be “out” of the card bank of an AT&TCall file
at one time.

You can move the cursor from field to field in the Edit Card window by
performing one of the following actions:

—

—

—

pressing TAB or ENTER to move the cursor to the next field

pressing SHIFT+TAB or SHIFT+ENTER to move the cursor to the
previous field

clicking the mouse on the field you want to select

Using one of the methods described above, move the cursor to the
“Title” field, and type Manager.

Using one of the methods described above, move the cursor to the
“City” field, delete Sea Bright , and type Asbury Park.

Select the Return Card button.

The Edit Card window disappears, and the changes you made are
displayed. The modified card for Dave Kemp is returned to the bank
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Step 4: Creating a New Card

In this step, you will learn how to create a new card, enter information into it,
and add the card to the bank.

To add a new card to the card bank, you must get a new, blank card, enter
the data in it, and then add the card to the bank.

To add

1.

2.

3.

4.

a new card to the card bank, perform the following steps:

Select the New Card button

The New Card window appears, and the cursor is located in the “Last”
field. The contents of this window is a new, blank card.

Type Meyer.

Using one of the methods described previously, move the cursor to
the “First” field, and type Fred.

Select the Add Card button.

The New Card window disappears, the labels for the new card
appear in he List field, and the information for the new card is
displayed. The new card is now part of the card bank.

Now create a new card for someone you know. When entering the information
in the new card, be sure to include that person’s phone number in either the
Office # or Home field. Enter the phone number the same way as you would
when you are dialing it from your telephone. For example, if you must enter a
“9” before dialing the phone number, include “9” at the beginning of the phone
number in the card. You will use this new card again in Step 6. After creating
this card, select the card “Meyer, Fred” from the card bank, and proceed to
Step 5.
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Step 5: Entering Notes for a Card

In this step, you will learn how to enter notes for the card that you created in
Step 4.

AT&TCall enables you to enter notes for each card in a card bank. The Notes
field can contain up to 32K. When a card contains notes, the Notes icon
appears to the left of the Show Notes button. To enter notes for a card,
perform the following steps

1.

2.

3.

Select the Show Notes button.

The card display is replaced by a blank “note pad.”

Select Insert Timestamp from the Edit menu.

The day, date, and time are inserted at the top of the note pad.

Type Must call tomorrow , and then select the Hide Notes button.

The card display replaces the note pad. The Notes icon appears to
the left of the Show Notes button, signifying that notes are present for
this card.

Step 6: Making Calls

In this step, you will learn how to make a call from the card you created in
Step 4 for someone you know and also make a call fro the dialpad.

NOTE:
You should perform this step only if you logged in from AT&TCall.

AT&TCall provides the following ways for you to make phone calls while in a
file:

■     the Dial buttons on each card

■     the Quick Dials in the AT&TCall window

■     the Dialpad
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Making a phone call with a Dial button on a card consists of clicking on the
Dial button next to the phone number on the displayed card. To make a call
from a card, perform the following steps:

1.

2.

3.

Select the card you created in Step 4.

The card appears.

Click on the Dial button next to that person’s phone number.

If you do not have a speakerphone, pick up the handset. AT&TCall
places the call. you have five seconds to go off hook (that is, pick up
the handset) after clicking on the Dial button. If you pick up the
handset after the five second interval expires, the call is denied. You
can also place a call by lifting the handset before clicking on the Dial
button.

If you have a speakerphone, your speakerphone activities, and
AT&TCall places the call.

Select the HangUp button, or hang up the handset to disconnect the
call.

The Hang Up button is enabled whenever you make an outgoing call via
AT&TCall or your telephone while AT&TCall is running. As long as the call you
make is active, the Hang Up button remains enabled. For example, if you
place a call on hold via your telephone, the Hang Up button is disabled.
However, as soon as you return to the call on hold, the Hang Up button is
enabled

Making a phone call with Quick Dial consists of clicking on the Dial button of a
Quick Dial that you have already programmed with a telephone number. (If
you do not have a speakerphone, you must pick up the handset.) This
procedure is described later in this tutorial.

Making a phone call using the Dialpad feature is similar to dialing a phone
number on your telephone.
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To make a call from the Dialpad, perform the following steps:

1.

2.

3.

4.

Select the Dialpad button

The Dialpad window appears.

Using the PC keyboard or clicking on he buttons in the Dialpad
window, enter a phone number.

When entering the telephone number, make sure you enter the
number the same way as you would when you are dialing it from your
telephone. For example, if you must enter a “9” before dialing a
telephone number outside of your telephone system (that is, an
outside call), enter a “9” in the beginning of the phone number. At any
time, you can edit the digits that you enter in the Dialpad window.

AT&TCall also enables you to copy telephone numbers to the
Windows clipboard. You may then paste the telephone numbers to
the Dialpad window.

Click on the Dial button.

If you do not have a speakerphone, pick up the handset. AT&TCall
places the call, and the Dialpad window closes automatically. You
have five seconds to go off hook (that is, pick up the handset) after
clicking on the Dial button. If you pick up the handset after the five
second interval expires, the call is denied. You can also place a call
by lifting the handset before clicking on the Dial button.

If you have a speakerphone, the speakerphone activates, and
AT&TCall places the call. The Dialpad window closes automatically.

Select the Hang Up button, or hang up the handset to disconnect the
call.
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Step 7: Saving an Existing File

In this step, you will learn how to save to the hard disk of you PC the changes
that you made to the existing file.

Now that you are done making the cards in the “sample.dex” file you must
save your changes to disk. Select Save from the File menu. This procedure
saves the changes you made to “sample,dex” to the hard disk of your PC.

Step 8: Creating a New AT&TCall File

In this step, you will create a new AT&TCall file. New files are empty (that is,
they have no cards in the bank) and untitled. You will use this new file to learn
how to customize the labels of the card display in a file (Step 9).

To create a new AT&TCall file, select New from the File menu. An untitled,
empty AT&TCall file appears. This file is empty and displays a blank card.

Step 9: Customizing the Labels

In this step, you will learn how to customize the labels of the card display of
the new file you created in Step 8.

When you initially access a new AT&TCall file, AT&TCall displays the default
labels for the cards (for example, "Last:," "First:," "Title:," and "Company:").
However, you can change these labels at any time, enabling you to create
custom templates for the cards in your AT&TCall files. Whatever changes you
make to the labels apply only to the cards in the AT&TCall file in which you are
working. As a result, you can have AT&TCall files with different labels on their
cards. However, all the cards in the file have the same labels.
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To customize the labels, perform the following steps:

1.

2.

3.

4.

Select Edit Labels. . . from the Setup menu.

The Edit Labels dialog box appears.

Using the methods described previously, move the cursor to
Text Field #7.

Delete State:, and enter Country:.

Select the OK button.

The Edit Labels dialog box appears, and the new field label is
displayed on the card template.

Step 10: Programming a Quick Dial

In this step, you will learn how to program a Quick Dial in a new AT&TCall file
that you created.

NOTE:
You should perform this step only if you logged in from AT&TCall.

AT&TCall enables you to program Quick Dials for each AT&TCall file. Quick
Dials consist of two components: a Label button and a Dial button. The Label
button displays information you want to be displayed on the button (for
example, the person’s name). The Dial button dials the phone number you
specified on the related card. AT&TCall Quick Dials act the same way as
autodial buttons on your telephone.

The card bank in this new AT&TCall window is empty. Since a Quick Dial dials
the phone number from a specified card, you must create a card before you
can program a Quick Dial.
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To create a card, perform the following steps:

1.

2.

3.

Select the New Card button

The New Card window appears.

Fill out the card for someone you know. Make sure you enter a
telephone number for the person

When entering the telephone number, make sure you enter the
number the same way as you would when you are dialing it from your
telephone. For example, if you must enter a “9” before dialing a
telephone number outside of your telephone system (that is, an
outside call), enter a “9” in the beginning of the phone number

When finished, select the Add Card button.

The new card is displayed.

Dial.

After creating a card, you can program the phone number for that card to a
Quick Dial.

To program a Quick Dial, perform the following steps:

1.  Press and hold down SHIFT and click on a Label button of a Quick

The Create Quick Dial dialog box appears, displaying the label that
will appear on the Quick Dial Label button and the telephone number
that the Quick Dial will dial. You may modify the label to make it more
descriptive to you and select the option button of the phone number
that you want this Quick Dial to dial (if more than one telephone
number is available).

When programming Quick Dials, you may want to modify the labels.
For example, suppose you want to program a Quick Dial for a friend’s
office telephone number, and also program a Quick Dial for that
person’s home telephone number. If you do not modify the Label
buttons when programming these Quick Dials, you will have two
Quick Dials that have the same labels, but dial different telephone
numbers. By looking at the Label buttons of these Quick Dials, you
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will be unable to determine which Quick Dial dials the office telephone
number, and which Quick Dial dials the home telephone number. In
this case, it would make sense to include terms such as “Home” or
“Office” in the labels to differentiate what each of the Quick Dials will
dial

2.  When finished, select the OK button.

The Create Quick Dial dialog box closes, and the label appears on
the Label button of the Quick Dial.

Step 11: Saving a New File

In this step, you will learn how to save the new file to the hard disk of your PC.

To save this new file to disk, perform the following steps:

1.

2.

3.

Select Save AS. . . from the File menu.

The Save As dialog box appears.

Enter trial in the File Name box.

NOTE:
AT&TCall automatically adds the “.dex” suffix to the file name
you enter. If you prefer, you may enter another suffix. However,
it is recommended that you use the “.dex” default to make it
easier to identify and load AT&TCall files.

Select the OK button.

The Save As dialog box appears, and “AT&TCall-TRIAL.DEX”
appears in the title bar of the AT&TCall window.
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Step 12: Exiting AT&TCall

In this step, you will learn how to exit AT&TCall.

Now that you have completed the AT&TCall tutorial, exit AT&TCall. To exit
AT&TCall, select Exit from the File menu. The AT&TCalI window closes.
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Helpful Hints

Once you have completed the tutorial, refer to the following hints:

■ Keep all AT&TCall files in the same directory.

By default, AT&TCall saves and opens files from the directory in which
the PassageWay Solution applications are installed. By keeping all the
AT&TCall files in the same directory, you can easily access your files.

■ Determine whether you need more than 20 Quick Dials.

AT&TCall enables you to program a maximum of 50 Quick Dials (two
sets of 25, which are accessed via either the Quick Shift button or the
Quick Shift option in the View menu). However, if you need no more
than 20 Quick Dials, you can set AT&TCall to display a maximum of 20
Quick Dials (two sets of 10, which are accessed via the Quick Shift
option in the View menu). See “Changing the Number of Quick Dials
Displayed,” described later in this chapter.

■ Administer a password for your AT&TCall files.

To prevent unauthorized individuals from accessing your files,
administer passwords for your AT&TCall files. See “Protecting an
AT&TCall File with a Password,” described later in this chapter.
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Running AT&TCall

In order to run AT&TCall, you must access Windows and open the program
group that contains the PassageWay Solution applications. To run AT&TCall,
double-click on the AT&TCall icon. The Telephony Server Identification dialog
box appears.

Session Inactive

Server

Phone

Name: ATT#G3_SWITCH#CSTA#INHOUSE

Ext.: 72704

Figure 8-8.  Telephony Server Identification Dialog Box

The Telephony Server Identification dialog box contains the following
information:

■ the name of the server

■ your telephone extension

The first time you run AT&TCall, the Telephony Server Identification dialog box
contains “sample” information for the Server Name and Phone Ext. fields
(Figure 8-9).
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Session Inactive

Server Name:

Phone Ext.:

Figure 8-9.  Initial Telephony Server Identification Dialog Box

Every time you run AT&TCall, you will be prompted to enter your password for
the Telephony Server in order to log into the Telephony Server. You can use
AT&TCaIl without logging into the Telephony Server, but you will be unable to
make calls using AT&TCall.

If you have run AT&TCall before, perform the following steps:

1.  Select the OK button in the Telephony Server Identification dialog
box.

The Telephony Server Login dialog box appears. Your Iogin ID and
password are displayed.

2.  Select the OK button.

If the information you entered in this dialog box is correct, an untitled
AT&TCall window appears, displaying a blank card.
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If you are running AT&TCall for the first time, perform the following steps:

1.

2.

3.

4.

5.

Enter the name of the server or select the name of the server in the
Server Name box.

Enter your telephone extension in the Phone Ext. box.

Select the OK button.

The Telephony Server Login dialog box appears.

Enter your Iogin ID on the Telephony Server in the Login ID box.

Enter your password in the Password box, and then select the OK
button.

If the information you entered in this dialog box is correct, an untitled
AT&TCall window appears, displaying a blank card.
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File Tasks

This section describes the tasks that you will perform when working in an
AT&TCall file.

Changing How Cards are Sorted in an
AT&TCall File

AT&TCall enables you to change the order in which cards are organized in
the card bank. To change how cards are sorted in your AT&TCal file:

1.  Select Sort. . .from the View menu.

The Sort dialog box appears.

Select the fields that will be used to
organize your card bank. “First” will be
used as most important when the cards in
your card bank are sorted.

First:

Second:

Last:

First:

Figure 8-10.  Sort Dialog Box

2.  Select the First box, and select the label of the field that you want
AT&TCall to sort by first.

3.  Select the Second box, and select the label of the field that you want
AT&TCall to sort by second.

8-29



Using AT&TCall

4.  Select the OK button.

The Sort dialog box closes, and the cards are now sorted in the card
bank according to your specifications.

Creating a File Template

AT&TCall enables you to create a template for all new AT&TCall files that you
open. Once you create a template, all of your new AT&TCall files will have the
attributes (for example, specific labels or the number of Quick Dials that you
want displayed) that you specified in the template. For example, suppose you
want 25 Quick Dials, a card with your home phone number, and the first
Quick Dial programmed with your home phone number in every file that you
create. If you specify these attributes in your template, every new file that you
create will automatically have 25 Quick Dials, a card with your home phone
number, and the first Quick Dial programmed with your home phone number.
At any time, you can modify or delete this file.

To create a template:

1.

2.

3.

4.

Select New from the File menu.

A new, untitled AT&TCall window appears.

Customize the file to your specifications. For example, modify the
labels, add any cards that you want to appear in all of your new
AT&TCall files, and specify the number of Quick Dials you want in all
of your new AT&TCall files.

When you are finished, select Save AS. . . from the File menu.

The Save As dialog box appears.

Enter attcall.tpl in the Filename box, and select the OK button.

The template is now saved. Every new file you open will now contain
the attributes that you specified in your template.
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Creating a New AT&TCall File

To create a new AT&TCall file:

1.  Select New from the File menu.

A new, empty AT&TCall file with the title “(UNTITLED. DEX)” appears.
When you save this file, AT&TCall will prompt you to name the file.

2.  Enter your information in this file.

3.  When you are finished working and want to save this file, select Save
As. . . from the File menu.

AT&TCall prompts you to name this file.

4.  Enter the file name in the File Name box, and then select the OK
button.

The name of the file appears in the title bar of the window.

Dialing a Phone Number with the DialPad

NOTE:
You should perform this procedure only if you logged in from AT&TCall.

To dial a phone number with the Dialpad:

1.

2.

 Select the Dialpad button.

The Dialpad window appears.

Using your PC keyboard or clicking on buttons in the Dialpad window,
enter the phone number.

When entering the telephone number, make sure you enter the
number the same way as you would when you are dialing it from your
telephone. For example, if you must enter a “9” before dialing a
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3.

4.

telephone number outside of your telephone system (that is, an
outside call), enter a “9” in the beginning of the phone number. At any
time, you can edit the digits that you enter in the Dialpad window.

AT&TCall also enables you to copy telephone numbers to the
Windows clipboard. You may then paste the telephone numbers to
the Dialpad window.

Click on the Dial button.

If you do not have a speakerphone, pick up your handset. AT&TCall
places the call, and the Dialpad window closes automatically. You
have five seconds to go off hook (that is, pick up the handset) after
clicking the Dial button. If you pick up the handset after the five-
second interval expires, the call is denied. You can also place a call
by lifting the handset before clicking on the Dial button.

If you have a speakerphone, the speakerphone activates, and
AT&TCall places the call. The Dialpad window closes automatically.

When the call is completed, select the Hang Up button, or hang up
the handset to place your telephone on hook.

Exiting AT&TCall

To exit AT&TCall, select Exit from the File menu.

Exporting AT&TCall Information

AT&TCalI enables you to export a single card or an entire AT&TCall file to a
file in the comma separated values format (“.csv”), which can be used in other
applications. During the export procedure, AT&TCall takes the 12 fields on a
card and the associated Notes field and writes them out in a horizontal line in
a “.CSV” file. This line of information from a card is referred to as a “record.” If
you export an AT&TCall file that has 20 cards, the “.CSV” file will have 20
records.
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To export an AT&TCall file or card:

1.

2.

3.

Open the file that has the information you want to export.

The AT&TCall window appears.

NOTE:
If you only want to export one card, select that card in the bank.

Select Export from the File menu.

A second menu appears.

Select All Cards. . . if you want to export the entire AT&TCall file,
or select Current Card. . . if you want to export the currently
displayed card.

The Export dialog box appears.

Figure 8-11.  Export Dialog Box
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4.  Enter the name of the file to which you want to save this information
and select the OK button.

The Export dialog box closes, and the new file is created.

Importing Files into AT&TCall

AT&TCall enables you to import files that were created in other applications.
To be imported by AT&TCall, these files must be in the comma separated
values format (“. CSV”). A “. CSV” file consists of “records,” which are horizontal
fields of data. Each field of data is separated from the next field by a comma
(,). Fields containing commas and/or fields consisting of more than one line
must be surrounded by quotes (""). Each record is one group of related data.

The end of each record is signified by a carriage return. A “.CSV” file can have
numerous fields in a record. However, AT&TCall will only import 13 fields of
data from each record in a “.CSV” file. Three records in a “.CSV” file may look
like this:

Nolan, Pat, "ABC Travel, Inc."
Ricker, Lisa, "ABC Travel, Inc."
Vidil, Rich, "ABC Travel, Inc."

AT&TCall imports 13 horizontal data fields from the “.CSV” file, and then places
the information in the 13 vertical fields of a card in an AT&TCall file (that is, the
12 card fields and the Notes field). If there are more than 13 fields of data in a
record, AT&TCall ignores the remaining data in that record and proceeds to
the next record. If there are less than 13 fields of data in a record, AT&TCall
assumes that the remaining fields in the record are blank and proceeds to the
next record. For example, if each record only contained two fields of
information, AT&TCall would place the information in the first two fields in a
card (for example, the “Last” and “First” label fields) and make the remaining
fields in that card blank. It would then proceed to a new card and enter the
information for the next record.
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During the import procedure, AT&TCall scans the file to be imported, verifying
that the file is valid (that is, it is in the correct format) and that only numeric
characters will reside in the telephone number fields (that is, the ninth, tenth,
and eleventh fields) in a card in an AT&TCall file. The telephone number fields
in a card accept all numeric digits, *, #, (,), hyphens, spaces, and commas.

To import a file:

1.  Open the AT&TCall file in which you want the imported data to reside.

The AT&TCall file window appears.

NOTE:
If you are importing data into an existing AT&TCall file, the new
data will be sorted automatically as it is imported. As a result,
this new information will be mixed in with your existing
information.

2.   Select Import. . . from the File menu.

The Import dialog box appears.

3.  Select the file that you want to import, and select the OK button.

AT&TCall scans the file and then imports the records from the file (if
the file is valid). A dialog box appears, stating the number of cards
(that is, records) that were imported from the “.CSV” file.

4.  Select the OK button.

The dialog box closes, and the new information is displayed in the
AT&TCall window.
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Modifying the Telephony Server Login
Parameters

NOTE:
You should perform this procedure only if you are using AT&TCall as a
standalone application (that is, you are not running AT&TCall with
FastCall).

AT&TCall enables you to modify the following information that you use to log
into the Telephony Server:

■      your Iogin ID

■     your password

■     the name of the server

■     your telephone extension

If any of this information is incorrect, you will be unable to access the
Telephony Server, preventing you from making calls using AT&TCall. You
cannot change your actual Iogin and password on the Telephony Server using
the Telephony Server Login dialog box. This dialog box only enables you to
modify the information that AT&TCall sends to the Telephony Server when you
attempt to log in.

NOTE:
You cannot modify the Telephony Server Login information while you
are logged into the Telephony Server (that is, while you are in an active
session).
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To modify the login information:

1.

2.

3.

Make sure that you are not logged into the Telephony Server. (Refer
to “Verifying the Connection with the Telephony Server” to determine
whether you are logged in.)

If you are already logged into the Telephony Server, exit AT&TCall
and then double-click on the AT&TCall icon. The Telephony Server
Identification dialog box appears.

If you are not logged into the Telephony Server, select Telephony
Server Login. . . from the Setup menu. The Telephony Server
Identification dialog box appears.

Modify the appropriate information, and then select the OK button.

The Telephony Server Login dialog box appears.

Modify the appropriate information.

When you are finished, enter your password for the Telephony Server,
and select the OK button.

Opening an Existing AT&TCall File

To open an existing AT&TCall file:

1.

2.

Select Open. . . from the File menu.

The Open dialog box appears, showing a list of the available “.dex”
files in the current directory and disk drive.

Select the AT&TCall file you want from the File Name box, and select
the OK button. You may use the drive and directory controls to switch
drives and/or directories.

The file is loaded, and AT&TCall displays the last state of the card
bank. Whenever you open an existing AT&TCall file, AT&TCall
displays the last card that was displayed before you saved and
exited that file.
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Printing a Card List

AT&TCall enables you to print a list of the cards in an AT&TCall file. You may
specify the labels of the information that you want printed for each card. For
example, if you want the list to contain the last name, first name, and office #
for each card in the file, you must specify these labels in the Print List dialog
box. In this example, one field would contain "Last:," one field would contain
"First:," one field would contain "Office #:," and the three remaining fields
would each contain "(None)." "(None)" signifies that no label was selected and
that no information will be printed in this field. You may select up to six labels
whose information you want printed.

To print a list of the cards in an AT&TCall file:

1.  Select Print List. . . from the File menu.

The Print List dialog box appears.

Figure 8-12.  Print List Dialog Box

2.  In each field, select the label of the information that you want printed
for each card.

3.  When finished, select the OK button.

Printing begins, and a dialog box is displayed, which enables you to
cancel printing.
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Printing an AT&TCall File or Card

AT&TCall enables you to print either all of the cards in an AT&TCall file or only
the card that is currently displayed. When printing a file or card, you may
specify whether you want the notes associated with the card(s) displayed. If
you specify that you want the notes displayed, AT&TCall will print out each
card and its notes on its own page. The top of each page will contain the
label for the card, and the bottom of each page will contain the date, page
number, and file name.

If you specify that you do not want the notes displayed, AT&TCall will print out
four cards on each page. The top of each page will contain the labels for the
first and last cards on the page. The bottom of the page will contain the date,
page number, and file name. Figure 8-13 shows how the cards look with and
without the notes printed.
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Edwards, Mary
Last: Edwards
First: Mary
Title:

Company:
Address: 123 Main St.

City: Anywhere
State: NJ

Zip: 007748
Office #:
Home #:
Other #:

Account #:

jshjsdh djhs jhasdjdsa asjs asjhd as jsd sds With Notes
asd djherie as djsd jsjhd dhsjd sdhd
shjsdhsd sdj d sdh sajhjs sjshdjh sjhd
sdjhsdjh sjs sajsj sdjkhsds sajhdsj djsd
jshjsdh djhs jhasdjdsa asjs asjhd as jsd sds
asd djherie as djsd jsjhd dhsjd sdhd
shjsdhsd sdj d sdh sajhjs sjshdjh sjhd
sdjhsdjh sjs sajsj sdjkhsds sajhdsj djsd
jshjsdh djhs jhasdjdsa asjs asjhd as jsd sds
asd djherie as djsd jsjhd dhsjd sdhd
shjsdhsd sdj d sdh sajhjs sjshdjh sjhd
sdjhsdjh sjs sajsj sdjkhsds sajhdsj djsd
jshjsdh djhs jhasdjdsa asjs asjhd as jsd sds
asd djherie as djsd jsjhd dhsjd sdhd
shjsdhsd sdj d sdh sajhjs sjshdjh sjhd
sdjhsdjh sjs sajsj sdjkhsds sajhdsj djsd
jshjsdh djhs jhsasdjdsa asjs asjhd as jsd sds
asd djherie as djsd jsjhd dhsjd sdhd
shj
sdj
jsh
asd
shj
sdj
jsh
asd
shj
sdj
jsh
asd
shj
sdj

Without Notes

Brown, Tom to Morgan, Jack
Last: Brown Last: Edwards
First: Tom First: Mary
Title: Title:

Company: Company:
Address: Address: 123 Main St.

City: City: Anywhere
State: State: NJ

Zip: Zip: 07748
Office #: Office #:
Home #: Home #:
Other #: Other #:

Account #: Account #:

Last: Kemp Last: Morgon
First: Dave First: Jack
Title: Title:

Company: ABC Travel Company: ABC Travel
Address: 1010 Ocean Ave. Address 42 Rocky Mountain Rd.

City: Sea Bright City:
State: NJ State:

Zip: Zip:
Office #: Office #:
Home #: Home #:
Other #: Other #:

Account #: Account #:

Figure 8-13.  Printing Cards With and Without the Notes
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To print an AT&TCall file or card:

1.  Select Print Cards. . . from the File menu.

The Print Cards dialog box appears.

Figure 8-14.  Print Cards Dialog Box

2.

3.

4.

Perform one of the following steps:

—  If you want to print the card that is displayed currently, select
the option button for Current Card.

—  If you want to print all the cards in the file, select the option
button for All Cards.

Select the Print Notes check box if you want to print the notes
associated with the card(s).

When finished, select the OK button.

Printing begins, and a dialog box is displayed, which enables you to
cancel printing.

8-41



Using AT&TCall

Protecting an AT&TCall File with a Password

AT&TCall enables you to administer a password for each file, preventing
unauthorized people from accessing the file. Passwords may consist of up to
eight printable characters (that is, letters, numbers, and punctuation marks)
and are case sensitive (that is, AT&TCall can differentiate between capital
letters and lowercase letters). After a password is administered for a file,
AT&TCall prompts you to enter a password every time you attempt to access
that file. You may administer passwords for as many AT&TCall files as you
like.

To administer a password for an AT&TCall file:

1.

2.

Select Save AS. . . from the File menu.

The Save As dialog box appears.

Select the Password button.

The Password dialog box appears.

Figure 8-15.  Password Dialog Box

3.  Enter your password, and select the OK button.

The Confirm Password dialog box appears.
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4.

5.

Re-enter your password, and select the OK button.

Select the OK button.

The next time you attempt to open this file, AT&TCall will prompt you
for the password.

Removing the Password from an
AT&TCall File

To remove the password from an AT&TCall file:

1. Open the AT&TCall file whose password you want to remove.

2.

3.

4.

5.

The file is loaded.

Select Save AS. . . from the File menu.

The Save As dialog box appears.

Select the Password button.

The Password dialog box appears.

Delete the password from the Enter Password field, and select the OK
button.

Select the OK button.

The next time you attempt to open this file, AT&TCall will not prompt
you for the password.
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Saving an AT&TCall File

To save any changes to an existing AT&TCall file, select Save from the File
menu. If the file is new, and has not been saved yet, select Save AS. . . from
the File menu.

NOTE:
AT&TCall automatically adds the “.dex” suffix to the file name you enter.
If you prefer, you may enter another suffix. However, it is recommended
that you use the “.dex” default to make it easier to identify and load
AT&TCall files.

Setting the Account Code Options

AT&TCall enables you to automate the process of account code entry if your
company uses account codes regularly. If you activate the account code
option, AT&TCall will use the contents of the last field (that is, the bottom field)
of each card as the default account code for calls made from that card. If no
account code is present, or the field contains information other than a valid
account code, AT&TCall will prompt you to provide one.

NOTE:
The Account Code Entry Feature Access Code must precede the
Account Code.
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To set the Account Code options:

1.  Select Account Code Options. . . from the Setup menu.

The Account Code Options dialog box appears.

If your company uses account codes regularly, you can configure AT&TCall
to automate the process of account code entry.

If you choose to Prompt for Account Codes before dialing. AT&TCalI will
use the contents of the last (i.e., bottom) field of each card as the default
account code for calls made from that card. If no account code is present,
you will be prompted to provide one.

Note that the Account Code Entry Feature Access Code must precede the
Account Code.

Ignore account codes.

Prompt for account codes before dialing.

Figure 8-16.  Account Code Options Dialog Box

2.

3.

Select the appropriate option button.

Select the OK button.
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Setting the AT&TCall Window To Always Be
on Top of Other Windows

AT&TCall enables you to specify that you want the AT&TCall window to be
located on top (that is, in front) of all the other open windows, including the
active window. This option is especially useful when you are using AT&TCall in
the Card Hidden mode and want to keep a set of programmed Quick Dials
readily accessible.

To specify that the AT&TCall window is always on top of other windows, select
Always on Top from the Setup menu. A check mark appears next to the
Always on Top option, indicating that the option is activated. The AT&TCall
window will now remain in front of all the other windows you open, even if it is
not the active window.

Setting the Dial Options

AT&TCall enables you to specify a prefix and/or suffix that AT&TCall will add
to all telephone numbers dialed via Dial buttons in the associated AT&TCall
file. For example, if you must enter a “9” before dialing a telephone number
outside of your telephone system (that is, an outside call), you can specify the
prefix “9” in the Dial Option dialog box. However, if you specify a Dial Option,
the system will use that option for each and every call you initiate from any
Dial button in that AT&TCall file. Therefore, if you use Dial Options, make sure
all of the telephone numbers in all of the cards in that AT&TCall file require the
same Dial Option.

NOTE:
If you are using AT&TCall with FastCall and you want to specify a dial
prefix and/or suffix, make sure you specify this information in FastCall.
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To set Dial Options:

1.  Select Dial Options. . . from the Setup menu.

The Dial Options dialog box appears.

Use the controls below to configure AT&TCall
to apply dialing prefixes and/or suffixes to all
telephone numbers on all cards in this file:

Prefix:

Suffix:

Figure 8-17.  Dial Options Dialog Box

2.  Select the Prefix check box and/or the Suffix check box, depending
on your requirements.

The box next to the option you selected is checked.

3.  In the field next to the option you selected, type the prefix or suffix.

4.  Select the OK button.

The Dial Options dialog box closes.
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Specifying an AT&TCall File To Be Loaded
Automatically

AT&TCaIl enables you to specify a file that will be loaded automatically every
time you access AT&TCall. To specify a file to be loaded automatically:

1.

2.

3.

4.

5.

6.

7.

Exit AT&TCall.

Locate the AT&T PassageWay group window in Program Manager.

Select the AT&TCall icon with a single click.

The AT&TCall icon is highlighted.

Select Properties. . . from the File menu of Program Manager.

The Program Item Properties dialog box appears.

Place the cursor in the Command Line box.

Move the cursor to the end of the Command Line box, after
ATTCALL.EXE.

Press the spacebar on your keyboard, and then enter the name and
extension of the AT&TCall file that you want to be loaded
automatically. If the file does not reside in the same directory as
AT&TCall, you must specify the path in front of the file name.

NOTE:
You must include .dex at the end of the file name. Otherwise,
AT&TCall will be unable to load this file automatically.

Figure 8-18 shows how the Program Item Properties dialog box would
look if you set the “sample.dex” file to be loaded automatically.
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Figure 8-18.  Sample File to be Loaded Automatically

8.  Select the OK button.

The Program Item Properties dialog box closes. The next time you
access AT&TCall, the file you specified will be automatically loaded.

Verifying the Connection with the Telephony
Server

NOTE:
You should perform this procedure only if you are using AT&TCall as a
standalone application ( that is, you are not running AT&TCall with
FastCall).

To determine whether you are logged into the Telephony Server, select
Telephony Server Login. . . from the Setup menu. The Telephony Server
Identification dialog box appears. The top of the dialog box displays the
status of your session.
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Server Identification dialog box are disabled. Figure 8-19 shows a Telephony
Server Identification dialog box for an active session.

If you are logged into the Telephony Server, the message session Active
in displayed. When the session is active, all of the fields in the Telephony

Figure 8-19.  Sample Telephony Server Identification Dialog Box

Select the Cancel button to close the Telephony Server Identification dialog
box.

If you are not logged into the Telephony Server, the message Session
Inactive is displayed.
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If you want to log into the Telephony Server, perform the following steps:

1.  Select the OK button.

The Telephony Server Login dialog box appears.

2.  Enter your password in the Password box

3.  Select the OK button.

If you do not want to log into the Telephony Server, select the Cancel button.

8-51



Using AT&TCall

Card Tasks

This section describes the tasks that you will perform when working on cards
in an AT&TCall file. These tasks are presented in alphabetical order.

Accessing the Notes Field

AT&TCall enables you to maintain notes for each card. The Notes icon
appears to the left of the Notes button when the card has information in the
Notes field. The Notes field can contain up to 32K. To access the Notes field
for a card:

1.

2.

3.

4.

Select the card of which you want to access the Notes field..

The selected card appears.

Select the Show Notes button.

The Notes field appears.

Enter information in the Notes field or modify the existing information
(if any) in the field.

When you are finished, select the Hide Notes button.

The card is displayed.
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Changing the Field Labels in the Cards

AT&TCall enables you to change the field labels for the cards in the bank.
This only applies to the bank you are in. To change the field labels:

1.

2.

3.

Select Edit Labels. . . from the Setup menu

The Edit Labels dialog box appears.

Make your changes.

When you are finished, select the OK button.

The Edit Labels dialog box closes, and your changed are displayed
on the card.

Creating a New Card

To create a new card:

1.  Select the New Card button.

The New Card window appears, and the cursor is located in the first
field.

2.  Enter the appropriate information in each field that you use.

3.  When you are finished entering information in this card, select the
Add Card button.

The New Card window closes, the labels for the new card appear in
the List field, and the information for the new card is displayed.
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Deleting a Card

To delete a card:

NOTE:
When you delete an existing card, all Quick Dials associated with
that card are deleted.

1.

2.

Select the card you want to delete.

The selected card is displayed.

Select Delete Card from the Edit menu.

The Delete Card dialog box appears.

Delete this card?

NOTE: all Quick Dial buttons associated with the
card will be erased!

Figure 8-20.  Delete Card Dialog Box

3.  Select the OK button.

The card is deleted from the bank, and the next card in the bank is
displayed.
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Dialing a Phone Number from a Card

NOTE:
You should perform this procedure only if you logged in from AT&TCall.

To dial a phone number from a card:

1.  Select the card that contains the phone number that you want to dial.

The selected card is displayed.

2.  Click on the Dial button located to the right of the phone number that
you want to dial.

If you do not have a speakerphone, pick up the handset. AT&TCall
places the call. You have five seconds to go off hook (that is, pick up
the handset) after clicking on the Dial button. If you pick up the
handset after the five-second interval expires, the call is denied. You
can also place a call by lifting the handset before clicking on the Dial
button.

If you have a speakerphone, you speakerphone activates, and
AT&TCall places the call.

After the call is completed, select the Hang Up button, or hang up
your handset to place your telephone on hook.
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Editing an Existing Card

To edit

1.

2.

3.

4.

an existing card:

Select the card you want to edit.

The card is displayed.

Select the Edit Card button.

The Edit Card window appears containing the current information for
the card.

Make your changes to the card.

When you are finished, select the Return Card button.

The Edit Card window closes, and the update card is displayed.

Hiding/Showing the Card Display

AT&TCall enables you to hide the card display and view only the Quick Dials,
the Hang Up button, the Dialpad button, the Timer button, and the Quick Shift
button (if the 25/50 Quick Dial Buttons option is selected). To hide the card
display, select Hide Card from the View menu.

To show the card display after hiding it via the Hide Card option in the View
menu, select Show Card from the View menu.
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Using the Timer

AT&TCall provides a stopwatch that enables you to time anything that you
want. You can use the Timer to time the length of a call, but you need to
manually start and stop the Timer. The Timer is not tied to the call.

To use the Timer:

1.  When you want to start the timer, select the Timer button.

The Timer window appears and immediately starts keeping time. The
Timer measures time in hours, minutes, and seconds. To rest the
timer, select the Reset button. To stop the timer, select the Stop
button. To restart the timer after it has been stopped, select the Start
button.

2.  When you are finished using the timer, select Close from the Control-
menu box of the Timer window.
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Quick Dial Tasks

This section describes the tasks you will perform when using Quick Dials in an
AT&TCaIl file. These tasks are presented in alphabetical order.

NOTE:
You should perform these tasks only if you logged in from AT&TCall.

Accessing Information for a Quick Dial

To view the information for a Quick Dial:

1.

2.

Press and hold down SHIFT, and then click on the Dial button of the
Quick Dial in which you are interested.

The Quick Dial Information dialog box appears. This dialog box
present the label and phone number for this Quick Dial.

When you are finished, select the OK button.

If you want to display the card associated with the Quick Dial, click on the
Label button of the Quick Dial in which you are interested. The associated
card is displayed.

Assigning a Phone Number to a Quick Dial

To assign a phone number to a Quick Dial:

1.  Select the card that contains the telephone number that you want to
program to a Quick Dial.

The selected card is displayed.

2.  Press and hold down SHIFT, and then click on the Label button of the
Quick Dial that you want to program.

The Create Quick Dial dialog box appears. AT&TCall provides a
default label.
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3.

4.

5.

Enter the label that you want to appear on the Label button of the
Quick Dial.

Select the option button of the telephone number that you want this
Quick Dial to dial.

Select the OK button.

The label you entered appears on the Label button of the Quick Dial
you selected.

Changing the Number of Quick Dials
Displayed

AT&TCall allows you to program a maximum of 50 Quick Dials (two sets of 25,
which are accessed via either the Quick Shift button or the Quick Shift option
in the View menu). However, if you need no more than 20 Quick Dials, you
can set AT&TCall to display a maximum of 20 Quick Dials (two sets of 10,
which are accessed via the Quick Shift option in the View menu).

To specify the number of Quick Dials you want to access, select either 10/20
Quick Dial Buttons or 25/50 Quick Dial Buttons from the Setup
menu.

Changing the Setup of the Quick Dial Labels

AT&TCall enables you to display the information on the Label buttons of Quick
Dials as left-justified or centered. This setting applies to all AT&TCall files. To
change the setup of the information on the Label buttons of Quick Dials:

1.   Select Quick Dial Labels. . . from the Setup menu.

The Quick Dial Label Setup dialog box appears.

2.   Select the option button for the setup you want.

3.   Select the OK button.
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Dialing a Phone Number from a Quick Dial

NOTE:
You should perform this task only if you logged in from AT&TCall.

To dial a phone number from a Quick Dial, click on the Dial button of the
Quick Dial in which you are interested.

If you do not have a speakerphone, pick up the handset. AT&TCall places the
call. You have five seconds to go off hook (that is, pick up the handset) after
clicking on the Dial button. If you pick up the handset after the five second
interval expires, the call is denied. You can also place a call by lifting the
handset before clicking on the Dial button.

If you have a speakerphone, your speakerphone activates, and AT&TCall
places the call.

After the call is completed, select the Hang Up button or hang up your
handset to place your phone on hook.

Erasing a Quick Dial

To erase the label and telephone number assigned to a Quick Dial:

1.

2.

Press and hold down SHIFT, and then click on the Label button of the
Quick Dial that you want to erase.

The Change Quick Dial dialog box appears.

Select the Erase button.

The information for that Quick Dial is erased, and the Label button for
the Quick Dial is blank.
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Re-Assigning an Existing Quick Dial

To assign a phone number to a Quick Dial that has been assigned previously:

1. Select the card that contains the telephone number that you want to
program to the Quick Dial.

The card is displayed.

2.

3.

4.

5.

6.

Press and hold down SHIFT, and then click on the Label button of the
Quick Dial that you want to change.

The Change Quick Dial dialog box appears.

Select the Create New button.

The Create Quick Dial dialog box appears.

Enter the label that you want to appear on the Label button of the
Quick Dial.

Select the option button of the telephone number that you want this
Quick Dial to dial.

Select the OK button.

The label you entered appears on the Label button of the Quick Dial
you selected.
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AT&TCall Menu Bar Options

This section describes the options contained in each AT&TCall menu.

File

This section describes the File menu options.

New
Creates a new, empty AT&TCall file. When selected, this option presents a
default screen with no entries. The window title displays "AT&TCall-
(UNTITLED.DEX).”

Open
Enables you to open an existing AT&TCall file. When selected, this option lists
the existing AT&TCall files. You may scroll through the list and select a
specific file.

Save
Saves the changes made to the AT&TCall file on which you are working.

Save As...
Prompts you to name the file on which you are working. The default extension
for every AT&TCall filename is “.dex.”

Import...
Enables you to import files that are in the comma separated values format
(.cvs).
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Export
Enables you to export the current card or all cards in an AT&TCall file to a file
that is in the comma separated values format (.csv).

Print Setup...
Displays the Windows printer setup window, allowing you to modify the printer
settings (for example, paper size and print orientation).

Print Card...
Enables you to print either all cards in an AT&TCall file or the card displayed
currently. When printing the card(s), you may specify whether you want the
notes associated with the card(s) printed also.

Print List...
Enables you to print specific label fields for each card in an entire AT&TCall
file. You may select a maximum of six labels.

Exit
Exits the AT&TCall application.

Edit

This section describes the Edit menu options.

NOTE:
You can use the Undo, Cut, Copy, and Paste option when you are
performing one of the following tasks:

—  editing an existing card

—  adding a new card

—  working in the Notes field of a card
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Undo
“Undoes” the last editing action you performed in a field. For example, if you
change the information in a field and then select “Undo,” the field displays its
previous information (that is, the information that was changed).

Cut
Deletes information selected from a field and places it in the Windows
Clipboard while you are editing a card.

Copy
Copies information selected from a field and places it in the Windows
Clipboard while you are editing a card.

Paste
Pastes infromation from the Windows Clipboard into the current field while you
are editing a card.

Insert Timestamp
Places the day, date, and time in the Notes field for the card displayed. This
information appears in front of the cursor and can be placed anywhere in the
Notes field.

Clear Notes
Erases the contents of the Notes field for the card displayed.

Edit Card
Enables you to edit the card displayed on the screen.

New Card
Enables you to add a new card to the AT&TCall file.
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Delete Card
Enables you to delete the card displayed on the screen.

Find...
Enables you to search for specific characters in each specified field or all
fields on each card in the AT&TCall file.

Find Next
Enables you to find the next card that matches the criteria you specified for
the Find option.

View

This section describes the View menu options.

Hide Card
Displays only the Quick Dials, the Hang Up button, the Dialpad button, the
Timer button, and the Quick Shift button (if the 25/50 Quick Dial Button option
is selected).

Show Card
Displays the entire card along with Quick Dials.

Hide Notes
Closes the Notes field associated with the selected card.

Show Notes
Displays the Notes field associated with the selected card.
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Quick Shift
Enables you to toggle between the first and second set of Quick Dials.

Next Card
Displays the next card in the AT&TCall file (as sorted).

Prev Card
Displays the previous card in the AT&TCall file (as sorted).

Next Letter
Enables you to "jump" to the next letter that contains a card in the AT&TCall
f i le.

Prev Letter
Enables you to "jump" to the previous letter that contains a card in the
AT&TCall file.

Sort...
Enables you to specify the primary and secondary labels by which the cards
in your AT&TCall file are sorted.

Setup

This section describes the Setup menu options.

Edit Labels...
Enables you to modify any of the labels in the card template for your AT&TCalI
file. When selected, this option displays a sample card with the current labels.
You may modify any of these labels.
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Dial Options...
Enables you to enter a prefix and/or suffix that you want dialed with every
number. For example, if your telephone system requires that first you dial a "9"
before making a call using an outside line, you can specify "9" in the "Dial
Option..." prefix. By specifying your prefix, you do not need to include a "9" in
front of every phone number on every card.

Account Code Options...
Enables you to administer one of the following account code options:

■    Ignore account codes, which ignores the account code.

■   Prompt for account codes before dialing, which prompts you to enter
an account code before dialing the number if the card does not contain
an account code. Entering an account code is optional. If you do not
want to enter an account code, select the Cancel button in the Account
Code Options dialog box.

Telephony Server Login...
Enables you to

■    determine whether you are logged into the Telephony Server

■     change the Iogin parameters

■   log into the Telephony Server

Quick Dial Labels...
Enables you to display the Label button infromation for the Quick Dials as left-
justified or centered.

10/20 Quick Dial Buttons
Provides 20 Quick Dials for you to program and use. AT&TCall only displays
10 Quick Dials at a time. To access the second set of 10 Quick Dials, select
the Quick Shift option from the View menu.
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25/50 Quick Dial Buttons
Provides 50 Quick Dials for you to program and use. When you select this
option, AT&TCall only displays 25 Quick Dials at a time. To access the second
set of 25 Quick Dials, either select the Quick Shift button in the lower-right
corner of the AT&TCall window or select the Quick Shift option from the View
menu.

Always on Top
Keeps the AT&TCall window on top of all other open windows, including the
active window. This prevents the AT&TCall window from being obscured by
other windows.

Accessories

This section describes the Accessories menu options.

■    Call Log

■    Timer

Call Log
Enables you to access the Call Log, which contains information on all of the
calls you made from an AT&TCall file.

Timer
Displays the Timer window, which contains a timer that immediately starts
running.
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Help

This section describes the Help menu options.

Contents
Displays the topics in on-line Help.

Search for Help on...
Opens the Search dialog box for on-line Help. You can look up Help
information by entering keywords in the dialog box.

How to Use Help
Describes how to use on-line Help.

About AT&TCall...
Displays the AT&TCall version number, the Microsoft Windows version
number, the mode in which Microsoft Windows is operating, the amount of
free memory (KB) available on your system, and the size of the largest
contiguous block of memory (KB) available.
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Troubleshooting

A
Overview

This chapter provides information that can assist you in solving problems that
you might encounter with FastCall.

FastCall Problems

Problem 1: Configuration changes are not taking effect

You must restart the FastCall Controller program in order for certain changes
to take effect. These include:

■    Telephone Parameters

■    User Modes

■    Outgoing Call Rules
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To restart the FastCall Controller program, first exit from it by using ALT + TAB
to select the FastCall Master Control Program task, then press ALT + F, X or
select File, Exit. Or click on the FastCall Master Control Program icon
once and select Close from the pop up menu. Then reactivate the FastCall -
Call Control Keys by double-clicking on the FastCall Controller icon in the
FastCall program group. If you prefer, you may omit exiting from the FastCall
Controller program before reactivating it. In this case, the following dialog
box will be displayed.

Cannot run more than one copy of this program
at one time.

Do you want to restart the FastCall Controller now?

Figure A-1.  FastCall - Master Control Program Dialog Box

Click on the Yes button to restart the FastCall Controller.

Problem 2: When you attempt to change the password, the error
message box displays Password not confirmed. Password change
canceled.

1. The following message appears when changing the password if you
enter the new password incorrectly in the Password Confirmation
screen. Try to change the password again, being sure to enter the
same password in both screens.
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Password not confirmed. Password change cancelled.

Figure A-2.  FastCall Error Message Box

2.  Also remember that the FastCall password is case sensitive. Check
whether the CAPS LOCK key is on.

Problem 3: No screen pops.

1.

2.

3.

4.

5.

6.

Check the parameters of your Incoming Call Rules.

Check the Alerts to make sure that a trigger is selected and
highlighted.

Verify the trigger operation using the Playback button.

Check to be sure that you’re using the correct input for the macro.

Verify that the application is running, and check that the computer
system clock is set correctly.

If you are experiencing problems in popping up the correct screen for
an incoming call, and your keystroke macro appears to be working
properly, you may not have your database entries correctly formatted.
If your keystroke macro includes either the called number or calling
number, the format of the telephone number may be adjusted by
using the Format Option in the Incoming Call Triggers screen. See
Chapter 5 for information about the Telephone Number formatting
option.
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Problem 4: Call triggers are not operating.

1.

2.

3.

4.

5.

Insure that trigger entry is highlighted in Select Trigger Window in Call
Alert Option of Incoming Call Rules.

Check that Incoming Call Rules are enabled.

Verify that the application is running.

Verify that the selected window is available.

If the application screen is popping, but keystrokes are not being
entered or appear to be playing too fast for the application to keep
up, your windows application may not have the ability to buffer
keystrokes. if this is the case, the fastcall.ini file in the FastCall
directory may be modified to delay the keystroke string. Change the
setting of the Key Delay from zero to a value which will delay each
keystroke by that number of milliseconds. For example, changing the
Key Delay to 10 will delay the keystrokes by 10 milliseconds.

Problem 5: FastCall is not answering calls.

1.   Make sure FastCall Controller is running.

2.   Make sure phone line(s) are connected.

3.   Make sure phone is properly configured in AT&T Switch Admin.

Problem 6: You cannot dial with F4 - Dial Main or F5 - Dial Other.

1.

2.

3.
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Make sure that the number conforms to the dialing format selected
under User Modes, either NADP or International Mode.

Make sure that there are macros recorded for each trigger and that
both Dial Main and Dial Other macros are recorded if you wish to use
both F4 and F5 for the same applications.

Make sure that there is only one trigger for each application/window
combination. If multiple triggers are assigned, FastCall uses the
trigger with the lowest index number available to execute when the F4
or F5 keys are pressed.
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4.

5.

6.

7.

Make sure you do not have multiple copies of the same Windows
application running.

Remember that the colon (:) is a dialable character. FastCall strips
out non-dialable, unsupported characters, but if there is a colon typed
on the card before the number to be dialed, it will not be stripped out.
Reformat your entries to eliminate colons and other undesired dialable
characters before the number. See the section on “Supported
Characters for Special Dialing Codes” in Chapter 4.

If you attempt to use the F4 - Dial Main or F5 - Dial Other keys to
invoke outgoing call triggers and their associated keystroke macros,
and FastCall fails to dial, make sure that the last active window before
the F4 or F5 key was pressed was the window for which the desired
trigger is defined.

Applications in Windows that are set to “always on top” (that is, clock,
some application toolbars) will prevent Outgoing Macros from
running. Disable this option if you wish to use outgoing call macros.

Problem 7: FastCall Controller is not starting.

1.

2.

3.

4.

5.

The telephone set is not configured in Telephony Service Admin.

The telephone set is not configured in FastCall Admin.

The User Login to the server is invalid.

The user does not have proper file permissions.

CSTA.DLL is not loaded in windows or the system path statement.
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Problem 8: Transfers, Conferences or Redirects are not operating.

1. Make sure FastCall is set for the proper number of call appearances.

2. Call appearances must be administered contiguously. In other words,
if two appearances are set they must be on line appearances 1 and
2. Three appearances would be lines 1, 2, and 3. Setting two
appearances on line appearance 1 and 4 would cause transfers,
conference, and redirect to not operate.
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AT&TCall Problems

Problem 1: You are unable to log into the Telephony Server via AT&TCall

NOTE:
This problem may occur only if you are running AT&TCall as a
standalone application (that is, without running FastCall).

This problem may be caused by the following circumstances:

■

■

Information in the Telephony Server Identification dialog box is
incorrect.

Check the information in this dialog box. .

You do not have permission to manipulate your telephone from your
PC.

Contact your network administrator to determine if you have permission
to manipulate your telephone from your PC.

Problem 2: You are unable to access AT&TCall

You may not have all of the DLLs required to run AT&TCall. Contact your
network administrator.
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Problem 3: When you attempt to log into the Telephony Server, the
Server Name box displays server instead of the server name you
specified previously

NOTE:
This problem may occur only if you are running AT&TCall as a
standalone application (that is, without running FastCall).

The Telephony Server may be “down.” Whenever the Telephony Server is
down, its name does not appear in the Server Name box. Select the Cancel
button to close the Telephony Server Login dialog box, and then try to log in
when the Telephony Server is “up.” When the Telephony Server is up, its name
appears in the Server Name box.

Problem 4: When you try to make a call, AT&TCall displays a message
that you are already active on a call, even though you are not active on a
call.

NOTE:
This problem may occur only if you are running AT&TCall as a
standalone application (that is, without running FastCall).

Access the Telephony Server Identification dialog box (via the Telephony
Server Login option in the Setup menu) to verify the following information:
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■ The server you are logged into is the Telephony Server on which your
phone is administered.

■ The phone extension specified is the telephone from which you are
trying to make the call.



Keyboard Shortcuts

B
Overview

documentation.

This appendix provides some keystroke combinations for performing common
Windows tasks. For more information, refer to your MS-Windows
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Keyboard Shortcuts

Table B-1.  Keyboard Shortcuts

Press:
ALT + TAB

ALT + SPACEBAR, X

ALT + SPACEBAR, N

ALT + letter

ESC
ARROW keys
SPACEBAR

TAB

To:
Switch between currently active applications. You
must keep the ALT key pressed while pressing and
releasing the TAB key. Each time you press the TAB
key, a task window is displayed in the center of your
screen with the name of an active application. When
the application that you want to switch to is shown in
the task window, release the ALT key.
Maximize the current window. Press the ALT key and
then the Spacebar, release them, and then press the
letter X key. The currently active window will be
maximized.
Minimize the current window. Press the ALT key and
then the Spacebar, release them, and then press the
letter N key. The currently active window will be
minimized to an icon.
An underlined character in a screen or menu
indicates the letter to press with the ALT key to
access that function. Sometimes you have to press
another letter also to select a command, as in
submenus.
To exit from a dialog box or pull-down menu.
To move up and down in list boxes.
Press the Spacebar to select/deselect an option
button or check box, or to highlight items in a list.
To move the cursor around in a dialog box.
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Glossary

A
ACD

Automatic Call Distribution. This is a telephone system feature that routes calls to
agents automatically.

active call
A call in which you can speak to someone else (that is, the call is not ringing at your
phone or on hold).

agent
The person using a FastCall system in an ACD or Call Center environment.

ANI
Automatic Number Identification. This is another name for call ID (CLID). ANI is
typically a 10-digit number that is delivered by the network to identify the incoming
caller.

AT&TCall
A card file application that enables you to maintain names, addresses, telephone
numbers, and other information you desire, Each AT&TCall file created is a calling
directory from which you can place calls.

B
bank

The collection of cards in an AT&TCall file.
blind transfer

A transfer during which the person transferring the call completes the transfer without
talking to the person receiving the call.
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C
call appearance

An icon that represents each call that is active, ringing, or on hold at your telephone,
Call appearances are displayed in the call appearance area of the FastCall Controller
window.

call log
A file that stores an entry of every call you make using FastCall or AT&TCalI (including
calls you make from the Dialpad window). This is the file PWLOG.LOG in your
Windows directory.

call log archive file
A file in which you may store call log entries that were removed from the call log. This
is an ASCII file in which each field of data is separated by a tab. This is the file
PWLOG.ARC in your Windows directory.

Call Prompting
A telephone system feature that enables a person calling to provide information (for
example, social security number, account number, area code) via a touch-tone
(DTMF) phone. This is also referred to as caller input.

call rule
A set of conditions that filters calls to enable FastCall to handle calls in the ways that
you want them to be handled.

called number
The telephone number called by someone. You may have many numbers through
which incoming calls may be received. The called number is the specific number
dialed by the caller. A called number can also be an extension.

caller
Person placing a call.

caller ID
The information associated with each call you make or receive.

Caller ID Label
The description of a telephone number as displayed in the Calling or Called Number
fields. The description is entered when configuring the Calling or Called Number Lists
in FastCall Administration.
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caller input
Information entered by a calling party via a touch-tone (DTMF) phone. This
information may be an account number, such as when you call a credit card
company and are prompted to enter your account number. See also Call Prompting.

calling number
The number from which someone is calling.

card
A data record in an AT&TCall file. This record contains 13 data fields.

CLID
Caller Identification. This is another name for ANI.

comma separated values format
A text file that contains lines of data. Each field of data on a line is separated from the
next field by a comma (,).

Conference Room window
The window in FastCall that identifies each participant involved in the conference call.
Each participant is represented in the Conference Room window by a panel. The
Conference Room window is opened when you have an active call and select the
Conference button on the Call bar. From this window, you can place the conference
on hold, return to a conference that is on hold, drop participants from the conference,
and end the conference.

consultative transfer
A transfer during which the person transferring the call speaks to the person who will
receive the call before completing the transfer.

CTI
Computer Telephone Integration. The combining of computer and telephone
technologies that allows each technology to use the other and in many cases, such
as with FastCall, augments the capabilities of each technology.
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D
DCP

Digital Communications Protocol. Used for signaling between an AT&T digital
telephone (7400 Series) and the AT&T DEFINITY G1/G2/G3 system or System 75/85.

Dialpad window
A window in AT&TCall that lets you dial telephone numbers.

DID
Direct Inward Dialing. This is a telephone system feature that enables specific
numbers to be reached from a common exchange.

DNIS
Dialed Number Identification Service. This is a telephone system feature that identifies
a number that is dialed.

DTMF
Dual Tone Multiple Frequency. This is a term for touch-tone telephones.

Dynamic Data Exchange (DDE)
A method of exchanging data between Windows applications.

Dynamic Link Library (DLL)
A Windows program that is used by other programs, A DLL provides services for
another program.

E
exchange

A three-digit prefix specific to a calling area.
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F
FastCall Professional

The full-featured version of FastCall.
FastCall Promotional

A version of FastCall that has a subset of the functionality of FastCall Runtime.
Promotional does not support the Caller Input feature and does not allow the creation
and recording of incoming or outgoing triggers.

FastCall Runtime
A version of FastCall that has a subset of the functionality of FastCall Professional.
Runtime does not support the Caller Input feature, but does allow the creation
incoming or outgoing triggers of Library macros.

H
handset

The handheld part of the telephone that you pick up, talk into, and listen from. Also
known as the receiver.

I
inside call

A call in which both parties are using the company’s internal telephone network (that
is, neither party is using the public telephone network).
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K
keystroke macro

A recorded sequence of instructions to execute any number of function and actions
to automate the performance of multiple tasks.

knowledge worker
A person using FastCall system in a non-call center environment.

L
line

An instance or point of access to an extension number used for placing and receiving
phone calls. Also known as line appearance or call appearance.

local area network (LAN)
A data communications network consisting of a group of interconnected computers
sharing applications, data, and peripheral devices (for example, printers).

Log Viewer
An application that lets you view call entries in the call log.

N
NADP

North American Dialing Plan. The telephone numbering conventions used on the
North American continent.

NetWare Telephony Services
Software that provides telephone-related services to members of a local area network
(LAN).

network administrator
The person responsible for managing the operation of your local area network (LAN).
The actual title of this person in your company may be different.

GL-6



Glossary

O
off hook

When the handset is removed from the cradle (for example, when you lift the handset
to place or answer a call) or the speakerphone is not activated.

on hook
When the handset is left in the cradle or the speakerphone is not activated.

outside call
A call in which one of the parties is using the public telephone network.

P
panel

An icon in the Conference Room window that represents a participant of the
conference call. Each panel may display a person’s name and telephone number.

PBX
Private Branch Exchange. The equipment that controls a company’s private telephone
network and connects the private telephone network to the public telephone network,
Also referred to as a switch.

Q
Quick Dial

A button in the AT&TCall application that you program to dial a telephone number
automatically. Each Quick Dial has a Dial button and a Label button. Clicking on the
Dial button dials the telephone number that you programmed. The Label button
displays the information you want associated with the telephone number you
programmed. Each AT&TCall file can have up to 50 Quick Dials.
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S
speakerphone

A device that lets you listen to a telephone caller on a loudspeaker and talk to the
caller using a voice-activated microphone. It is unnecessary to hold the telephone
handset or to wear a headset.

T
telephony

The application of voice transmission technology.
Telephony Server

A computer on a local area network (LAN) that has the specific purpose of providing
services related to telephones.

trigger
Information and instructions that execute actions defined by configuring application
paths and recording keystroke macros. When a call meets the criteria of a call rule, a
trigger is executed, making applications and data pop up on the screen.
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A
account code options

setting in an AT&TCall file, 8-44
Advanced Dialing options

external, 6-19
internal, 6-21

alerts, 6-9
ALL exchanges, 6-18
always on top

setting, 8-46
answering calls, 3-8

problems, A-4
application paths

assigning, 5-6
application triggers, 4-42

configuring, 5-8
AT&TCall

accessing information for a
Quick Dial, 8-58

accessing the notes field, 8-52
assigning a phone number to a

Quick Dial, 8-58
card tasks, 8-52
changing the field labels in cards, 8-53
changing the number of Quick Dials

displayed, 8-59
changing the setup of the Quick Dial

labels, 8-59
creating a new card, 8-53
creating a new file, 8-31
creating a template file, 8-30
deleting a card, 8-54
description, 8-3

dialing a phone number, 8-31
dialing a phone number from a

Quick Dial, 8-60
editing an existing card, 8-56
erasing a Quick Dial, 8-60
exiting the application, 8-32
exporting information, 8-32
file tasks, 8-29
helpful hints, 8-25
hiding the card display, 8-56
importing files into AT&TCall, 8-34
making a call from a Quick Dial, 8-60
making calls, 8-55
modifying Iogin information, 8-36
opening files, 8-37
printing a card, 8-39
printing a card list, 8-38
printing a file, 8-39
programming a phone number to a

Quick Dial, 8-58
re-assigning an existing

Quick Dial, 8-61
removing a password, 8-43
running, 8-26
saving a file, 8-44
setting a file to be loaded

automatically, 8-48
setting a password for a file, 8-42
setting the account code options, 8-44
setting the dial options, 8-46
setting window to always be

on top, 8-46
showing the card display, 8-56
sorting cards in the bank, 8-29
troubleshooting, A-7, A-8
tutorial, 8-10
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using the timer, 8-57
verifying connection, 8-49

Auto Login, 4-36
Auto Trigger Before Answer, 4-42
Auto Trigger On Answer, 4-42

B
Button bar

description, 3-8

C
Call button, 3-18
Call Control Keys window

configuring, 4-6
description, 3-3
exiting, 3-46
problems, A-5

Call Forward Destinations List, 6-7
adding items, 4-25
configuring, 4-24
deleting items, 4-27
example, 4-26

Call Information Panel
description, 3-5

call log
deleting entries from, 7-5
description, 7-2
printing entries from, 7-6

call rule configurations
saving, 6-24

call rules, 1-4, 6-1
action, 6-6
alerts, 6-9
configuring, 2-8, 6-3
configuring for outgoing calls, 6-16

criteria, 6-5
enabling/disabling, 6-4
example, 6-11, 6-12, 6-13, 6-14, 6-15
priority, 6-4
rule description, 6-4

call triggers
configuring, 5-8, 5-30
example, 5-19
overview, 5-2
problems, A-4
recording DDE, 5-44
recording macros, 5-13, 5-33
saving configurations, 5-48

Called Number List
adding numbers, 4-16
configuring, 4-15
deleting numbers, 4-18
example, 4-17

caller input, 2-4, 4-35
Call Prompter, 4-19

Caller Input List
adding items, 4-20
configuring, 4-19
deleting items, 4-23
example, 4-22

Calling number, 1-4
Calling Number List

adding numbers, 4-11
configuring, 4-10
deleting numbers, 4-14
example, 4-13

calls
answering, 3-8
conferencing, 3-22, 3-39, 3-40
hanging up, 3-22
hold, 3-36
making from AT&TCall cards, 8-55
making from AT&TCall dialpad, 8-31
making from FastCall, 3-17, 3-18
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making from Quick Dials, 8-60
problems, A-4
problems answering, A-4
problems with AT&TCall, A-8
redirecting, 3-10
transferring, 3-30

cards
accessing notes field, 8-52
changing field labels, 8-53
creating, 8-53
deleting, 8-54
editing, 8-56
hiding display, 8-56
making calls, 8-55
printing, 8-39
printing list, 8-38
showing display, 8-56
sorting, 8-29

conference calls, 3-22, 3-39
adding a participant, 3-42
dropping a participant, 3-43
ending a conference call, 3-45
putting a conference call on hold, 3-45
returning to a call on hold, 3-45
setting up, 3-40

Conference Room, 3-39
configuration

modifying FastCall settings, 2-15
configuring directory application, 2-13
configuring FastCall, 2-2
configuring outgoing call rules, 2-8
configuring outgoing call triggers, 5-30
configuring telephone parameters, 2-4
Continuous Call Window, 4-41

D
DDE

recording for an incoming call trigger,
5-44

DDE client
configuring, 5-46

Dial Main
problems, A-4

Dial Main button, 3-17
dial options setting in AT&TCall, 8-46
Dial Other

problems, A-4
Dial Other button, 3-17
Dialing Codes

adding items, 4-29
configuring, 4-29
deleting items, 4-32
example, 4-31
supported characters, 4-28

dialing from AT&TCall, 8-31, 8-55
dialing from Quick Dials, 8-60
digit dialing, 3-38
Directory, 3-18
directory application

configuring, 2-13, 4-39
Display Information Panel, 3-37
Do Not Disturb, 4-41
documentation conventions, 1-12
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E
Errors

call triggers not operating, A-4
FastCall not answering, A-4

exchanges, 6-18
exiting FastCall, 3-46
exporting

AT&TCall information, 8-32
exporting triggers, 4-44
external Advanced Dialing options, 6-19

F
FastCall

adding a participant to a
conference call, 3-42

administration, 4-1, 4-3
answering calls, 3-8
Button bar, 3-8
Call Control Keys window, 3-3
Call Information Panel, 3-5
changing password, 4-8
Conference Room, 3-39
conferencing calls, 3-22, 3-39
configuring application paths, 5-6
configuring application triggers, 5-8
configuring Auto Login, 4-36
configuring Call Control Keys

window, 4-6
configuring Call Forward Destinations

List, 4-24
configuring Called Number List, 4-15
configuring Caller Input List, 4-19
configuring Calling Number List, 4-10
configuring DDE client, 5-46

configuring directory
application, 2-13, 4-39

configuring incoming call rules, 6-3
configuring outgoing call

rules, 2-8, 6-16
configuring outgoing call triggers, 5-30
configuring Special Dialing Codes

List, 4-28
configuring telephone

parameters, 2-4, 4-33
digit dialing, 3-38
Display Information Panel, 3-37
dropping a participant from a

conference, 3-43
ending a conference call, 3-45
exiting, 3-46
exporting triggers, 4-44
features, 1-2
hanging up calls, 3-22
importing triggers, 4-46
initial configuration, 2-2
keystroke combinations, B-1
loading configurations, 4-50
making calls, 3-17, 3-18
modifying configuration, 2-15
operation, 1-4
overview, 1-1
password, 4-3
placing calls on hold, 3-36
putting a conference call on hold, 3-45
recording a DDE for an incoming call

trigger, 5-44
recording macros for incoming call

triggers, 5-13
recording macros for outgoing call

triggers, 5-33
redirecting ringing calls, 3-10
restarting, 4-38
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returning to a conference call
on hold, 3-45

running, 3-2
saving call rule configurations, 6-24
saving configurations, 4-48
saving trigger configurations, 5-48
setting preferences, 4-40
starting, 3-2
starting a conference call, 3-40
System menu, 3-39
Tool bar, 3-37
transferring calls, 3-30
troubleshooting, A-1, A-2, A-3, A-4,

A-5, A-6
user responsibilities, 1-12

FastCall - Call Control Keys
configuring, 4-6

FastCall Administration window
description, 4-4

FastCall Professional
features, 1-6

FastCall Promotional
features, 1-7

FastCall Runtime
features, 1-7

field labels
changing in AT&TCall, 8-53

file tasks
AT&TCall, 8-29

files
printing, 8-39
saving, 8-44

G
Global Dialing, 4-2, 4-41

H
Hang Up button, 3-22
hanging up a conference call, 3-45
hanging up calls, 3-22
help, 1-12
helpful hints

AT&TCall, 8-25
Log Viewer, 7-4

hold
conference calls, 3-45

Hold button, 3-36
hold calls, 3-36
Hotkey

configuring, 4-6
default, 4-6
disabled, 4-43

I
importing

AT&TCall, 8-34
importing triggers, 4-46
incoming call rules

action, 6-6
alerts, 6-9
configuring, 6-3
criteria, 6-5
enabling/disabling, 6-4
example, 6-11, 6-12, 6-13, 6-14, 6-15
priority, 6-4
rule description, 6-4

incoming call trigger
example, 5-19
recording DDE, 5-44
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incoming call triggers
configuring, 5-8
recording macros, 5-13
saving configurations, 5-48

internal Advanced Dialing options, 6-21
International Dialing, 6-16
Intuity Message Manager, 3-38

K
keystroke combinations, B-1

L
loading a FastCall configuration, 4-50
local, 6-18
local area code

specifying, 6-18
local exchanges, 6-18
local line prefix

specifying, 6-18
Log Viewer

deleting entries from the call log, 7-5
description, 7-2
helpful hints, 7-4
menu descriptions, 7-11
printing log entries, 7-6
setting the preferences, 7-6
sorting call log entries, 7-7
specifying calls to be displayed, 7-9
tasks, 7-5

Iogin information
modifying, 8-36

long distance line prefix, 6-18
Look-Up Conversion, 5-10

M
macro

recording, 5-13
Main macro, 5-33
making calls

problems, A-4
master redirect number, 2-4, 4-35

N
North American Dialing Plan

(NADP), 6-16
notes

accessing in AT&TCall, 8-52

O
Other macro, 5-34
outgoing call rules

configuring, 2-8, 6-16
exchanges, 6-18

outgoing call triggers
configuring, 5-30
dialog box, 5-31
example, 5-36
Main macro, 5-33
Other macro, 5-34
recording macros, 5-33
saving configurations, 5-48
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P
PassageWay Solution Telephony Services

overview, 1-1
password, 4-52

administering for an AT&TCall file, 8-42
changing, 4-8
errors, A-2
FastCall Administration, 4-3
removing from an AT&TCall file, 8-43

printing
AT&TCall card, 8-39
AT&TCall card list, 8-38
AT&TCall file, 8-39

Q
Quick Dial

accessing information about, 8-58
assigning a phone number to, 8-58
changing the number displayed, 8-59
changing the setup of the labels, 8-59
dialing a phone number from, 8-60
erasing, 8-60
making a call from, 8-60
programming a phone number to, 8-58
re-assigning an existing

Quick Dial, 8-61
tasks, 8-58

R
recording macros

incoming call triggers, 5-13
outgoing call triggers, 5-33

Redial, 3-18

Redirect button, 4-24
redirecting ringing calls, 3-10
requirements, 1-8
rules

action, 6-6
accept call, 6-6
Forward to <extension>, 6-7
Forward to Attendant, 6-7
Forward to Voice Mail, 6-7

alerts, 6-9
configuring for outgoing calls, 6-16
configuring incoming call, 6-3
criteria, 6-5
enabling/disabling, 6-4
example, 6-11, 6-12, 6-13, 6-14, 6-15
priority, 6-1, 6-4

rules-based call processing, 6-1
running AT&TCall, 8-26
running FastCall, 3-2

S
saving a FastCall configuration, 4-48
screen pop applications, 5-3
screen pops

problems, A-3
sorting cards, 8-29
Special Dialing Codes, 3-18
Special Dialing Codes List

adding items, 4-29
configuring, 4-29
deleting items, 4-32
example, 4-31
supported characters, 4-28

starting AT&TCall, 8-26
starting FastCall, 3-2
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starting FastCall Administration, 4-3
System menu, 3-39
system requirements, 1-8

T
tasks

card, 8-52
Log Viewer, 7-5
Quick Dial, 8-58

technical support, 1-12
telephone parameters

caller input
button, 4-35

configuring, 2-4, 4-33
extension, 4-34
number of phone lines, 4-35

Telephony Server
modifying Iogin information, 8-36
problems logging in from AT&TCall, A-7
verifying connection, 8-49

template
creating, 8-30

timer
using in AT&TCall, 8-57

Tool bar, 3-37
Transfer button, 3-30
transferring calls, 3-30

problems, A-6
trigger, 6-10

example, 5-19
recording DDE, 5-44
type, 5-11

Trigger Only on Demand, 4-43

triggers, 1-4, 4-42
configuring, 5-8, 5-30
exporting, 4-44
importing, 4-46
overview, 5-2
problems, A-4
recording macros, 5-13, 5-33
saving configurations, 5-48

troubleshooting AT&TCall, A-7, A-8
troubleshooting FastCall, A-1, A-2, A-3,

A-4, A-5, A-6

U
user modes

configuring, 4-40
default settings, 4-40
enabling & disabling, 4-41
types of

Auto Trigger Before Answer, 4-42
Auto Trigger On Answer, 4-42
Continuous Call Window, 4-41
Trigger Only on Demand, 4-43

types of application triggers, 4-42
types of Do Not Disturb, 4-41
types of international dialing, 4-41

user responsibilities, 1-12

W
Warn Before Dial Over Active Call, 4-42
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